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The enclosed Software (Program and its associated Documentation) is licensed by Canfield Scientific, Inc. 
to customers for their use only in the terms set forth below. 

1. License:  Canfield Scientific hereby agrees to grant the original purchaser (Licensee) a non-exclusive 
license to use the enclosed Software subject to the terms and restrictions set forth in this License Agreement. 

2. Title:  Canfield Scientific retains all rights, title, and interest in the enclosed Software.

3. Copyright:  The Program and its Documentation are copyrighted by Canfield Scientific, Inc.. The Licensee 
or other users may not copy or otherwise reproduce any part of the Program or its documentation, except 
that the Program may be loaded into a computer as an essential step in executing the Program on the com-
puter and copies made solely for back-up or archival purposes. 

4. Restrictions, Use, and Transfer: 

(a) The original and any back-up copies of the Program and its Documentation are to be used only in con-
nection with a single computer. 

(b) The Program may be physically transferred from one computer to another, provided that the Program 
is used in connection with only one computer at a time. This license may be transferred to others together 
with the original and all back-up copies of the Program and its Documentation, provided that the transferee 
agrees to be bound by the terms of this License Agreement. 

(c) Neither the Program nor its Documentation may be modified or translated without written permission 
from Canfield Scientific, Inc.. 

(d) The Program may not be used, copied, modified, adapted, transferred, or merged in whole—or in part—
into another program except as expressly provided for in the license.

(e) The Program may not be reverse engineered, disassembled, decompiled nor any attempts made to dis-
cover the source code of the Program.

(f) Neither the Program nor any portion of the Software or Documentation may be sublicensed, rented, 
leased, or loaned. 

5. Exclusion of Warranty; Limitation Liability; Limited CD/DVD Warranty: 

(a) The Program and its Documentation is provided “as is” without warranty of any kind, either expressed 
or implied, including but not limited to the implied warranties of merchantability and fitness for a particu-
lar purpose. The entire risk as to the results and performance of the program is assumed by the Licensee. 

(b) Neither Canfield Scientific nor anyone else who has been involved in the creation, production, or delivery 
of this Program and its Documentation shall be liable for any direct, indirect, consequential, or incidental 
damages arising out of the use of or inability to use such products, even if Canfield Scientific has been 
advised of the possibility of such damages or claim.

(c) Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or 
consequential damages, so the above limitations or exclusions may not apply to the Licensee.

(d) Canfield Scientific warrants the enclosed CD/DVD (but not the Program contained thereon) to be free 
of defects in materials and workmanship under normal use for 30 days after purchase. During the 30-day 
period you may return a defective CD/DVD to an Authorized Canfield Scientific Dealer and it will be replaced 
without charge unless the CD/DVD is damaged by accident or misuse. Replacement of the CD/DVD is the 
sole remedy in the event of a defect. This warranty gives the Licensee specific legal rights, and other rights 
which may vary from state to state.

(e) No employee, agent, dealer or distributor of Canfield Scientific is authorized to modify this limited war-
ranty, or to make any additional warranties.

6. Product Improvements:  Canfield Scientific reserves the right to make corrections or improvements 
to the Program and its documentation and to the related CDs/DVDs at any time without notice and with 
no responsibility to provide these changes to purchasers of earlier versions of such products. All product 
upgrades are covered under a separate Support and Upgrade Agreement.



7. Term and Termination:  This license is effective upon your use of the software and remains effective 
until terminated. The license may be terminated by destroying the Program and its Documentation and all 
copies thereof. This license will also terminate if the Licensee fails to comply with any term or Agreement. 
The Licensee agrees upon such termination to destroy all copies of the Program and its Documentation.

8. Confidentiality:  The Software contains trade secrets and proprietary know-how that belongs to Canfield 
Scientific and it is being made available to you in strict confidence. Any use or disclosure of the software, 
or of its algorithms, protocols, or interfaces, other than in strict accordance with this license agreement, may 
be actionable as a violation of Canfield’s trade secret rights.

9. U.S. Government Restricted Rights:  The Program and related Documentation is provided with Restricted 
Rights. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subpara-
graphs (c) (1) (ii) of the Rights In Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at 48 CFR 52.227-19 
as applicable. The software manufacturer is Canfield Scientific, Inc. located at 253 Passaic Ave., Fairfield, 
NJ 07004. 

10. Export Restriction:  This Software is subject to U.S. export jurisdiction and may not be shipped, 
transferred or exported into any country or used in any manner prohibited by the United States Export 
Administration Act or any other export laws, restrictions or regulations.

11. Governing Law:  This license agreement is governed by the laws of the state of New Jersey.

Patent:  http://www.canfieldsci.com/patents/

THIRD-PARTY LICENSES  USE OF SOME THIRD PARTY MATERIALS AND SERVICES INCLUDED IN OR ACCESSED 
THROUGH THE CANFIELD SOFTWARE MAY BE SUBJECT TO OTHER TERMS AND CONDITIONS TYPICALLY 
FOUND IN A SEPARATE LICENSE AGREEMENT, TERMS OF USE OR “READ ME” FILE LOCATED WITHIN OR 
NEAR SUCH MATERIALS AND SERVICES OR AT  http://www.canfieldsci.com/end-user-license-agreements/

http://www.canfieldsci.com/patents/
http://www.canfieldsci.com/end-user-license-agreements/
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CHAPTER 1
Installing the Software 

1.1  MINIMUM SYSTEM REQUIREMENTS 

Before installing the software, please make sure 
your computer system meets the minimum system 
requirements, currently: 

• � Pentium 4 or higher (Core 2 Duo for RBX® 
applications)

• � Windows 8.1 Professional 64 Bit, Windows 7 
Professional or Ultimate (64 Bit recommended), 
Windows Vista Ultimate, SP 2

• � DVD Drive

• � At least 4GB RAM

• � At least 1 GB available disk space for installing 
application. More recommended for data.

• � 1024 x 768 or higher resolution, including 4K 
monitors

• � Microsoft Internet Explorer 7 or higher

• � 100/1000 MB Ethernet port required for networking 
(WiFi not supported)

Check our website for latest requirements:
www.canfieldsci.com/imaging-systems/mirror/

http://www.canfieldsci.com/imaging-systems/mirror/ 
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1.2  INSTALLING MIRROR SOFTWARE ON A STAND-ALONE COMPUTER 

Follow the steps below to install the software on a 
single computer or on multiple computers that are not 
connected by a network. To run Mirror software on 
multiple networked computers simultaneously, see 
1.3  Installing Mirror Software on a Network. 

1  Run Windows Update to ensure that you are running 
the most current version of the operating system. 

2  Log on to the computer with a user account that has 
local administrative access privileges. 

3  Attach the hardware key  to an available  
USB ( ) port. 

4  Close any programs that may be running on your 
computer. 

5  Temporarily disable any anti-virus software.

6  Insert the Mirror Software Installer DVD into your 
computer’s DVD drive. The Mirror Setup program starts 
automatically.

	 If the setup program does not start automatically, 
double-click the DVD drive in “My Computer”, then 
double-click “setup.exe”.

	 NOTE:  The second disk, “Mirror Sample Patients”, 
contains optional files that may be added to a database. 
See Importing Sample Patients (following page) for 
installation instructions.

7  When the InstallShield welcome screen appears, click 
Next to proceed with installation. 

8  Read the Mirror License Agreement. You must accept 
the terms of the License Agreement to continue with 
software installation. If you do not accept these terms, 
the Setup program will close.

9  When prompted to select the setup type, select the 
radio button next to “Stand-Alone”. (Note: If you wish 
to install Mirror in a specific location, you will have that 
option later in the installation.) 



Chapter 1� Installing the Software

Mirror User Guide	 PART 1:  PHOTOFILE	 4

.—.—.—

10  When “Select Features” appears, be sure any 
additional features you want to install, such as iPad 
support, are checked.

11  A summary of installation details appears. If you 
wish to review or change any settings, click Back.  
If you are satisfied with the settings, click Next 
to begin copying the Mirror program files to the 
computer’s hard drive.

12  When prompted that installation is complete, 
click Finish. Note: In some cases, your computer may 
automatically restart after installation.

Importing sample patients to the database (optional)
A collection of sample patients is provided on a separate disc for 
use during training or for practicing Mirror techniques.

	 1  Insert the Mirror Sample Patients CD into your 
computer’s CD-ROM drive.

2  Double-click the  Mirror icon on the Windows 
desktop to open Mirror software.

3  Select File A Import Patients… to open the Import 
Patient Records dialog box.

4  Click the Change Directory… button.

	 5  Navigate to your computer’s CD drive (usually  
drive D under My Computer) and click on the 
“MirrorSamplePatients” CD to select it, then click OK.  
A list of the sample patient files appears in the Import 
Patient Records dialog box. 

6  Click Check All, then click Import.

	 7  Click Yes in the pop-up window.
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8  It takes a few minutes to import the sample patient 
records. When the import is complete, Import 
Patients Summary is displayed with a message 
confirming that the import is complete. Click OK.

The sample patients are now available in your Mirror 
database.

1.3  INSTALLING MIRROR SOFTWARE ON A NETWORK

	 IMPORTANT:  Canfield recommends that a network 
administrator install the software on a network. 

About network authorization

Mirror software supports “concurrent use” network 
licensing. This allows multiple installations of the 
software on one local area network (LAN) to share a 
single hardware key. The number of computers that 
may run the software at the same time is determined 
by the number of network seat licenses you have 
purchased. A complete network installation involves 
the following components:

Authorization Service — This is a special piece of 
software that manages license information (authorized 
products, number of available seat licenses, etc.). The 
network computer with the hardware key (the License 
Server) must be configured with the “Canfield Clinical 
Systems Authorization Service.” 

Hardware key — This small device contains license 
information required by the Authorization Service. The 
hardware key must be attached to the License Server. 

Canfield Application – This is the Mirror program. In 
order to run, the Application must communicate with 
the Authorization Service to determine whether or not a 
seat license is available. 
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When you attempt to run the software on a network 
workstation, the Canfield Application on that computer 
communicates with the Authorization Service via a TCP/
IP connection to determine whether or not there is a 
seat license available. If so, the program launches and 
the number of available seat licenses is decreased by 
one. When the program is closed on a workstation, the 
number of available seat licenses is increased by one. 

Network configuration

Before setting up the software for network use, you 
must ensure that a network administrator has properly 
configured the network with a Windows domain 
controller and TCP/IP. A TCP port must be open 
and available for use by the license authorization 
system (the default port is 9090). It is recommended 
that a group be created on the domain for users of 
the software. This group will need to have security 
permissions on the Canfield database and image files 
set to Full Control. 

	 NOTE: Use of the software on a network without a 
Windows domain controller is not recommended. 

Setting up the License Server

One computer on your network should be designated 
the License Server. You may or may not choose to 
run the Application on this computer. However, it is 
important that the License Server be turned on and 
connected to the network with the HASP hardware key 
attached at all times. 

Follow the steps below to install the Application, the 
Authorization Service and the Network Client on the 
computer that you have chosen as the License Server. 

1  Run Windows Update to ensure that you are running 
the most current version of the operating system. 

2  Log on to the computer with a user account that has 
local administrative access privileges. 
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3  Attach the hardware key  to an available  
USB ( ) port. 

4  Close any programs that may be running on the 
computer. 

5  Temporarily disable any anti-virus software.

6  Insert the installation DVD into the computer’s DVD 
drive. The Mirror Setup program starts automatically.

7  When the InstallShield welcome screen appears, click 
Next to proceed with installation. 

8  Read the Software License Agreement. If you agree 
to the terms of the License Agreement, click Yes to 
continue with software installation. If you click No, the 
Setup program will close.

9  When prompted for setup type, select Server, then 
click Next. 

10  A summary of installation details appears. If you 
wish to review or change any settings, click Back. If 
you are satisfied with the settings, click Next to begin 
copying the program files to the computer’s hard drive. 

11  When prompted that installation is complete, click 
Finish. (Note: If prompted to do so, you should choose 
to restart the computer.) 

12  By default, the software installs a SQL database. 

Sharing a network database

In most network installations, a single database is 
shared by all workstations. In addition to managing 
license information, the License Server may also be 
configured to maintain a master database list. 

1  Open the Application on the License Server  
(double-click the icon on the Windows desktop to 
open the Application). 

2  Select Set Database Options from the Options 
menu. 
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3  Select a database from the list and click Edit. 

4  Select the “Share this database” check box at the 
bottom of the Database Information dialog box and 
click OK. (Note: The “Share this database” check box 
does not appear on a network workstation or  
stand-alone installation.) 

5  Click OK to exit the Database Options dialog box. 

Installing the software on a network workstation

You may install the software on any number of 
workstations. In order for the program to run on a 
given workstation, that computer must have access 
to the License Server via a TCP/IP connection. The 
License Server must be turned on with the hardware 
key connected. There is no need for a hardware key to 
be connected directly to the workstation. 

Follow the steps below to install the Application and 
the Network Client on a network workstation. 

1  During the workstation installation, you will need the 
Host Name of the License Server. This information may 
be obtained from the License Server (the computer with 
a hardware key attached to it) by selecting Programs 
from the Windows Start menu, then Canfield imaging 
Systems, then License Server Configuration. 

2  Run Windows Update on the workstation to ensure 
that you are running the most current version of the 
operating system. 

3  Log on to the workstation with a user account that 
has local administrative access privileges. 

4  Close any programs that may be running on the 
workstation. 

5  Temporarily disable any anti-virus software.

6  Insert the installation DVD into the computer’s DVD 
drive. The Mirror Setup program starts automatically.

7  When the InstallShield welcome screen appears, click 
Next to proceed with installation. 
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8  Read the Software License Agreement. If you agree  
to the terms of the License Agreement, click Yes to 
continue with software installation. If you click No, the 
Setup program will close.

9  When prompted for setup type, select Workstation 
(Client), then click Next.

10  Enter the Host Name in the License Server Name 
or TCP/IP Address field. 

11  Click Connect, then choose the shared database 
from the Default Database menu. 

12  Click Apply Selection, then click Next.

13  A summary of installation details appears. If you 
wish to review or change any settings, click Back. If 
you are satisfied with the settings, click Next to begin 
copying the program files to the computer’s hard drive. 

14  When prompted that installation is complete, click 
Finish. (Note: If prompted to do so, you should choose 
to restart the computer.) 

15  Double-click on the  Mirror icon on your desktop 
to launch Mirror software. 

Accessing a shared network database

If you have shared a database on the License Server 
(see Sharing a network database above), you may 
access that database on any workstation by selecting 
Switch Database from the File menu. 

If you wish to open the selected network database 
automatically each time Mirror software is run on a 
workstation, check the “Set as Startup Database” box.
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1.4  OPTIONAL SOFTWARE COMPONENTS 

When running a “custom installation” instead of an 
“express installation,” a screen appears to allow the 
selection of optional software components. 

MS SQL Server Express 2012

This option installs Microsoft SQL Server Express 2012.  
If Microsoft SQL Server is not already running on the 
network, MS SQL Server Express should be installed on 
the Canfield database server (see 1.5 Using SQL Server 
for details). It is not necessary to install MS SQL Server 
Express on any workstations. 

Network License Server

This option installs the Authorization Service software 
that allows a hardware key to be shared over a 
network. This needs to be installed only on the License 
Server (the computer to which the hardware key is 
attached). It is not necessary to install this option on 
any workstations. 

Security Reports

This option installs the necessary reporting tools to 
support HIPAA audit trails. 

ViewMyConsult®
(where available)

Selecting this feature will install the Canfield Service 
utility on your computer. This supports the upload 
of consultations to the ViewMyConsult.com website, 
where they can be viewed by your clients from any 
computer or mobile device. To enable this feature, 
it will be necessary to register your license key and 
configure an administrative area on the website as 
described at the completion of this installation.
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Apple iPad Support

Selecting this feature will install the Canfield Service 
utility on your computer. This supports a consultation 
app that can be downloaded to your iPad from the 
Apple App Store. With this app, you can access 
any of the sessions in your database and conduct 
client consultations on your iPad from anywhere in 
your facility. To enable this feature you will need to 
purchase an iPad license for your system as described 
at the completion of this installation.

Documentation

User guides in PDF format are copied from the 
installation disk to the Mirror folder on the hard drive: 
C:\Program Files\Mirror\Documentation

1.5  USING SQL SERVER

When using the software over a network, performance 
may be greatly improved by using a SQL database 
instead of MS Access. In addition, Mirror’s  
HIPAA-related security features can be used with  
SQL databases only. For these reasons, you may wish 
to create SQL databases for Mirror.

	 IMPORTANT:  Canfield Scientific strongly recommends 
that configuration of a SQL database be performed by 
a network administrator.

Setting up the database server

One computer on your network needs to run Microsoft 
SQL Server, Microsoft SQL Server Express, or Microsoft 
SQL Server Desktop Engine (MSDE). It is best to use 
a dedicated database/file server that is not used as a 
workstation. The server should have an ample amount 
of RAM (preferably 1GB or more), a fast processor 
or multiple processors, a fast hard drive or array, and 
should be running Windows 2003 or higher. 
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If you are already running MSSQL Server on the 
network, you may skip this section and proceed to 
“Creating a new SQL database.” 

If you have not yet installed the Mirror software on 
the computer that you wish to use as a SQL database 
server, follow the procedure for “Setting up the License 
Server” (see 1.3  Installing Mirror Software on a 
Network) and be sure to select “Microsoft SQL Server 
Express” in Step 11. 

If the Mirror software has already been installed on 
the computer that you wish to use as a SQL database 
server, follow the steps below to install Microsoft SQL 
Server Express. 

1  Insert the installation CD (the Canfield Setup program 
will start automatically). 

2  Click Next.

3  Accept the license agreement and click Next.

4  When the Setup Type screen appears, select “Custom 
Installation” and click Next. 

5  Click Next to maintain the current installation folder. 

6  On the Select Features screen, select “Microsoft SQL 
Server Express” (and any other desired options) and 
click Next. 

7  A summary of installation details appears. Confirm that 
“Microsoft SQL Server Express” is listed under “Selected 
Components to Install” and click Next. 

8  When prompted that installation is complete, click 
Finish. (Note: If prompted to do so, you should choose 
to restart the computer.) 

Creating a new SQL database

1  Log on to the License Server with a user account 
that has Create Database privileges on the database 
server. (By default, local administrators on the database 
server have Create Database privileges.) 
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2  Double-click on the  Mirror icon to launch Mirror. 

3  Select Set Database Options from the Options 
menu. 

4  The Database Options dialog box opens to the 
Database List tab. 

5  Click Create Database. 

6  Make sure “SQL Server” appears in the Database 
Type field. 

7  In the Database field, enter a name for the new 
database. 

8  Accept the default (Local) or select the database 
server from the Server drop-down list. 

9  In the “Path to image files” field, enter a location to 
store image files for the new database (or click Browse 
to locate/create a folder and click OK). 

10  Select the “Share this database” check box. 

11  Click OK. 

12  The Canfield System Options - Administrator dialog 
box appears. Confirm that Database Role is set to 
“CanfieldDB Administrator,” make sure “Domain Users” 
is selected and click OK. (Note: If you do not wish 
to grant database access to all users on the domain, 
you may select individual users/groups instead. You 
may wish to create a specific group for all users of the 
software.) 

13  The Canfield Database Agent Scheduler dialog box 
appears. Make sure the “Enable Schedule” check box is 
selected. 

NOTE:  In a new install of Microsoft SQL Server Express 
no SQL Agent is available. The full version of MS SQL 
Server 2005 or higher is required for full access to SQL 
Agent to create automatic backups.
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14  Select the desired settings for creating backup files 
and click OK. (Note: Schedule the database backup to 
occur shortly before your regular data backup.) 

15  Click OK to close the Database Options dialog box. 

Backing up a SQL database

The scheduler will place a backup copy of the SQL 
database in the MSSQL Server backup directory on the 
database server. If the Application is installed on the 
database server, and no active MSSQL Server backup 
directory previously existed, the backup copies will 
be placed in the “backup” folder inside the Canfield 
program folder on the database server. If an active 
MSSQL Server backup directory already existed on 
the database server, the backup copies will be placed 
there. 

	 IMPORTANT: The database server must be turned on at 
the scheduled time for the backup file to be created.

Your regular data backup should include at least the 
MSSQL Server backup directory and all image folders 
(the folders containing .t2k files). 

To ensure that database backup is set to the proper 
directory, perform the following test:

1  In the Application, select Set Database Options 
from the Options menu. 

2  Select a SQL database in the list. 

3  Click the Backup button. 

4  In Windows Explorer, browse to the backup 
directory. A .bak file should appear with the same 
name as the selected database. 
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1.6  DATABASE OPTIMIZER

Mirror’s Database Optimizer utility helps to maintain the 
integrity and performance of your Mirror databases.  
To ensure fast, trouble-free operation of your Mirror 
system, you should run the Database Optimizer as 
soon as possible after installing an upgrade and on a 
monthly basis thereafter. 

The first time you open Mirror software after 
upgrading, the Database Optimization window 
will appear automatically. Since optimization can 
take a long time for large databases, it is 
recommended to accept the default option of 
scheduling optimization for a later time. Select a 
time when no one will be using your Mirror 
system and click OK. 

NOTE:  Mirror must remain open until the 
scheduled time to avoid losing the setting.
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CHAPTER 2
Overview

2.1  MIRROR SOFTWARE MODULES 

Mirror software consists of a suite of software modules 
that are sold separately and may be used together. 
PhotoFile is the core component of Mirror software, 
providing advanced medical image management. Each 
additional module offers a specific set of functionality 
that may be added to PhotoFile. 

PhotoFile  provides the core medical image 
management functions of image storage and retrieval, 
on‑screen viewing, printing and image export. 

PhotoTools  provides features used to prepare 
images for lectures, consultations and other visual 
communication applications, as well as features for 
improving the imaging workflow. Tools include 
tethered image capture, image overlay (Compare),  
color correction, orientation matching, layout board, 
labels, whiteboarding, consultation tools (Enhance, 
Asymmetry, Mirror), presentations and measurements. 

Rejuvenation software for simulating skin rejuvenation 
procedures enables you to easily simulate the benefits 
of procedures such as neurotoxins, dermal fillers, 
laser procedures, microdermabrasion, and other skin 
rejuvenation therapies.

NOTE:  Depending on which modules you have 
purchased, certain features may not appear on your 
system. 



Chapter 2� Overview

Mirror User Guide	 PART 1:  PHOTOFILE	 17

.—.—.—

2.2  THE MAIN SCREEN 

image gallery

menus 

toolbar 

active image
Image Check 
icon 

Image Data tab 

Patient Search 
tab 

Chart tab 

Image Search 
tab 

2.3  NAVIGATING THE SOFTWARE 

Mirror software features are accessed by selecting 
commands from the main menus or by clicking buttons 
on the main toolbar. Which commands are available 
depends upon the current state of the program (whether 
the Chart is open or closed, if any images are open/
selected, etc.). 

Dialog boxes

Many commands (New Patient, for example) cause a 
dialog box to appear. A dialog box allows you to enter 
information, make selections or choose settings for the 
current operation. 

When settings and data in a dialog box appear as you 
wish, you can execute the command by clicking a 
button that is typically marked with a descriptive label 
(Save, Import, etc.) or simply OK. 
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Most dialog boxes also contain a Cancel button. 
Clicking Cancel closes the dialog box without 
executing the command. Any data entered prior to 
clicking Cancel is discarded. 

Tools

Commands that perform an action on an image  
(Print, for example) cause the program to switch from 
the main screen to a tool window. 

The types of user interface elements present varies 
depending on the tool. Some tool windows display 
little more than the active image. Other tool windows 
contain a menu bar, a toolbar and an image gallery, and 
may appear very similar to the main screen. Other tool 
windows contain a few of these elements. 

Two visual clues indicate whether you are in a tool 
window or the main screen. First, look for the  
easy-access tabs (Image Data, Chart, Patient Search  
and Image Search) along the right edge of the screen.  
If the tabs are present, you are on the main screen.  
If not, you are inside a tool. 

Second, if you are on the main screen, File appears at 
the left end of the menu bar. If you are inside a tool 
window, either the menu bar is absent or the name of 
the tool appears at the left end of the menu bar. 

To exit a tool window and return to the main screen, 
right-click with the mouse (or press the side button on 
the pen). Depending on where you are, you may need 
to right-click several times to return to the main screen.

2.4  SELECTED IMAGES VS. OPEN IMAGES 

Mirror software is used to store, retrieve, view, adjust 
and modify images. An image must be either selected 
or open when you perform one of these operations.
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Thumbnails (selected images)

The Chart and Image Search tabs allow you to view a 
number of images as small thumbnails on one screen. 
This arrangement makes it easy to work with images 
in groups (for example, to compare pairs of images or 
export groups of related images). 

Click on thumbnails to select the images. Commands 
executed from the main menus or toolbar are performed 
on whatever images are currently selected. (Images open 
in the Image Gallery are disregarded as long as the Chart 
or Image Search tab remains open.) 

For more information on the Chart and Image Search, see 
Chapter 7, The Chart, Patient Search, and Image Search 
Tabs. 

The Image Gallery (open images)

The Image Gallery provides a workspace that allows 
you to focus on a small number of images with a 
minimum of screen clutter. This is helpful when using 
the software during a patient consultation. 

Selecting one or more images in the Chart or Image 
Search and clicking Open Images opens those images 
in the Image Gallery. (Open images is available from 
the drop-down list when you right-click on a selected 
image.) One image—the “current” or “active” image—
appears full-size in the viewing area of the main 
screen. The other open images are represented as small 
“stamps” in the Image Gallery. Clicking on a stamp 
switches to the corresponding image. 

As long as the Chart and Image Search tabs remain 
closed, any commands selected from the main menus 
or toolbar are performed on either the active image 
or on all open images (depending on the specific 
command). 

	 Images from multiple patients may be open in the 
Image Gallery at the same time. 
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2.5  BASIC OPERATIONS 

The following are some basic operations that are 
required for using Mirror software. These basic 
operations may differ slightly from standard MS 
Windows conventions. 

Moving

Moving the mouse will cause the cursor to move on the 
screen. 

If you are using a pen and tablet, hold the tip of the 
pen within 1 cm of the tablet surface as you move it. 
The pen should not actually touch the tablet. 

Clicking

To “click” on an object, move the mouse to position the 
cursor on top of the object, then press and release the 
left mouse button. 

If you are using a pen and tablet, move the pen to 
position the cursor on top of the object, then press the 
tip of the pen onto the tablet and release. 

Right-clicking

“Right-click” means to press and release the right mouse 
button. A right-click is typically used in the software to 
cancel the current operation or to exit a tool. 

If you are using a pen and tablet, press and release the 
button on the side of the pen to right-click. 

Drag-and-drop

“Drag-and-drop” is a method used in many Windows 
programs to move an object from one location on 
the screen to another. The drag-and-drop behavior in 
Mirror software differs slightly from standard Windows 
drag-and-drop. 
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To begin a drag-and-drop operation in Mirror software, 
click once on the object you wish to move and drag 
it slightly. You may then release the mouse button. As 
you move the cursor, you will see the object move as 
well. Move the object to the desired location and click 
again to drop the object in position. 

2.6  THE FILING SYSTEM 

A Mirror database is made up of individual patient 
records. Each patient record contains data pertaining 
to that patient (name, MRN, date of birth, etc.) along 
with images that have been saved for that patient. 
Each image may have additional data associated with it 
(image date, procedure, etc.). 

The data and images in a Mirror database are stored 
on a computer hard drive as a single database file 
(.mdb) and a folder containing image (.t2k) files. The 
number of patient records and images you can store in 
the Mirror database is primarily dependent upon the 
capacity of the hard drive or server. 

In a network environment, data is stored in a single 
SQL Server database and images are stored on a 
network file server.
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CHAPTER 3 
Customizing Mirror Software 

NOTE:  Options discussed in this chapter may pertain 
only to specific Mirror software modules. Depending on 
which modules you have purchased, some options may 
not appear on your system, or may appear but have no 
function. 

3.1  SETTING PROGRAM OPTIONS 

Set Program Options enables you to set screen 
display parameters, image parameters, disclaimer 
message parameters, video input and output 
parameters, or to set other Windows programs to run 
from within the Mirror software. 

Using the Program Options dialog

Select Set Program Options from the Options menu 
to open the Program Options dialog box. Click on one 
of the tabs at the top of the dialog box to view the 
different groups of program options. 

The Reset button restores the options in the current 
tab to their default settings. The Reset All button 
restores all program options (in all tabs) to the default 
settings. 

Screen tab

Text Style — Opens the Font dialog box, so you can 
format text in an image (e.g., size, color, etc.). These 
settings do not affect the disclaimer. To format the 
disclaimer, see Disclaimer tab later in this chapter. 
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Tab Transparency — Move the slider left and right to 
modify the transparency of the easy-access tabs (Image 
Data, Chart, Patient Search, Image Search). A sample is 
provided below the slider. 

Center Initial Window — Centers the program window 
on the screen the next time you start the program. This 
setting is perceptible only when the program window is 
smaller than full screen (i.e., not maximized). 

Toolbar is Visible — When selected, the toolbar is 
displayed. When cleared, the toolbar is hidden. 

Show Pop‑Up Image Data — When selected, floating 
the cursor over a thumbnail in the Chart causes image 
data to be displayed in a pop-up window. 

Track Search Results in Chart — When selected, the 
Chart is automatically filtered to display only those 
patients/images matching the current search. The type 
of filter applied is based on how the Chart is opened 
(i.e., from Patient Search or from Image Search).

Blank Screen Bitmap — Enter the name (including 
path) of a bitmap or graphic file to be displayed on the 
main screen when no images are open. If you do not 
know the bitmap’s name or path, click Browse to find 
and select the file. 

Disclaimer tab

The disclaimer is a line of text that appears on screen 
automatically whenever a modified image is displayed. 
You must have the Rejuvenation module to create 
modified images. 

Disclaimer Text — Select the Disclaimer Text field 
and type your own disclaimer. The default message is 
“Simulation only: Actual results may differ.” 

Text Style — Click Text Style to format the disclaimer 
text. This command opens the Font dialog box from 
which you can set font size, color, etc. Changes are 
reflected in the Sample preview box. 
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Show Disclaimer — Select this option to have the 
disclaimer text displayed automatically beneath 
modified images. 

Images tab

Image Compression — Compression increases the 
number of images you can store on your hard drive. 
Drag the slider to the right to increase the amount of 
compression used (i.e., to create smaller image files). 

The sample image below the slider provides a preview 
of the effect that the selected level of compression will 
have on image quality. 

	 IMPORTANT: High levels of compression (small file 
sizes) may have a noticeable effect on image quality. 

Compression ratios of up to 1:10 generally do not cause 
any discernible loss in image quality. You may wish to 
experiment with various image compression settings on 
sample images to determine the highest compression 
setting that provides acceptable image quality for your 
needs. 

	 To calculate the approximate file size for images, 
multiply the resolution (in pixels) by three and then 
multiply by the compression ratio. For example, 
an image with three million pixels saved with 1:10 
compression produces a file approximately 0.9MB in 
size (3MP x 3 = 9MB; 9MB/10 = 0.9MB). 

NOTE:  The compression ratio displayed under the 
sample image is only an approximation. The actual 
amount of compression will vary from image to image. 

Enable Lossless Compression Option — When this 
option is selected, a “Use lossless compression” check 
box appears in the Image Import Settings dialog. This 
allows images to be imported and saved without the use 
of JPEG compression. 

	 IMPORTANT: The use of lossless compression creates 
image files that are significantly larger than those 
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created with JPEG compression. Unless you are sure 
you require lossless compression, you should leave this 
option unchecked. 

Create Stamps from Modified Data – When this option 
is selected, stamps and thumbnails are created from 
modified image data when available. (Note: You must 
have the Rejuvenation module to create modified 
images.) If this option is cleared, stamps and thumbnails 
are always generated from original image data. 

This setting applies only to the subsequent creation 
of thumbnails; existing thumbnails are not affected. 
To apply the new setting to existing thumbnails, use 
the Generate Thumbnails command in the Utilities 
menu. 

Confirm on Close All Images — When this option is 
selected, a confirmation prompt appears whenever the 
Close All Images command is used (even if no images 
are new or modified). 

Save Modifications — When this option is cleared, it is 
not possible to save image modifications to the patient 
chart. (Note: This option pertains to image modifications 
made with one of the simulation tools.) 

Edit Images Using Screen Size — Select this option 
when using high resolution images. When selected, 
images are automatically resized to fit the screen upon 
entering simulation tools. (Note: This setting has no 
impact on the size of the original image.) If you are 
capturing images at a resolution that is not much higher 
than your screen resolution, you may wish to clear this 
option. 

Image Cache Size — In certain situations, the image 
cache size may be adjusted to optimize system 
performance. In most cases, it is best to leave the image 
cache size set to its default value unless instructed to 
change it by Canfield technical support.
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Programs tab

Use this tab to add other programs to the Utilities menu 
so they may be launched from within the software. 

1  Click New from the Programs tab. 

2  In the Description field, enter the name of the 
program as you wish it to appear in the Utilities 
menu. Insert an ampersand (&) in front of a letter in 
the description to make that letter an access key. 

3  In the Command Line field, enter the command 
line used to execute the program. If you do not know 
it, click Browse and search your directories for the 
program’s executable (.exe) file. 

4  In the Default Directory field, enter the path to 
the directory containing the program’s files, or click 
Browse and search for the program files. 

5  Click OK.

The Edit and Delete buttons may be used to modify 
or remove programs already in the list. (Note: Deleting a 
program from the Utilities menu does not remove that 
program from the computer.)

Image Search tab

Use this tab to control the order and availability of items 
in the Sort By drop-down list in Image Search. 

Video I/O tab

These options are available only on systems with 
PhotoTools and a video capture card. The specific 
options vary according to your hardware setup (video 
capture card and device). 

For both video input and video output, select a 
standard (NTSC or PAL) and an interface (S‑Video, 
Composite or, on some systems, RGB). Select Sync on 
Green for certain RGB-interface cameras. 
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Mirror Camera View is available only if your hardware 
supports it. Select Mirror Camera View to view a mirrored 
live video image the way the patient sees it in a mirror. 

3.2  SETTING DATABASE OPTIONS

Set Database Options provides access to the 
following database administration functions: creating 
and destroying databases, converting Access databases 
to SQL Server, setting the startup database, scheduling 
backups, configuring database field formats, and setting 
the software to automatically purge deleted images and 
patient records. Note: Not all database administration 
functions can be accessed by all users. Refer to the 
specific function below.

Using the Database Options dialog

Select Set Database Options from the Options menu 
to open the Database Options dialog box. Note: The 
Reset All button restores all database options (in all 
tabs) to the default settings.

Database List tab

At initial installation, Mirror software includes one 
empty MS Access database. The Database List tab may 
be used to convert that database to SQL Server, create 
new empty databases, or connect to other existing 
databases.

Add — (All users.) Used to add an existing database to 
the database list.

Edit — (All users.) Opens the Database Information 
dialog box, which allows you to view details about the 
selected database and change the path for associated 
image files. Note: Shared databases can only be edited 
on the system that is sharing the database.

Remove — (Canfield DB Administrator or Power User.) 
Removes the selected entry from the database list. 
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Remove does not delete the database file or associated 
images from the system. Note: You will not be 
prompted to confirm. Be sure you wish to remove the 
selected database from the list.

Backup — (Canfield DB Administrator or Power User.) 
SQL Server databases only. Creates a copy of the 
selected database in the backup directory. By default, 
the backup directory is located within the program 
folder.

Restore — (Canfield DB Administrator.) SQL Server 
databases only. Restores a database from a backup file. 
Note: It is not possible to restore the currently active 
database.

Scheduler — (Canfield DB Administrator or Power 
User.) SQL Server databases only. Used to schedule 
the automatic creation of backup copies of SQL Server 
databases, which may in turn be included as part of 
regular system backup. Note: SQL Server backup should 
be scheduled to take place shortly before system 
backup.

Set Startup Database — (All users.) Sets the selected 
database to be the default database that opens each 
time the program is launched. Note: If Mirror’s security 
features are enabled, the startup database must be a 
SQL Server database.

Create Database — Used to create a new empty 
database. Databases can be created by users with 
Administrator-level access to the database computer 
(not Canfield DB Administrator).

Destroy Database — (Canfield DB Administrator.) 
Permanently deletes a database from the system.

	 IMPORTANT:  Once a database has been destroyed, it 
cannot be recovered.

Convert to SQL — (Canfield DB Administrator.) Used to 
convert a MS Access database to a SQL Server database. 
(Disabled if no SQL Servers are found.) Canfield 
recommends you convert to SQL Server for better 
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network performance. In addition, Mirror’s security 
features are available only with SQL Server databases. 

Creating an empty MS Access database

Follow the procedure below to create a new, empty 
MS Access database for use with the software.  
NOTE:  An MS Access database should be used only for 
stand-alone installations or when you do not wish to 
use Mirror’s security features. For a network installation, 
it is better to use a SQL database.

1  Select Set Database Options from the Options 
menu to open the Database Options dialog box. 

2  Click the Database List tab. 

3  Click Create Database to open the Database 
Information dialog box. 

4  Select “Access” from the Database Type drop-down 
list. 

5  Enter a name for the database in the Database field. 
This is the name that will be used by the Windows 
system to identify the new database. 

6  In the Server field, select the server for the database 
from the drop-down list.

7  In the Path to Database Files field, enter the 
location where you would like the new database file 
to be created. If you wish, you may click Browse to 
locate the desired folder. 

8  In the Path to Image Files field, enter the location 
where you would like the image files for the new 
database to be stored. If you wish, you may click 
Browse to locate the desired folder. If the selected 
folder does not yet exist, the software will create a new 
images folder. 

9  Click OK to add the new database and return to the 
Database List tab. The new database appears in the 
database list. 
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Once you have created a new database, you may access 
that database by selecting it from the Database List.

Creating an empty SQL Server database

To optimize performance on a network, Canfield 
strongly recommends that you use SQL Server instead 
of MS Access. Mirror’s security features can only be 
used with a SQL Server database.

1  Log on to the Mirror License Server with a user 
account that has Create Database privileges on the 
database server.

2  Launch the application.

3  Select Set Database Options from the Options 
menu.

4  Click the Database List tab.

5  Click Create Database.

6  Make sure “SQL Server” appears in the Database 
Type field.

7  In the Data Source Name field, enter a name for 
the new database.

8  Select the database server from the Server 
drop‑down list.

9  In the Path to Image Files field, enter a location to 
store image files for the new database (or click Browse 
to locate/create a folder).

10  Select the “Share this database” check box.

11  Click OK.

12  The Canfield Database Security dialog box appears. 
Confirm that Database Role is set to “Canfield DB 
Administrator.” Be sure “Domain Users” is selected and 
click OK. Note: If you do not wish to grant database 
access to all users on the domain, you may select 
individual users/groups instead. You may wish to 
create a specific group for all users of the software.
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13  The Canfield Database Agent Scheduler dialog box 
appears. Make sure the “Enable Schedule” check box is 
selected.

14  Select the desired settings for creating backup files 
and click OK. Note: Schedule the database backup to 
occur shortly before your regular data backup.

15  Click OK to close the Database Options dialog box.

Converting an MS Access database to SQL Server

If you have an existing MS Access database that is used 
with a networked system, you may improve system 
performance by converting the database to SQL Server. 
You will also have the option of using Mirror’s security 
features on a SQL Server database.

1  Make a backup of the existing database and images.

2  If you do not already have a copy of Microsoft SQL 
Server running on the network, install Microsoft SQL 
Server Express.

3  Close the Application on all workstations.

4  Log on to the License Server with a user account that 
has Create Database privileges on the database server. 
(By default, local administrators on the database server 
have Create Database privileges.)

5  Select Set Database Options from the Options 
menu to open the Database Options dialog box.

6  Click the Database List tab.

7  Select the existing MS Access database in the 
database list.

8  Click Convert to SQL.

9  Confirm that all information in the Convert Access to 
SQL dialog box is correct and click OK.
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Connecting to an existing database

If the database you wish to connect to already appears 
in the database list on the License Server, see Sharing 
a network database below for the easiest way to access 
that database from network workstations.

Follow the procedure below to add an existing 
database to the database list (for example, after 
upgrading your computer system).

1  Select Set Database Options from the Options 
menu to open the Database Options dialog box.

2  Click the Database List tab.

3  Click Add to open the Select Data Source dialog box.

4  Click the Machine Data Source tab.

5  If the desired database already appears in the list 
of data sources, select it and click OK, then proceed 
directly to step 15.

6  If the database does not appear in the list of data 
sources, click New to open the Create New Data 
Source wizard.

7  Select System Data Source and click Next.

8  From the list of database drivers, select “Microsoft 
Access Driver (*.mdb)” and click Next.

9  Click Finish to close the Create New Data Source 
wizard and open the ODBC Microsoft Access Setup 
dialog box.

10  Enter a name and description for the new data 
source.

11  Click Select to open the Select Database dialog box.

12  Locate the database (.mdb) file you wish to connect 
to and click OK to return to the ODBC Microsoft Access 
Setup dialog box.
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13  Click OK to close the ODBC Microsoft Access Setup 
dialog box and return to the Select Data Source dialog 
box.

14  Make sure the new data source is selected in the list 
and click OK.

15  Make sure the correct path appears in the Path 
to image files field. If necessary, you may use the 
Browse button to locate the correct image folder.

16  Click OK to add the new database and return to the 
Database List tab.

Once you have added a database to the database list, 
you may access that database by selecting Switch 
Database from the File menu.

Sharing a network database

In most network installations, a single database is 
shared by all workstations. In addition to managing 
license information, the License Server may also be 
configured to maintain a master database list.

1  Open the Application on the License Server (the 
computer with a hardware key attached).

2  Select Set Database Options from the Options 
menu.

3  Click the Database List tab.

4  Select a database from the list and click Edit.

5  Select the “Share this database” check box at the 
bottom of the Database Information dialog box and 
click OK. Note: The “Share this database” check box 
does not appear on a workstation or stand-alone 
installation.

6  Click OK to exit the Database Options dialog box.

Once you have shared a database on the License 
Server, you may access that database on any 
workstation by selecting Switch Database from the 
File menu.
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Setting the startup database

Follow the steps below to select which database opens 
automatically each time the program is launched.  
Note: If Mirror security features are enabled, the startup 
database must be a SQL Server database.

1  Select Set Database Options from the Options 
menu.

2  Click the Database List tab.

3  Select the desired database from the list and click 
Set Startup Database.

4  Click OK to exit the Database Options dialog box.

	 IMPORTANT:  It is a good idea to test a new database 
before setting it as the startup database.

Hair database list tab

In addition to the main patient database, the Hair 
module also maintains a hair database for the Hair Graft 
tool. Hair databases are added in the same manner as 
patient databases (see above).

Field formats tab

From this tab you can format the Social Security 
Number, Phone, Postal Code and State fields. Click an 
entry in the Format column to edit that entry. Use the 
appropriate placeholder characters as described in the 
dialog box. An example of the current format appears 
below the list of placeholders.

Options tab

Deleted Records — Select “Auto purge deleted patients 
and images at program exit” and any images or charts 
you delete are automatically purged when you exit the 
program.

	 IMPORTANT:  If you select the Auto Purge option, you 
will not be able to undelete patients or images after 
exiting the program.
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Authorization tab

This tab displays the license information currently 
programmed into the attached hardware key. 
No license information is available on a network 
workstation with a remote key.

3.3  SETTING TOOL OPTIONS 

Using the Tool Options dialog

Select Set Tool Options from the Options menu to 
open the Tool Options dialog box. Click on the tabs at 
the top of the dialog box to view the tool options. 

The Reset button restores the options in the current 
tab to their default settings. The Reset All button 
restores all tool options (in all tabs) to the default 
settings. 

General tab

Cutout Transparency — Drag the Cutout Transparency 
slider to adjust the overlay transparency used within 
various simulation tools. An example of the setting 
appears under the slider. 

Allow Whiteboarding — If you have purchased 
PhotoTools, you may select this option to make the 
whiteboarding feature automatically available in 
many of the View tools. Remove the selection to skip 
the whiteboarding feature. This does not affect the 
availability of the Whiteboard tool on the main toolbar 
or in the Image menu. 

DV Preview Frame Rate — Sets the number of frames 
per second displayed for the live video preview in the 
Pre-Op and Post-Op capture tools when using a digital 
video source. (Note: Digital video capture requires 
PhotoTools.) 
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Side-by-Side Image Size — Determines how images are 
displayed when using the Side-by-Side tool. When Best 
Fit is selected, images fill the height of the screen and 
a scroll bar appears as needed to view the full width 
of the images. When Full Image is selected, images are 
reduced so that both full images appear on screen (no 
scroll bar is needed).

Pre-op/Post-op tab

Settings on this tab affect the Digital Video Record 
tool (used for tethered capture of motion video clips) 
and tethered digital still capture with video preview. 
Tethered capture is a feature of PhotoTools. 

Select Video Driver — Used to select Digital Still 
Camera or DirectX Video for tethered capture.

Select Capture Sequence — Used to select a capture 
sequence to be used during tethered capture.  
A capture sequence is a template containing standard 
photographic views. When a capture sequence is 
selected, an alignment grid and image icon appear on 
screen for each view to assist with patient positioning. 
Standard Grid should be selected if you do not wish 
to use a capture sequence. 

Sequence Location — Click on Change Directory to 
browse for a file containing capture sequences. Check 
Save Directory Setting if you will select sequences 
from this file in the future.

Standard Grid Lines — Specifies the number of 
horizontal and vertical grid lines to appear on the video 
preview screen when Standard Grid is selected. 

DV Record tab

Settings on this tab affect the Digital Video Record tool 
(used for capturing motion video clips). Digital Video 
Record is a feature of PhotoTools. 
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Initial Capture Buffer Size — In some cases, increasing 
the size of the Initial Capture Buffer may improve video 
recording performance. For better performance, enter 
a value that is greater than the file size for the largest 
video clips that you capture. 

Maximum Duration of Recording — This setting may  
be used to prevent the accumulation of very large 
video clips that can rapidly consume hard drive space. 
The Digital Video Record tool will automatically stop 
recording when a clip has reached the maximum 
duration.

Number of Frames per Second — A greater number of 
frames per second produces smoother video clips, but 
also results in larger file sizes. High frame rates may 
also cause a noticeable time delay during recording. 

Video Compression — Select one of three compression 
options: Smaller Files (lowest image quality), Normal, 
or Higher Quality (largest file sizes). The file sizes listed 
in this section are rough approximations—actual file 
sizes will vary. 

Mirror tab

The Mirror tool (a feature of PhotoTools) is used to 
display a patient’s image as they are accustomed to 
seeing it in a mirror. The check box on the Mirror tab 
determines whether the Mirror tool displays just the 
reflected image, or displays the original and reflected 
images side-by-side. 

Labels tab

If you have saved Labels templates in the Labels tool, 
you may select one of these templates to be applied 
automatically to all images upon import. Labels are a 
feature of PhotoTools. 
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Motion Clips tab

This tab is available only if your system is configured 
with a Targa 2000 or Integral FlashPoint 128 video 
capture card and PhotoTools. 

Data Rate — Drag the slider to adjust the rate at which 
motion clip data is processed. 

The size and quality of the motion clip decreases as 
you decrease the data rate. Setting a data high rate 
might make motion clips record incorrectly if the hard 
drive cannot keep up. 

Duration — Drag the slider to increase or decrease 
the length of motion clips. The size of the motion file 
changes accordingly. 

3.4  SETTING SYSTEM OPTIONS:  
IMPLEMENTING MIRROR’S SECURITY FEATURES

Mirror incorporates HIPAA-related security features 
that can be used to control access to your Mirror 
database and track system and database-level events. 
Mirror’s security features are implemented through 
defined user roles, secure logins, and audit trails. The 
security features can only be used with MS SQL Server 
databases.

User roles

Mirror uses a combination of Windows NT accounts 
and SQL Server roles to define and control user access 
privileges. Mirror allows you to establish roles for 
individual users or groups using three levels of access 
privileges: Canfield DB user, Canfield DB Power User, 
or Canfield DB Administrator. Roles can be assigned 
to users or groups for specific databases. Canfield DB 
Users can create, modify, or delete patient records. 
Power Users have access to some database functions 
including backing up the database and viewing event 
reports. Administrators have access to all system 
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operations including assigning user and group roles, 
creating, destroying, or converting databases, enabling 
audit trails, and purging event reports.

Logins

Mirror’s secure login procedures function at the 
application level. When one user logs out (or is 
automatically logged out) and another user logs in, the 
new user gains access to the application at the location 
from which the previous user logged out. (Note that 
if an Administrator logs out from an administration 
function, Users and Power Users would not have access 
to that function when they log in.) Because the Mirror 
application does not have to be opened each time 
a user logs in, this feature streamlines the workflow 
when multiple users access Mirror from the same 
workstation. If only one user is accessing Mirror from a 
workstation and you do not need this feature of Mirror 
logins, Windows logins may be adequate to meet your 
security needs. Consult your HIPAA compliance officer 
to determine whether you should use Windows or 
Mirror logins.

For additional security, Mirror logins can be set up so 
that users are automatically logged out of the Mirror 
application after a designated time during which Mirror 
does not receive any keyboard or mouse input. An 
automatic logout time is established globally for all 
Mirror users.

Audit trails

Mirror’s audit trails enable you to track system and 
database events. System events include login attempts 
(successful or failed) and creating or destroying a 
database. Database events include opening a database, 
and opening, creating, modifying, or deleting patient 
records. Access to audit data is controlled by user 
rights; Power Users may view event reports, however 
only Administrators can specify which events will be 
tracked or schedule purging of event reports.
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Specific system and database events can be configured 
to include a “prompt for reason” dialog to appear 
whenever a user initiates one of these events. When 
this feature is enabled, the user is prompted to enter a 
reason in an Event Reason dialog. The user’s entry in 
the Event Reason dialog appears on the Event Report 
for that event.

Mirror’s security and audit features are enabled through 
Set System Options on the Options menu. By default, 
security features are not enabled.

Setting System Options

Canfield DB Administrators can use the Set System 
Options command to define user and group roles, 
set up logins and auto-logout times, and enable audit 
trails. Canfield Users and Power Users cannot open the 
System Options command.

Using the System Options dialog

Select Set System Options from the Options menu to 
open the System Options dialog box. Note: The Apply 
button applies all system options settings (in all tabs).

Security tab

The Security tab is used to define user and group 
roles, enable logins, and set the duration time before 
automatic logout occurs. User and group roles are 
defined for a specific database.

Enable Login — Enables a Mirror login for all SQL 
Server databases. Mirror logins are useful if multiple 
users share a single workstation.

Enable Auto Logout — Enables Mirror’s automatic 
logout feature. When enabled, auto logout applies to 
all Mirror users. Note: Manual logout from Mirror is 
available from the File menu.
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Logout after (x) minutes of idle time — Sets the number 
of minutes to elapse without any keystrokes or mouse 
input to Mirror before the user is automatically logged 
out.

Database Name — Displays the currently selected 
database for assigning database roles.

Server Name — Displays the SQL Server for the selected 
database.

Database Role — Used to specify the role (Canfield 
DB User, Canfield DB Power User, or Canfield DB 
Administrator) that will be assigned to the selected 
user(s) or group(s).

Switch Database — Used to select a SQL Server 
database. Roles assigned to users or groups will apply 
for the selected database.

Assign — Used to select the users or groups who will 
be assigned the database role.

All — Selects all users and groups in the list.

None — De-selects all users and groups in the list.

DBO — Displays the DBO for the selected SQL Server 
database.

Audit Trails tab

The Audit Trails tab is used to select the system and 
database events that you wish Mirror to track.

Enable Audit Trails — Enables Mirror’s audit trail 
feature. This option must be checked before specific 
events can be selected for tracking.

System Events

Track Login Event — Used to track all Mirror logins. 
This option has no effect if Mirror logins are not 
enabled.
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Track Create DB Event — Used to track database 
creation.

Track Destroy DB Event — Used to track database 
destruction.

Prompt for reason — Causes an Event Reason dialog to 
appear when the user attempts to perform the function. 
The user is prompted to enter a reason.

Database Events

Open DB — This event occurs each time a specific user 
connects to a specific database. Open DB events are 
tracked whether Mirror or Windows logins are used.

Create Patient — This event occurs when a new patient 
record is created.

Modify Patient — This event occurs when patient 
demographic data is modified.

Delete Patient — This event occurs when a patient 
record is removed from the database.

Open Patient — This event occurs when a user opens 
the chart for a specific patient. Note: Only one open 
patient event is recorded for a specific patient per open 
database.

Prompt for reason — Causes an Event Reason dialog to 
appear when the user attempts to perform the function. 
The user is prompted to enter a reason for the event. 
To enable this feature for a specific event, click on the 
event. Then check Prompt for reason.

Switch database — Used to select a database for setting 
database events.

Enable auto purge — Used to automatically purge the 
Event History.

Purge event history after x months — Used to specify 
the number of months security reports will be retained 
before they are purged.
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SQL Server tab

For users running Microsoft SQL Server Express or 
MSDE without MS SQL Server Enterprise Manager, this 
tab provides access to some SQL Server management 
functions.

3.5  CUSTOMIZING THE TOOLBAR AND MENUS 

The Customize dialog box is used to selectively show 
or hide various commands in the main menus, and to 
add, remove or rearrange buttons on the main toolbar. 

Toolbar tab

Select Customize from the Options menu and click the 
Toolbar tab. Select an item in the Button Category 
list at the left side of the dialog box. Click on a button 
in the Available Buttons list to display the description 
of that button at the bottom of the dialog box. 

Adding a Tool to the Toolbar — Drag a button from the 
Customize dialog box onto the toolbar. The new button 
is inserted on the toolbar in the position at which it is 
dropped. 

Rearranging Tools on the Toolbar — Select Customize 
from the Options menu and click the Toolbar tab. 
Drag a button on the toolbar to a new location. To add 
extra space between two buttons, drag a button one 
half position to the right. 

Removing a Tool from the Toolbar — Select Customize 
from the Options menu and click the Toolbar tab. 
Drag a button off the toolbar to remove it. 

Menu tab

The Menu tab shows available tools (or menu 
commands) by menu category. Select a menu category 
to view a list of related tools. Click on the check box 
to the left of a list item to select or clear it. All selected 
items appear in the corresponding menu. 
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3.6  TEMPLATES 

Several tools (Match Colors, Adjust Colors, Labels and 
Print) offer user-definable templates. Saving tool settings 
as a template makes it easy to apply the same settings 
to additional images in the future. For example, you 
may wish to create a Print template for before-and-after 
images with the patient’s name and procedure date 
across the top of the page and a caption below each 
image indicating “Pre‑Op” or “Post‑Op.”

Although the specific settings stored in a template vary 
from tool to tool, the manner in which templates are 
created, managed and applied is consistent. 

Creating a template

1  Open or select an image and activate a tool that 
offers templates. 

2  Perform the actions or adjustments that you wish to 
save to a template, but do not exit the tool. 

3  Select Add Current from the tool’s Template menu. 

4  Enter a name for the template and click OK. 

Applying a template

1  Open or select an image and activate a tool that 
offers templates. 

2  Select the desired template from the tool’s Template 
menu. (Note: The Template menu can display up 
to twelve templates. If you do not see the desired 
template in the menu, select More.) 

	 If you wish, you may designate a particular Labels 
template to be applied to all images automatically on 
import (see Labels in section 3.3). 
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Deleting a template

1  Open or select an image and activate a tool that 
offers templates. 

2  Select More from the tool’s Template menu. 

3  In the Templates dialog box, select a template and 
click Delete. 
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CHAPTER 4 
Menu Overview 

4.1  ABOUT THE MENUS 

This chapter briefly describes all of the commands that 
may appear in the main menus. Depending on which 
Mirror software modules you’ve purchased and the 
configuration of your system, some of these commands 
may not appear. 

From time to time, certain menu commands may 
appear “dimmed” or “grayed out.” These commands are 
unavailable based on the current state of the program. 
For example, if the Chart is open but no images are 
selected, any command requiring an image as a target 
is unavailable. 

Customizing menus

You can select which items appear on the drop-down 
menus. To do so, select Customize from the Options 
menu, click the Menu tab, and select the appropriate 
menu in the Menu Category list. Make sure the 
check box is selected for the desired menu item in the 
Available Tools list. 
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4.2  FILE MENU 

New Patient — Opens the Add/Modify Patient Record 
dialog box so you can create a new patient record.

Open Patient Chart — Opens the Chart tab  
(see 7.2 The Chart Tab for details).

Search for Patient — Opens the Patient Search tab so 
you can locate a patient record. 

Search for Images — Opens the Image Search tab so 
you can locate specific images. 

Save Images — Opens the Save Images dialog box 
so you can save new or changed images to a patient 
record. (Available only if new and/or changed images 
are open in the Image Gallery.) 

Save Duplicate Images — Opens the Save Images 
dialog box so you can save a copy of one or more 
images to any patient record. 

Switch Database — Opens the Switch Database dialog 
box. This command is available only if you have 
assigned multiple databases to the software  
(see 3.2 Setting Database Options for details). 

Import Patients — Used to import complete patient 
records (data and images) previously exported 
from any Canfield system using the Export Patients 
command. 

Export Patients — Used to export complete patient 
records (data and images) so they may be imported 
into any Canfield system. 

Delete Patients — If the Chart is open, removes the 
current patient record (data and images) from the 
database. If the Patient Search tab is open, removes all 
selected patients from the database. 

Undelete Patients — Displays a list of previously 
deleted patient records so they may either be restored 
to the database or permanently erased (purged). 
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Close Image — Closes the active image in the Image 
Gallery. If the current image is new or changed, the 
user is prompted to save it. 

Close All Images — Closes all images in the Image 
Gallery. If any images are new or changed, the user is 
prompted to save them. 

Print — Opens a submenu from which you can print 
images to paper, to slide format, or from video.

Lock Program — Minimizes the application and 
requires the user to enter a user name and password 
to re-open the program. (May be activated by selecting 
CTRL + ALT + L.)

Exit — Exits the program and returns to the Windows 
desktop. 

4.3  CAPTURE MENU 

Depending on your system configuration, some of the 
Capture commands may not appear in your menus. 

Import Images and Acquire are available in all 
Mirror software. All other capture commands require 
PhotoTools. 

Import Images — Used to import image files or video 
clips of any valid format. (Note: PhotoTools is required 
to import video clips.) 

Acquire — Opens a submenu of commands for 
working with TWAIN devices such as scanners. 

Capture Images — Opens the Import tool for tethered 
operation of digital still cameras that do not provide 
live video preview (available for supported Nikon 
SLRs).

Digital Video Capture — Opens the Digital Video 
Capture tool for capturing still images from a digital 
video source. 
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Pre-op Capture — Opens the Pre‑op Capture tool 
for tethered capture of a series of still images using a 
digital still camera that provides live video preview or a 
digital video camera. 

Post-op Capture — Opens the Post‑op Capture tool for 
tethered capture of a series of post‑op images correspond
ing to a previously captured series of pre‑op images using 
a digital still camera that provides live video preview or a 
digital video camera. 

Video — (Targa/FlashPoint card only) Activates the 
video camera for recording live video or playing it back. 

Live — (Targa/FlashPoint card only) Activates the video 
camera for set up or for viewing videotape.

Digital Video Record — Opens a tool for capturing 
motion video clips from a digital video source. 

4.4  IMAGE MENU

Many of the commands in the Image menu require 
PhotoTools. 

Match Colors (PhotoTools) — Automatically balance the 
color of one image to match the color of a second image. 

Adjust Colors (PhotoTools) — Manually adjust the color 
of an image by visual inspection. 

Focus (PhotoTools) — Sharpen or soften an image. 

Match Orientation (PhotoTools) — Automatically adjust 
the rotation and magnification of one image to match a 
second image. 

Rotate Image — Rotate an entire image by ninety 
degrees. 

Whiteboard (PhotoTools) — Create temporary markings 
on an image (or save a copy of the image with markings). 

Labels (PhotoTools) — Add labels and callouts to a 
non-destructive layer that may be saved with an image, 
turned on or off, and modified at any time. 
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Layout Board (PhotoTools) — Create a copy of an 
image at a different resolution, crop an image or 
combine multiple images into a single composite image. 

Delete Image — Remove one or more images from a 
patient record. 

Undelete Image — Displays a list of images previously 
deleted from the current patient chart. Images may be 
restored to the chart or permanently erased (purged). 

Restore Image — Discard modifications made to an 
image using simulation tools. 

Copy Image — Place a copy of an image on the 
Windows Clipboard. The image may then be placed in 
another program using the Paste command. (Note: The 
other program must be able to paste image files from 
the Clipboard.) 

Paste Image — Insert an image from the Windows 
Clipboard into the current patient chart or the Image 
Gallery. 

Send To — A submenu of commands for transferring 
images to other programs. 

4.5  VIEW MENU 

Compare — Used to fade between two different images 
(typically pre-op and post-op) or to fade between 
the original and modified versions of a single image. 
Compare is a feature of PhotoTools. 

Side-by-Side — Used to view two different images— 
or the original and modified versions of an image—
next to each other on the screen. 

Compare Method — Opens a submenu for selecting 
how to show the Compare and Side-by-Side views: 
normal or embossed. This is a feature of PhotoTools. 
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Layers — Allows the user to selectively show or hide 
data layers associated with an image (analysis, labels, the 
ImageCheck symbol, composite, density, and modesty 
panels). 

Show Image History — Displays various data for an 
image (when it was imported, when it was modified, 
image resolution, camera settings, etc.). 

Prioritize — Activates the Prioritize tool, so you can 
show single or combined modifications on an edited 
image (e.g., rhinoplasty and chin, rhinoplasty only, or 
chin only). Prioritize is a feature of Aesthetic Simulation 
in Mirror Suite. 

Mirror — Shows the active image the way the patient 
sees it in the mirror. This is a feature of PhotoTools. 

Asymmetry — Demonstrates a patient’s asymmetry  
by displaying a composite of two left sides next to a 
composite of two right sides. (Note: Use asymmetry  
on front view images.) Asymmetry is a feature of 
PhotoTools. 

Zoom — Activates the Zoom tool for magnifying 
portions of an image on screen. 

Show Edges — Displays the active image in embossed 
mode to emphasize lines and imperfections. Show 
Edges is a feature of PhotoTools. 

Loupe — Activates the Loupe tool for magnifying 
portions of an image on screen. 

Enhance — Activates the Enhance tool for displaying 
the standard image along with an enhanced image that 
makes pigment, fine lines and other surface features 
more apparent.

Digital Video Playback — Opens a tool for viewing 
motion video clips. Also allows still images to be captured 
from a video clip. This is a feature of PhotoTools. 

Blank Screen — Blanks out the screen for privacy. The 
blank screen can be used as a light box for x-rays. 
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4.6  SHAPE MENU (only in Aesthetic Simulation)

All tools listed in the Shape menu require the Aesthetic 
Simulation module in Mirror Suite. Some features 
also require one of the procedure-specific simulation 
modules. 

Warp — Opens a tool you can use to reshape areas of 
an image as if they were made of clay. 

Copy — Opens a tool you can use to duplicate areas of 
an image. (Requires Breast or Bleph & Brow module.) 

Resize — Opens a tool you can use to enlarge or 
reduce areas of an image. 

Stretch — Opens a tool similar to resize, but with one 
side of a selected area remaining fixed. 

Rotate — Opens a tool you can use to rotate a portion 
of an image. 

Rubber Stamp — Opens a tool you can use to 
duplicate an area of an image multiple times. 

Cutout — Opens a tool you can use to remove 
portions of an image. 

Excise — Opens a tool you can use to selectively 
remove portions of an image that are darker than their 
surroundings. 

Fade — Used to soften the effects of a modification. 

4.7  DRAW MENU 

Except for Wrinkle, all tools listed in the Draw menu 
require the Aesthetic Simulation module in Mirror 
Suite. Some features also require one of the procedure-
specific simulation modules. The Wrinkle tool is 
available with Rejuvenation.

Airbrush — Opens a tool you can use to paint over 
portions of an image with a solid color. 
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Texture — Opens a tool you can use to paint over 
portions of an image with a texture. 

Blend — Opens a tool you can use to smooth areas of 
an image. 

Erase — Opens a tool you can use to selectively 
remove or soften modifications made to specific areas 
in an image. 

Clone — Opens a tool you can use to paint over portions 
of an image using a sampled area from any open image. 
(Requires Breast or Bleph & Brow module.) 

Wrinkle — Opens a tool you can use to remove 
wrinkles, fine lines or blemishes. (Requires Skin 
Rejuvenation module.) 

4.8  TOOLS MENU 

Analysis — Opens a submenu of tools you can use to 
measure distances, area, angles and proportions in an 
image. Also measure the amount of change between 
original and modified images and calculate hair density. 
(Analysis tools are included with PhotoTools.) 

Resurfacing — Opens a tool you can use to 
demonstrate realistic resurfacing results including  
post-op redness. (Resurfacing is a feature of the  
Skin Rejuvenation module.) 

Breast Warp — Opens a tool you can use to 
demonstrate realistic outcomes for breast augmentation. 
(Breast Warp is a feature of the Breast module, only 
available with Mirror Suite.) 

Eyelids — Opens a tool you can use to demonstrate 
realistic blepharoplasty outcomes. (Eyelids is a feature 
of the Bleph & Brow module, only available with Mirror 
Suite.) 
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Hair — Opens a submenu with tools you can use for 
demonstrating realistic hair replacement outcomes,  
for simulating hair loss or for planning hair restoration 
surgery. (Hair tools are included with the Hair module, 
only available with Mirror Suite.) 

Presentations — Opens a tool you can use to create 
and view presentations. (The Presentations tool is a 
feature of PhotoTools.) 

Modesty — Opens a tool you can use to cover portions 
of an image with removable panels. (Modesty is a 
feature of PhotoTools.) 

4.9  OPTIONS MENU 

Set Program Options — Used to set screen display 
parameters, image parameters, disclaimer message 
parameters, video input and output parameters, or to 
set other Windows programs to run from within the 
software. 

Set Database Options — Used to perform database 
administration functions such as creating and destroying 
databases, converting Access databases to SQL Server, 
setting the startup database, scheduling backups, 
configuring database field formats, and setting the 
software to automatically purge deleted images and 
patient records.

Set Tool Options — Used to customize several tools. 

Set System Options — Used to enable Mirror’s security 
features, including defining user and group roles, 
setting up logins and auto-logout times, and enabling 
audit trails.

Customize — Used to selectively show or hide various 
commands in the main menus, and to add, remove or 
rearrange buttons on the main toolbar. 
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4.10  UTILITIES MENU

Attributes Manager — Used to add, modify or delete 
attribute libraries. 

Recompress Images — Used to selectively recompress 
image files to save disk space. 

Generate Thumbnails — Used to generate missing 
thumbnail images or to regenerate existing thumbnails 
for all images in a database at once. 

Find Orphan Images — Used to locate image files that 
are missing corresponding database entries and restore 
them to the database. 

Extras — Used to view and print Event Reports 
generated by Mirror’s audit trail feature.

4.11  HELP MENU

Help Topics — Opens the online help library. 

About — Displays information about the software you 
are running and technical support telephone number.
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CHAPTER 5 
Importing Images 

5.1  IMAGE SOURCES 

There are various ways to capture digital images and 
import them into the software. 

Digital camera with removable media

Most digital cameras store images on removable media. 
To transfer images from camera to computer, the 
storage card is removed from the camera and inserted 
into a card reader connected to the computer. (Note: 
Cameras that support the USB storage class standard 
may be connected to the computer via a USB cable 
without the need for a separate card reader.) The card 
is then recognized by the system as if it were a CD or 
other type of external drive. 

Images from any digital camera may be imported 
directly from the removable media. It is not necessary 
to use any additional software that may have 
been bundled with the camera. (Note: For the best 
compatibility, it is recommended that cameras be set 
to capture JPEG files.) See 5.2  Importing Previously 
Captured Images. 

Stored image files and video clips 

Mirror software supports several standard image file 
formats (JPEG, TIFF, Windows Bitmap and Portable 
Network Graphic), as well as the Canon RAW (CR2) 
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format. In addition, PhotoTools supports AVI media 
files. Images or video clips may be imported from a 
hard drive, network file server, CD, DVD or any other 
location. 

The procedure for importing stored files is the same 
as for importing images from a digital camera. See 
5.2  Importing Previously Captured Images. 

Tethered digital camera

A “tethered” camera is connected to the computer 
during image capture to provide direct communication 
between the camera and the software. (Note: This is 
not the same as connecting the camera to the computer 
after image capture in order to transfer images.) 

A tethered camera may be controlled either partially or 
completely from within the software, and images are 
captured directly into the software. 

Tethered capture is available only with PhotoTools.  
Visit www.canfieldsci.com/imaging-systems/mirror/  
for information on supported cameras.

TWAIN devices

Most scanners and some digital cameras communicate 
with software through a standard interface protocol 
known as “TWAIN.” Mirror software is compatible with 
most TWAIN devices. 

Video source

Digital still images or motion video clips may be 
captured from video sources such as camcorders, 
video microscopes, endoscopes and VCRs. Devices that 
offer digital video output may be connected directly 
to the computer (typically via IEEE-1394/FireWire). 
Other video sources may require an analog-to-digital 
video converter. Video capture is available only with 
PhotoTools. 

http://www.canfieldsci.com/imaging-systems/mirror/
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5.2  IMPORTING PREVIOUSLY CAPTURED IMAGES 

This section describes the process for importing 
images that have already been captured and stored. 
This encompasses images captured with a digital still 
camera, images exported from other software, etc. 

Making images available to Mirror software

Mirror software can import any image that is stored 
in one of the following standard formats: JPEG (.jpg), 
TIFF (.tif), Windows Bitmap (.bmp), Portable Network 
Graphic (.png) or Canfield Image File (.t2k). 

Note: While Mirror software supports the standard TIFF 
format, many proprietary and nonstandard versions of 
TIFF exist that are not compatible. 

There are several ways to make existing image files 
available for import into the software:

Storage card transfer — Most digital cameras store 
captured images on a removable storage card 
(CompactFlash, SmartMedia, MemoryStick, etc.). The 
card may be removed from the camera and inserted 
into an appropriate card reader (either internal or 
external) connected to the computer. Files on the card 
may then be accessed in the same way as on other 
removable storage media (such as CDs, etc.). 

USB connection — Digital cameras that support the 
USB storage class standard may be connected directly 
to the computer using a USB cable. Once connected, 
such a camera appears in the computer’s list of drives, 
providing access to any files on the camera’s storage 
card. In essence, the camera becomes an external card 
reader for the computer. 

Local or network drive — Image files may be imported 
from any accessible hard drive or network file server. 

Removable media — Image files may be imported from 
removable media such as CDs, DVDs or flash drives. 
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The Import Images dialog box

Select Import Images from the Capture menu to 
open the Import Images dialog box. 

Note: The Settings button is only available in the 
Import Images dialog if PhotoTools is installed. 

The Import Images window can be moved or re-sized, 
and the size of thumbnails can be adjusted. 

• � To move the Import Images window, click on 
the blue title bar at the top of the window and 
drag to move the window to a new location. 

• � To re-size the window, place the cursor on a 
horizontal or vertical edge or on a corner of the 
window. When the cursor changes to a  
double-headed arrow, click and drag the mouse. 

• � To adjust the size of the displayed thumbnail 
images, set the number of columns at the top of 
the window between 2 and 12. (Fewer columns 
display larger thumbnails.) 
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Locating the image file directory

The first time you import images from a particular 
location, it is necessary to direct the software to the 
directory containing the image files. If you always 
import images from the same source, you should only 
need to perform this procedure once. 

1  Make sure the device containing image files is 
properly connected to and recognized by your 
computer (i.e., insert removable media, log on to 
network, etc.). 

2  Select Import Images from the Capture menu. 

3  If the correct images do not appear, click the Find 
Images button at the bottom of the dialog box. Repeat 
as needed until the correct images appear. (Note: If you 
prefer, you may use the Directory button to browse 
directly to a specific folder.) 

4  Optional: Check Save Directory Setting if you will 
usually be importing images from this same location. 

Locating or creating a patient record

If a chart already exists for a patient, you can search 
for the chart, open it, and import images into the chart 
from within the Import Images tool. If a chart does not 
exist for the patient, you can create one from within 
the Import Images tool. Note: If no chart is open when 
you import images, the images will be imported to the 
Image Gallery as new (unsaved) images.

1  To search for a patient record, click the Search 
button. On the Lookup Patient window, enter the 
patient’s data. If the patient’s chart appears, double-
click on the chart to open it.

2  If a chart does not appear for the patient, on the 
Lookup Patient window, click ADD. Enter patient data. 
TIP: Press the TAB key to move among fields. You must 
enter a last name for the patient — all other fields are 
optional. (The more information you enter for a patient, 
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the easier it will be to find the patient later using 
Patient Search.) Click Save. 

Selecting images

The Import Images dialog box displays a small stamp 
for each image file in the source directory. Click once 
on an image to select it (a blue frame appears around 
selected images). To deselect an image, click on the 
image again to remove the frame. Use the All or None 
buttons to select or deselect all images at once. To 
select a series of images, click on the first image, then 
press the SHIFT key and click on the last image in the 
series.

Examining images before import

To examine an image closely before importing it, 
double-click on the image to zoom in on it. To 
deactivate the zoom, click the  Thumbnails button.

Automatic rotation of images

If images were captured with the camera held vertically, 
Mirror detects this information and automatically rotates 
the images so they appear with the correct orientation 
once they are imported into the software. This feature 
is available only with cameras that store capture 
information with images. Automatic Rotation is the 
default setting in Mirror. 

If images are not automatically being rotated to the 
correct orientation on import, either your camera does 
not store capture information, or the correct rotation 
setting is not enabled. 

With Mirror PhotoTools, you may still configure the 
software for 90-degree rotation of images upon import: 

1  Click the Settings button in the Import Images dialog 
box to open the Image Import Settings dialog box. 
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2  Select one of the 90-degree rotation options at the 
bottom of the dialog box. 

3  Select the Save Settings check box 

4  Click OK to return to the Import Images dialog box. 

If you do not have PhotoTools, see Rotating images 
manually below.

Rotating images manually

If automatic rotation of images is not available (because 
your camera does not provide capture information 
with images and you do not have PhotoTools) you can 
rotate images manually before import on the Import 
Images screen. To rotate all selected images, position 
the cursor on one of the selected images, right-click, 
and select Rotate Selected. To rotate only one of 
the selected images, position the cursor on the image, 
right-click, and select Rotate. Each additional click on 
Rotate Selected or Rotate will rotate the image(s) 
another 90 degrees.

Discarding images

To delete unwanted images, select the images,  
right-click, and select Delete. All selected images will 
be deleted. 

	 IMPORTANT: Deleting images from the Import Images 
dialog box will permanently remove them from their 
original location without copying them into the 
database. Once an image has been deleted in this 
manner, it cannot be recovered. 

Deleting source images

Select the “Delete source images after import” check 
box to automatically delete the original source images 
once they have successfully been imported and saved 
to a patient chart. This option is not available when 
importing images to the Image Gallery. 
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	 To ensure trouble-free image capture and import, 
Canfield recommends that you use your camera’s card 
format feature to periodically reformat your storage 
cards. Refer to your camera documentation for details. 

Hiding saved images

To remove images from the displayed images list once 
they have been saved, select the “Hide saved images” 
check box. Note: Hiding images is not the same as 
deleting them.

Applying attributes to images

To apply descriptive data to the selected image(s), 
select an attribute (such as Procedure) from the 
Attribute drop-down list. Then select a value from the 
Values List. To apply a value to all selected images, 
double-click on a value from the Values list. To apply a 
value to a single image, drag-and-drop the value to the 
image. To add notes, select Notes from the Attribute 
drop-down list and enter notes in the Notes field. 

	 If you wish to add Attributes and/or Values to the 
drop‑down lists, refer to Chapter 6, Saving Images. 

Importing images

Select all images you wish to import (see Selecting 
images in section 5.2 above). To save selected images 
to the patient chart and remain in the Import Images 
window, click Save. To save selected images to the 
patient chart and close the Import Images window, 
click Save & Close. 

To save selected images to the Image Gallery, be sure 
there is no patient chart open. If a chart is open (a 
patient name appears at the top of the Import Images 
window under Selected Patient), click Clear, then click 
Import.
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If the Chart was open when the Import Images 
command was selected, all imported images are saved 
to the current patient and automatically selected. If the 
Chart was not open, imported images appear in the 
Image Gallery as new (unsaved) images. 

Resizing images on import

With Mirror PhotoTools, you may crop and/or scale 
images as they are imported. Click the Settings button 
in the Import Images dialog box to open the Image 
Import Settings dialog box. Controls for resizing images 
are located in the top portion of the dialog box under 
the “Import size” heading. 

resizing 
controls 

By default, import size is set to “<Automatic>.” This 
setting retains the original resolution of imported 
images without resizing. This is the recommended 
setting for most images. 

To resize images on import, select a resolution setting 
(measured in pixels) from the import size drop-down 
list. If the desired resolution does not appear, click the 
Edit size list… button to open the Edit Image Size List 
dialog box. Enter a width and height in pixels, click 
Add to list and click OK. 

If you wish to apply the current resizing option to all 
future imports, select the Save Settings check box 
before clicking OK to close the Image Import Settings 
dialog box. If you would like the settings to apply only 
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for the current import, make sure the Save settings 
check box is cleared. 

Color correction

With PhotoTools, it is possible to perform color 
correction on images as they are imported. 

1  Capture a series of patient images. Include a standard 
gray card in one of the images. 

2  Open the Import Images dialog box. 

3  Select the image that contains the gray standard. 

4  Click the Settings button to open the Image Import 
Settings dialog box. 

5  Select “New color correction...” from the Color 
drop‑down list under Image Correction to open the 
Image Import Color Adjustment tool. 

Image Import Color Adjustment tool 

	 6  Move the cursor over the image in 
the upper right corner of the screen 
(labeled “Set Click Balance”). The 
cursor changes to an eyedropper.

7  Click in the middle of the gray 
standard with the eyedropper. The 
“Adjusted” images will change to 
reflect the color correction. 

8  Optional: If you wish, you may 
make additional adjustments by 
clicking on the appropriate images. 
Alternatively, you may change the 
values listed in the upper right corner 
of the screen and click Apply. 

In either case, the “Adjusted” images will change to 
reflect the color correction. 

9  Optional: Enter a name for the color correction in 
the Name field. If you leave Name blank, the program 
creates a name from the correction’s values. 
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10  Click OK to accept the color correction or click 
Cancel to exit the Image Import Color Adjustment tool 
without applying the correction. 

11  Optional: If you wish to save the color correction 
settings for use on future imports, select the Save 
settings check box. 

12  Click OK to return to the Import Images dialog box. 

13  Select the images you wish to import and click 
Import or Save. 

Sharpening images on import

With PhotoTools, images may be automatically 
sharpened as they are imported. 

1  Click the Settings button in the Import Images 
dialog box to open the Image Import Settings dialog 
box. 

2  Select “Sharpen” or “Sharpen more” from the 
Sharpness drop-down list under Image Correction. 

3  Select the Save settings check box. 

4  Click OK to return to the Import Images dialog box. 

5.3  USING TWAIN ACQUIRE 

Most scanners and some digital cameras communicate 
with software through a standard interface protocol 
known as “TWAIN.” Canfield software is compatible 
with most TWAIN devices. 

In order to import an image from a TWAIN device, you 
must first install and properly configure the device and 
its accompanying software. 

Selecting the source

You need only select the source once, unless you 
choose the wrong driver or wish to change drivers.
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1  From the Capture menu, select Acquire then Select 
Source to open a list of available TWAIN drivers. 

2  Select the name of the driver that corresponds to the 
device from which you wish to import images. 

3  Click Select. 

Acquiring the image

1  From the Capture menu, select Acquire then 
Acquire Images to open the currently selected TWAIN 
driver. (Note: The TWAIN driver is not part of the 
Canfield software.) 

2  Capture images using the TWAIN software. This 
process varies from one device to the next (refer to the 
software documentation that accompanied the device). 

3  Close the device software. 

Acquire settings

From the Capture menu, select Acquire, then 
Settings. The Twain Acquire Settings dialog box is 
displayed. (Note: requires PhotoTools.) 

 � TWAIN Acquire 
Settings dialog 
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The Import Size, Image Correction and Import Rotation 
features in the TWAIN Acquire Settings dialog function 
the same as their corresponding features in the Image 
Import Settings dialog (see 5.2  Importing Previously 
Captured Images). 

Autofeeders — “Enable autofeeder” is used with 
devices that have autofeeders as input devices 
(typically, page or slide scanners).

Saving images as files — “Save imported images as files 
in” is useful when working with autofeeders. Rather 
than seeing the images appear in the gallery, acquired 
images are stored as files on the hard drive in the 
displayed directory (click Change Path to change the 
directory where acquired images are stored). 

Once the images are imported to files, you can import 
the acquired images by clicking Import Images from 
the Capture menu. Then save the images in the 
appropriate chart(s).

5.4  ROTATING IMAGES AFTER IMPORT 

If an image has already been imported into the software, 
the Rotate Image tool may be used to rotate the entire 
image in ninety degree increments. This can be helpful 
if, for example, the camera was held sideways to capture 
vertical images. In most cases, however, images are 
rotated as they are imported (see above). 

Follow the steps below to rotate one or more full images. 

1  Select or open the image(s) you wish to rotate. 

2  Select Rotate Image from the Image menu. 

3  In the Rotate Images dialog box, select the images you 
wish to rotate (if you wish to apply the same rotation to 
all displayed images, you may skip this step). 

4  Choose a rotation direction (clockwise or 
counterclockwise). 
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5  Click Rotate to apply the rotation to selected images 
or click Rotate All to apply the rotation to all displayed 
images, whether they are selected or not. 

A rotated copy of each image is created. The original 
image remains unaltered. 

5.5  IMAGE HISTORY 

Mirror software maintains a history for each image in the 
database. This image history includes the date and time 
the image was first captured, imported or created, as 
well as any adjustments or modifications that have been 
made to the image in the Mirror software. Depending 
on how the image was originally captured, the image 
history may also include data from the camera. 

To view the history for an image, select or open an image 
and select Show Image History from the View menu. 

ImageCheck

With Mirror PhotoTools or Rejuvenation, the 
ImageCheck symbol appears in the bottom right corner 
of thumbnails and open images. The ImageCheck 
symbol gives a quick visual clue regarding the history 
of that image. Clicking on the ImageCheck symbol 
provides a shortcut for viewing the full image history.

/  Original (captured) — A green checkmark 
indicates that the image was created by a tethered 
capture tool (e.g., Digital Video Capture, VISIA, etc.) 
and has not been modified within Mirror. 

/  Original (imported) — A purple checkmark 
indicates that the image existed as a file outside of 
Mirror and was imported. The image has not been 
modified within Mirror, though its history prior to 
import is unknown. 
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/  Adjusted — A yellow cross indicates that the 
image was created inside Mirror from another image, 
potentially with some kind of global adjustment (color 
adjustment, cropping, etc.). The image has not been 
modified using simulation tools. 

/  Simulation — A hollow red triangle indicates that 
the image contains modifications made with simulation 
tools, but may be restored to an original or adjusted 
state.

/  Modified — A solid red triangle indicates that the 
image contains permanent modifications and cannot be 
restored to an original or adjusted state.
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CHAPTER 6 
Saving Images 

6.1  SAVING MODIFIED IMAGES

Mirror will always preserve the integrity of the original 
“source” images that were captured or imported into a 
Patient Chart. Modifying a source image will generate 
a new image which is not automatically saved. To save 
modified images follow the steps below.

1  Select Save Images from the File menu. The Save 
Images window appears and displays thumbnails of all 
unsaved images. 

Mirror automatically labels each thumbnail according to 
the type of changes you’ve made:

•  �<new> images are those to which you have applied 
adjustments such as color, orientation and rotation, 

Save Images window 		  or simulations such as warp and airbrush. These will 
be saved as separate image files.

•  �<changed> images are those to which overlays 
or layers have been added, such as labels. These 
modifications are saved with the original image, but 
can be removed or changed later if desired.

2  Select the images you wish to save: Click a thumbnail 
to select it, click again if you wish to deselect it, or 
click the All or None buttons to select all or none of 
the images.
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3  Click Save. All selected images are saved to the 
appropriate patient chart and are removed from the 
Save Images window.

	 You can edit the image data in the Save Images 
window prior to saving if desired: Select a single 
thumbnail and its image data will appear in the lower 
right of the window.

6.2  SAVING DUPLICATE IMAGES 

Duplicating a saved image can be useful for collecting 
copies of images that document especially interesting 
cases or exceptional surgical results. This also provides 
a means of moving images that may accidentally have 
been filed under the wrong patient. 

Using the Save Duplicate Images command

The Save Duplicate Images command may be used to 
copy one or more images to a patient chart. 

1  Select or open the images you wish to copy. 

2  From the File menu, select Save Duplicate Images. 
The Save Images window appears and displays all open 
images (if the Chart is closed) or all selected images (if 
the Chart is open). 

3  Select the images you wish to save.

	 Click the All button to select all images at once. 

4  Click Search and enter the Name, MRN or SS# to 
locate the patient record to which you wish to save the 
images. 

5  Double-click on the chart in which you want to save 
the images.

6  Click Save to save selected images to the chart and 
remain in the Save Images window, or click Save & 
Close to save the images and close the Save Images 
window.
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Using the clipboard

The Windows clipboard may be used to copy a single 
image to a patient chart, the Image Gallery, or to any 
other program that supports clipboard images. 

1  Select or open the image you wish to copy. 

2  From the Image menu, select Copy Image. 

3  Move to the destination for the copied image (i.e., 
the Image Gallery, Chart, or other program). 

4  If copying the image into Mirror software, select Paste 
Image from the Image menu. In most other programs, 
the Paste command is located in the Edit menu (refer to 
the program’s documentation for details). 

6.3  IMAGE DATA 

Each image may have descriptive data associated with 
it. Image data may be accessed in the Chart or in the 
Image Data tab on the main screen. 

The Image Data tab

	 The Image Data tab, located in the upper right corner 
of the main screen, provides easy access to the data 
associated with the active image in the main screen. 
Click once to expand the tab. Click the tab again to 
collapse it. (The tab may also be collapsed by clicking 
the right arrow button in the upper right corner.) 

The top portion of the open Image Data tab displays 
patient data for the current image, including the ID 
photo for that patient (see 7.3  Viewing and Modifying 
Patient Data for details on selecting the ID photo).  
To edit the patient data, or to view additional patient 
data, click the Patient Details button. 

If you do not wish personal data to be displayed in the 
Image Data tab, select the Privacy check box. When 
Privacy is selected, the patient name, social security 
number and ID photo are hidden. 
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	 If no patient data appears, the current image has never 
been saved to a patient chart. See 6.1 Saving Modified 
Images for details on saving images. 

Entering image data in the main screen

	 The Image Data tab may be used to add or modify data 
for the active image in the main screen. 

1  Make sure the image you wish to work with is the 
active image. (The active image is displayed full-size on 
the main screen.) 

2  If you have not already done so, save the image to a 
patient chart (see 6.1 Saving Modified Images). 

3  If the Image Data tab is collapsed, click the tab once 
to expand it. 

4  To enter image data, click the Edit Data button.

5  On the Edit Image Data window, select an attribute 
from the drop-down list, then select a value from the 
Values list. (If you selected “Notes” in the Attribute 
field, enter text in the Notes field.) Click Apply.

6  When finished entering image data, click Save to save 
the changes and remain in the Edit Image Data window, 
or click Save & Close to save the changes and close the 
Edit Image Data window. 

Editing image data in the Chart

Image data may also be viewed and modified in the 
Chart. By working in the Chart, it is possible to edit data 
for multiple images simultaneously. 

1  Open the Chart. 

2  Select one or more images. Data for the selected 
images is displayed on the right side of the Chart. 

3  Click the Edit Data button.
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4  On the Edit Image Data window, select an attribute 
from the drop-down list. To apply a value to multiple 
images, select the value and click Apply, or double-
click on the value. To apply a value to a single image, 
drag and drop the value on the image. (If you selected 
“Notes” in the Attribute field, enter text in the Notes 
field.) 

5  If notes were added during image import, you can 
replace or append the notes on the Edit Data window.

• � To replace existing notes, select the image(s) 
with notes you want to replace. In the Notes 
field, enter the new notes. Click Apply.

• � To append notes for a single image, select the 
image. Add additional notes in the Notes field. 
Click Apply. 

• � To append notes for multiple images, select the 
images. In the Applied Image Data window, 
double-click on the notes that you wish to 
append. Enter the additional notes. Click Apply.  

 � IMPORTANT: The appended notes will over
write original notes for all selected images.

6  When finished entering image data, click Save to save 
the changes and remain in the Edit Image Data window, 
or click Save & Close to save the changes and close the 
Edit Image Data window. 

Deleting image attributes

1  Select one or more images in the Chart. 

2  Click the Edit Data button.

3  Select the desired attribute type (procedure, 
diagnosis, etc.) from the Attribute list. 

4  Select the value you wish to delete in the Applied 
Image Data list. 

5  Press the Delete key. 
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6  Click Save to save the changes and remain in the 
Edit Image Data window, or click Save & Close to save 
changes and exit the Edit Image Data window. 

7  Repeat steps 2 through 6 for each attribute or value you 
wish to delete.

The Attributes Manager

Each attribute has a library of possible values which 
may be applied to images. These are the values 
that appear in the Selection List drop-downs. The 
Attributes Manager is used to add, modify or delete 
attribute libraries. Open Attributes Manager by selecting 
Attributes Manager from the Utilities menu or by 
selecting Edit List from a Selection List. 

Adding and removing values in a library

Values may be added to or removed from an attribute 
library using the Attributes Manager. 

1  In the Attributes Manager, select an item in the 
Attributes List to display the corresponding library in 
the Values List. 

 � Attributes 
Manager 

	 “Show VISIA Attributes” should be unchecked if you 
do not have a VISIA system. This will prevent VISIA 
attributes from appearing in drop-down lists.
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2  To add a value to the library, click the Add button 
located below the Values List. If a desired list of values 
already exists in another program (e.g., Word), you 
may copy and paste to add all of the values to the 
attribute library in one step. 

To remove an item from an attribute library, select that 
item in the Values List and click the Remove button 
located below the Values List. The item is removed 
from the library. If the value has already been applied 
to images in the database, you are prompted to either 
remove the value from the library without affecting 
applied data, replace the applied data with another 
value or remove the value from the library and from 
any images to which it has been applied. 

Adding an attribute type

By default, Mirror includes the Procedure, Diagnosis, 
and Physician attributes. You may add as many 
additional attributes as desired.

1  Select Attributes Manager from the Utilities menu 
to open the Attributes Manager. 

2  Click the Add button located below the Attributes List. 

3  Enter a name for the new attribute and click OK. 
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4  Select the desired attribute properties: 

• �Data Type — Select “text” for simple values or 
select “description & code” for paired values 
such as procedure & CPT code. 

• �Allow multiple values — Select this option to 
allow multiple values for the attribute to be 
assigned to a single image. 

• �Values must be selected from list — When this 
option is selected for an attribute (recommended), 
users will be unable to enter any value in the 
Chart that has not already been added to the 
Selection List using the Attributes Manager. This 
option is always selected for the “description & 
code” data type. 

• �Sort list automatically — When selected, the 
values for the attribute will be sorted alpha
betically in both the Attributes Manager and 
the Selection Lists. When cleared, the user may 
choose the order in which values appear by 
using the List Order Buttons. 

5  To insert a dashed line to separate items in the 
Attributes list, click on the item you wish to separate 
and click Add. Click Create Separator and click OK. 
The line appears above the item you selected on all 
Attribute drop-down lists. (To remove the line, select 
it on the Attributes list and click Remove.)

6  With the new Attribute selected, add the desired 
values to the Values List either by using the Add 
button or by copying values to the clipboard (from 
another attribute or another program) and clicking the 
Paste button located below the Values List. 

7  Click Close to close the Attributes Manager. The 
new attribute may now be selected from any Attribute 
drop-down list. 
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Exporting attributes

Using the Attributes Manager, it is possible to export 
a complete attribute library from one database and 
import it into another Canfield database. 

Attributes may be exported as follows:

1  Select Attributes Manager from the Utilities menu. 

2  Select one or more attributes in the Attributes list. 

3  Click the Export button. The Export Attribute dialog 
box appears. 

4  The selected attributes are automatically marked in 
the list. If you wish, you may select additional attributes 
or deselect attributes.

5  When exporting multiple attributes, you may either 
export all selected attributes to a single file or to 
individual files. To export to individual files, select 
“Export each attribute library to a separate file.” 

6  Enter a name for the output file. (Note: If multiple 
attributes are being exported to separate files, each file 
is automatically given the name of the corresponding 
attribute.) 

7  The current export directory is displayed at the 
bottom of the dialog box. Click the Directory button 
to select a different export directory. Note: Check “Save 
Directory Setting” if you will export attributes to this 
directory in the future.

8  Click the Export button to save the selected 
attributes to the export directory. The names, properties 
and values lists for all selected attributes are saved to a 
single file. 

Importing attributes

Once attributes have been exported from a database as 
described above, they may be imported into another 
Canfield database.
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1  Select Attributes Manager from the Utilities menu. 

2  Click the Import button. The Import Attribute dialog 
box appears. 

3  Click the Directory button, browse to a folder 
containing the attribute (.aix) files you wish to import 
and click OK. A list of available attribute files is 
displayed. Note: Check “Save Directory Setting” if you 
will import attributes from this directory in the future.

4  Click to select one or more files in the list. 

5  Click Import. 

Removing redundant attribute values

As your Mirror database grows, you may find that you 
end up with multiple variations of the same attribute 
value (“Breast Augmentation” and “Augmentation 
Mammoplasty,” for example). The following procedure 
will help you clean up your database.

1  Select Attributes Manager from the Utilities menu. 

2  Select the desired attribute in the Attributes list. 

3  Click the Auto Fill Values List button. At the 
prompt, click yes. This adds all applied values for the 
selected attribute to the Values List. 

4  In the Values list, select a specific value that you 
wish to remove and click the Remove button located 
below the Values list. 

5  At the confirmation prompt, click OK. 

	 IMPORTANT:  Be sure the prompt says “Remove 
selected value(s) from list?”.  If the prompt says 
“Remove selected attribute(s)?” you have clicked the 
wrong Remove button. Click Cancel, then click the 
Remove button located below the Values list on the 
right side of the dialog.
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6  If a message appears stating that the attribute value 
is already in use, select Delete from list and replace 
applied values with and select the desired value from 
the drop-down list. 

7  Repeat steps 4–6 as needed to remove additional 
values for the selected attribute. 

8  To help ensure more consistent data entry in the 
future, select the Values must be selected from list 
option for the selected attribute.
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CHAPTER 7 
The Chart, Patient Search, and Image Search Tabs

7.1  THUMBNAIL IMAGES IN THE CHART AND IMAGE SEARCH TABS

	 The Chart and Image Search tabs allow you to view a 
patient’s stored images as small thumbnails on one 
screen. (Refer to 7.2 The Chart Tab and 7.9 Working 
with Images In the Chart for details on using the Chart 
and Image Search tabs.) This arrangement makes it 
easy to work with images in groups (for example, to 
assign the same data to a number of images).

	 Chart 	
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Selecting thumbnails

Many commands operate on whatever images are 
currently selected in the Chart. 

•	Click on a thumbnail to select it. Selected images 
appear with a blue border. 

•	Click on additional images to add to the selection. 

•	Click on a selected image to deselect it. 

•	 The Shift key may be used to select a contiguous 
range of images: Click to select the first image in the 
range. While pressing and holding the Shift key, 
click the last image in the range. All images between 
the first and last image are also selected. 

	 •	 The All and None buttons may be used to select or 
deselect all images in the active patient chart.

Arranging thumbnails

You may arrange the thumbnails in the patient chart in 
any order you choose. 

1  Open the Chart. 

	 2  Make sure the Sort By control above the thumbnails 
indicates “User Defined.” If it does not, select “User 
Defined” from the drop-down list. 

3  Click on the thumbnail you wish to move and keep 
the mouse button pressed. 

4  While continuing to hold the mouse button, move 
the cursor to the position where you would like to 
place the thumbnail. 

5  Release the mouse button to drop the thumbnail 
in its new position. (Note: The cursor must be above 
another thumbnail when you release the mouse 
button—it cannot be between thumbnails.) 
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Sorting thumbnails automatically by date

Select an item from the Sort By drop-down list (located 
above the thumbnails) to automatically sort thumbnails 
by image date. You may choose to either show the 
newest images first or show the oldest images first. 

Resizing thumbnails

	 The size of the thumbnails in the Chart may be 
changed by selecting the number of columns to display 
(fewer columns allows larger thumbnails). Use the 
Columns control at the top of the Chart to select the 
number of columns (from 2 to 12). 

Opening thumbnails and accessing commands

Double-click on a thumbnail to open the image in 
Image Gallery. Right-click on an image to display a 
pop-up menu of common commands. 

7.2  THE CHART TAB

The Chart tab allows you to view previously created 
patient records. After you have created patient charts 
and imported images into them, you can use the Patient 
Search or Image Search tabs to locate a specific patient 
or image.

Creating a patient chart

To create a patient chart, do the following:

1  From the File menu, select New Patient. 

2  Type the patient’s information into the Add/Modify 
Patient Record dialog box. Press the TAB key to move 
among fields or select a field and type. You must enter a 
Last Name for every patient; all other fields are optional. 
(The more information you enter for a patient, the easier 
it will be to find the patient later using Patient Search.) 
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3  When finished entering data, click Save to add the 
new patient or click Cancel to close the Add/Modify 
Patient Record dialog box without adding the patient. 

Accessing the Chart

The Chart is accessed by clicking the Chart tab at the 
right edge of the main screen. Click the tab again to 
collapse it. (The tab may also be collapsed by clicking 
the right arrow button in the upper right corner.) 

Filtering the Chart

If you have performed a search in the Patient Search 
or Image Search tab, you may filter the Chart to display 
only those patients/images matching the current search. 

If you have performed a patient search, select View 
Patient Search Results and use the navigation 
controls to scroll through the charts for those patients 
who match the current search. 

navigation 
controls 

filter 
drop‑down

If you have performed an image search, select View 
Image Search Results and use the navigation controls 
to scroll through the charts for those patients with 
images matching the current search. As you view each 
patient record, only those images matching the current 
search are displayed. To view all images for the current 
patient, select View All from the Filter drop‑down list. 
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Viewing image attributes

To quickly view attributes for a single image, move the 
cursor over that image and pause (it is not necessary to 
select the image). A pop-up window appears displaying 
data for that image. Move the cursor to close the 
pop‑up image data window. 

If you wish to view data for multiple images, follow the 
procedure below. 

1  Select one or more images in the Chart. 

2  Attributes and values appear in the Image Data 
field. 

3  Attribute values for the selected images are displayed 
in the applied values list. Values applied to all selected 
images appear in black type. Values applied to only 
some of the selected images appear in gray type. 

Filter by attribute

To select images with a common attribute, for example, 
only those images captured on a certain day, or that 
represent a specific treatment, follow the procedure 
below.

	 1  Click  All to select all of the 
thumbnails in the current patient chart. 
Attribute values for all of the images are 
displayed in the applied values list. 

2  Double-click on the desired attribute. 
Images which do not include the 
attribute are deselected.

3  Click  Open Images to 
view the images that remain selected.
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7.3  VIEWING AND MODIFYING PATIENT DATA

Summary patient data is displayed in the Image Data and 
Chart tabs. To edit patient data, or to view additional 
patient data, click the Patient Details button in either 
the Chart or Image Data tabs. 

The ID photo

For each patient record, one image is used as an ID 
photo. This image appears as a small stamp in the 
Image Data tab, in the Save Images dialog box and in 
the Patient List on the Patient Search tab. By default, 
the ID photo is the first image in a patient’s chart. To 
use a different image as a patient’s ID photo, open the 
Chart for that patient, drag the desired image from the 
image list and drop it onto the ID photo. 

Privacy mode

When using the software in front of a patient, you will 
probably want to preserve the privacy of other patients 
in your database. Select the Privacy check box at the 
top of the Patient Search tab to suppress the display of 
personal information. When Privacy is selected, patient 
names, social security numbers and ID photos are 
replaced by the word “(privacy).” 

Privacy mode is also available in the Image Data tab. 

7.4  EXPORTING AND IMPORTING PATIENT RECORDS 

Export patients

The Export Patients command saves a complete patient 
record—including all patient data, images and image 
data—to a single file on a hard drive, network server or 
removable media. The file may then be imported into 
any Canfield system. This is useful for archiving patient 
records to offline storage or for transferring patient 
records from one Canfield system to another. 
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Exporting a single patient

1  Open the patient chart for the patient you wish to 
export. 

2  Select Export Patients from the File menu. The 
Export Patient Records dialog box opens displaying a 
list of all patients in the active database. The current 
patient is automatically selected in the list. 

3  Confirm that the destination directory displayed at 
the bottom of the dialog box is the location to which 
you wish to export the patient record. To select a 
different export destination, click Change Directory 
and browse to the desired folder. If you wish to make 
this directory the default export destination, select the 
Save Directory Setting check box. 

4  The software automatically assigns a name for the 
export file composed of the patient’s name and a unique 
number. You may enter a different filename if you wish. 

	 IMPORTANT: The output filename must end in “.dix” or 
“.dx2” in order to be imported into a Canfield system. 

5  By default, the software overwrites any file in the 
export destination that has the same filename as the 
current export. To be prompted when a file with the 
same name is encountered, select the Prompt before 
deleting existing files with the same name check 
box. 

6  Click Export to save the export file to the selected 
destination or click Cancel to close the Export Patient 
Records dialog box without saving a file. 

Exporting multiple patients

1  Open the Patient Search tab. 

2  If you wish, you may enter data in the search fields 
to filter the patient list (see 7.7 The Patient Search Tab 
for details). 
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3  In the patient list, click on the patient’s ID photo to 
select that patient (clicking a second time deselects the 
patient). Select all of the patients that you wish to export. 
You may use the All/None buttons above the patient 
list to select/deselect all patients in the list at once. 

4  Select Export Patients from the File menu. The 
Export Patient Records dialog box opens displaying a 
list of all patients in the active database. All patients 
selected in the Patient Search tab are automatically 
selected in the dialog box. 

5  Confirm that the destination directory displayed at 
the bottom of the dialog box is the location to which 
you wish to export the patient record. To select a 
different export destination, click Change Directory 
and browse to the desired folder. If you wish to make 
this directory the default export destination, select the 
Save Directory Setting check box. 

6  Select the Export each record to a separate file 
check box if you wish to allow patient records to 
be imported on an individual basis. With this option 
selected, each patient record is stored as a separate 
file that is independent of the others. The software 
automatically assigns a filename to each of these files 
made up of the patient name and a unique number. 

If you wish to export all selected patients to a single 
file, clear the Export each record to a separate file 
check box. Patients exported to a single file cannot 
be imported individually. Opening a file that contains 
multiple patient records imports all patients in that 
file. (However, patient records will be separate once 
they are imported.) The software automatically assigns 
a name for the export file. You may enter a different 
filename if you wish. 

	 IMPORTANT: The output filename must end in “.dix” in 
order to be imported into a Canfield system. 
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7  By default, the software overwrites any file in the 
export destination that has the same filename as the 
current export. To be prompted when a file with the 
same name is encountered, select the Prompt before 
deleting existing files with the same name check 
box. 

8  Click Export to save the export file to the selected 
destination or click Cancel to close the Export Patient 
Records dialog box without saving a file. 

Exporting patient data as text files

Export and import of patient data as standard text files 
(*.txt or *.csv) allows exchange of patient demographic 
data with other programs.

1  Select one or more patients in Patient Search.

2  Select Export Patients from the File menu or right-
click on a selected patient and select Export Patients.

3  Under Data format for export select “Export patient 
data only to a standard text file (*.csv)”.

4  Click Select Data.

5  Select the desired 
data fields and click 
OK.

6  Enter a file name, 
select a directory and 
click Export.

You can now open the 
exported CSV file in 
MS Excel or any other 
program that supports 
CSV files.
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Import patients

Use the Import Patients command to open a patient 
record previously exported from a Canfield system into 
the same system or into a different Canfield system. 

1  Select Import Patients from the File menu. The 
Import Patient Records dialog box opens displaying 
a list of all Canfield patient record (.dix) files in the 
current directory. 

2  If the desired file does not appear, click Change 
Directory and browse to the correct folder. If you wish 
to make this directory the default for future imports, 
select the Save Directory Setting check box. 

3  Click to select one or more files in the list. You may 
use the Check All and Uncheck All buttons to select 
or deselect all files at once. 

4  If you wish to automatically delete the files from 
the import directory after they are imported, select 
the Delete Record Files When Done check box. If 
this check box is cleared, the files will remain in their 
original location after the records are extracted. 

5  Click Import to open the selected record files or 
click Cancel to close the Import Patient Records dialog 
box without importing any patient records. 

•	 If a file contains records for multiple patients, each 
patient is imported to a separate chart. 

•	 If an imported patient already appears in the active 
database, the imported record is merged with the 
existing record. 

•	 If data or images exist in the imported file that are 
not present in the existing record, the new data or 
images are added. 

•	 If incoming data or images conflict with existing data 
or images, the existing record takes precedence. 
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Importing patient data

1  From your practice management or other software, 
export patient data as a Comma Separated Values (CSV) 
file. (For instructions on exporting a CSV file, consult 
your software’s documentation.)

	 IMPORTANT:  If you are importing patient data into a 
Mirror database that already contains data and images, 
make sure you have a current backup of that Mirror 
database before proceeding.

2  In Mirror, select Import Patients from the File 
menu.

3  Click Change Directory and browse to the folder 
with the CSV file.

4  Click a check box to select the desired file in the list.

5  If you are importing patient data into a Mirror 
database that already contains data and images, you 
may wish to check for duplicate records as the new 
data is imported:

• � Select Check for duplicate records.

• � Click Settings.

• � Select one or more fields to be considered 
when checking for duplicates. (Note: A unique 
identifier, such as Medical Record Number or 
Social Security Number, is recommended.)

• � Click OK.

6  Click Import.

7  Select options for field separator and header data that 
are appropriate for the file being imported.

8  Map data fields in the imported file to data fields 
in the Mirror database. Imported fields appear on the 
left. You may use the arrows below this list to view 
individual records in the imported data. Click to the 
right of an imported field to select the Mirror data field 
that should receive that data.
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9  Select how you would like to handle any matches 
that may be detected during import. Unless both your 
imported data and your existing Mirror data contain a 
unique identifier such as Medical Record Number or 
Social Security Number, it is recommended that you 
select “Prompt for each duplicate found.”

10  Click Finish.

Merging patient records

Over time, you may find that your Mirror database 
comes to contain duplicate records for one or more 
patients. You may clean up your database using one of 
the following methods:

Merge two selected patients

1  Select two patients in Patient Search.

2  Select Merge Duplicate Records from the Utilities 
menu.

3  At the prompt, select Merge two selected records 
and click OK.

Images from both selected patients are merged into the 
newer of the two charts and the redundant record is 
deleted.

Search database and merge duplicate records

1  Select Merge Duplicate Records from the Utilities 
menu.

2  Select one or more fields to be used in determining 
that records are duplicates. (Note: A unique identifier, 
such as Medical Record Number or Social Security 
Number, is recommended.)

	 3  Click OK.

4  Select how you would like to handle any matches 
that may be detected. Unless all of the Mirror 
patient records contain a unique identifier such as 
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Medical Record Number or Social Security Number, 
it is recommended that you select “Prompt for each 
duplicate found.”

5  Click OK.

7.5  DELETING PATIENT RECORDS 

The Delete Patients command may be used to remove 
one or more patient records from the active database.  
It is typically a good idea to export a patient record 
(see 7.4 Exporting and Importing Patient Records) prior 
to deleting it. 

Removing a single patient record

1  Open the patient chart for the patient you wish to 
delete. 

2  If you have not already done so, make an archive of 
the patient record using the Export Patients command 
(see 7.4 Exporting and Importing Patient Records). 

3  Select Delete Patients from the File menu. 

4  When a confirmation message appears, click Yes to 
remove the patient record or click No to cancel the 
deletion and keep the record in the database. 

Removing multiple patient records

1  Open the Patient Search tab. 

2  If you wish, you may enter data in the search fields 
to filter the patient list (see 7.7 The Patient Search Tab). 

3  In the patient list, click on the patient’s ID photo to 
select that patient (clicking a second time deselects the 
patient). Select all of the patients that you wish to delete. 
You may use the All/None buttons above the patient 
list to select/deselect all patients in the list at once. 

4  If you have not already done so, make an archive of 
the patient records using the Export Patients command 
(see 7.4 Exporting and Importing Patient Records). 
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5  Select Delete Patients from the File menu. 

6  When a confirmation message appears, click Yes to 
remove the patient records or click No to cancel the 
deletion and keep the records in the database. 

Restoring a patient record

The Delete Patients command moves patient records 
to a temporary holding area, similar to the Windows 
Recycle Bin. If you later change your mind about the 
deletion, you may restore a patient record back to the 
active database. 

1  Select Undelete Patients from the File menu. The 
Undelete Records dialog box appears and displays a list 
of deleted patients. If the Undelete Patients command 
is not available, either no patients have been deleted or 
the deleted records have been purged (see below). 

2  Click to select one or more patients in the list. You 
may use the Check All and Uncheck All buttons to 
select or deselect all patients at once. 

3  Click Undelete to restore the selected patient 
records or click Cancel to close the Undelete Records 
dialog box without restoring any patients. 

Permanently deleting patient records

Although the Delete Patients command removes 
patient records from the active database, it does not 
permanently delete them. Deleted records continue to 
consume storage space on the hard drive or network 
server until they are purged. 

1  Select Undelete Patients from the File menu. The 
Undelete Records dialog box appears and displays a list 
of deleted patients. If the Undelete Patients command 
is not available, either no patients have been deleted or 
the deleted records have already been purged. 
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2  Click to select one or more patients in the list. You 
may use the Check All and Uncheck All buttons to 
select or deselect all patients at once. 

3  Click Purge to permanently delete the selected 
patient records or click Cancel to close the Undelete 
Records dialog box without purging any patients. 

	 IMPORTANT: Once a patient record has been purged,  
it cannot be recovered using the Undelete Patients 
command. Make sure patient records have been 
properly archived before purging them. 

Purging deleted records automatically

If you wish, you may configure the software to 
automatically purge all deleted records every time 
the program exits. This prevents deleted records from 
consuming storage space unnecessarily. 

1  Select Set Database Options from the Options 
menu. 

2  Select the Options tab. 

3  Select the Auto-purge deleted records and 
images at program exit check box and click OK. 
Whenever you exit the program, any patient records 
or images that have been deleted using the Delete 
Patients or Delete Image commands will be purged 
automatically. 

	 IMPORTANT: When the auto-purge option is selected, 
you will be unable to restore patient records or images 
using the Undelete Patient or Undelete Images 
commands. Make sure all users of your system are 
informed if you select the auto-purge option. 
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7.6  DELETING IMAGES 

The Delete Image command may be used to remove 
one or more images from a patient record. 

Removing images from a patient record

1  Open the Chart. 

2  Select the image(s) you wish to delete. 

3  Select Delete Image from the Image menu. 

4  When a confirmation message appears, click Yes to 
remove the image(s) from the patient record or click No 
to cancel the deletion and keep the image in the chart. 

Restoring a deleted image

The Delete Image command moves images to a 
temporary holding area, similar to the Windows Recycle 
Bin. If you later change your mind about the deletion, 
you may restore an image back to it’s original patient 
record. 

1  Open the appropriate patient chart. 

2  Select Undelete Image from the Image menu. The 
Undelete Images dialog box appears and displays a list 
of deleted images for the current patient. If the Undelete 
Images command is not available, either no images 
have been deleted from the current patient record or the 
deleted images have been purged (see below). 

3  Click to select one or more images in the list. You 
may use the Check All and Uncheck All buttons to 
select or deselect all images at once. 

4  Click Undelete to restore the selected images or 
click Cancel to close the Undelete Images dialog box 
without restoring any images. 
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Permanently deleting images

Although the Delete Images command removes images 
from the patient record, it does not permanently delete 
them. Deleted images continue to consume storage 
space on the hard drive or network server until they 
are purged. 

1  Open the appropriate patient chart. 

2  Select Undelete Image from the Image menu. The 
Undelete Images dialog box appears and displays a list 
of deleted images for the current patient. If the Undelete 
Images command is not available, either no images 
have been deleted from the current patient record or the 
deleted images have been purged. 

3  Click to select one or more images in the list. You 
may use the Check All and Uncheck All buttons to 
select or deselect all images at once. 

4  Click Purge to permanently delete the selected 
images or click Cancel to close the Undelete Images 
dialog box without purging any images. 

	 IMPORTANT: Once an image has been purged, it 
cannot be recovered using the Undelete Images 
command. 

Purging deleted images automatically

If you wish, you may configure the software to 
automatically purge all deleted images every time 
the program exits. This prevents deleted images from 
consuming storage space unnecessarily. 

1  Select Set Database Options from the Options 
menu. 

2  Select the Options tab. 

3  Select the Auto-purge deleted records and 
images at program exit check box and click OK. 
Whenever you exit the program, any patient records 
or images that have been deleted using the Delete 
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Patients or Delete Image commands will be purged 
automatically. 

	 IMPORTANT: When the auto-purge option is selected, 
you will be unable to restore patient records or images 
using the Undelete Patient or Undelete Images 
commands. Make sure all users of your system are 
informed if you select the auto-purge option. 

7.7  THE PATIENT SEARCH TAB

The Patient Search tab allows you to enter search 
criteria to locate an individual patient. When all tabs 
are collapsed, click on the Patient Search tab at the right 
edge of the screen. When either the Chart or Image 
Data tab is open, you may switch to the Patient Search 
tab by clicking on it (all tabs are located at the left edge 
of the active tab). The Patient Search tab may also be 
reached by clicking the  Patient Search button 
located next to the navigation controls in the Chart. 

	 To preserve the privacy of other patients in your 
database when using the software in front of a patient, 
select the Privacy check box at the top of the Patient 
Search tab. The display of personal information is 
suppressed when Privacy is selected: patient names, 
social security numbers and ID photos are replaced by 
the word “(privacy).”

  � The Patient Search tab opens, allowing 
you to enter search criteria to locate 
an individual patient or you may click 
Show all patients to display a list of 
patients in the active database. 
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The total number of patients found appears above the 
Patient List next to the “Matches” label. 

The Patient List may be sorted by last name, by date 
of birth (D.O.B.) or by medical record number (MRN). 
Select the desired option from the drop-down list 
located above the Patient List. 

Click the Clear Search 
button at the top of the 
Patient Search tab to clear  
all search results. 

Patient Search tab 

The list may be filtered by entering patient data  
or image data into the search fields. 

The scroll bar to the right of the Patient List  
may be used to view additional patients. 

	 The number of currently selected patients is displayed 
above the Patient List. Click on the patient’s ID photo 
or data to select that patient. Click again to deselect. 
The All or None buttons may be used to select or 
deselect all patients in the list at once. 

Selected patient records may be exported or deleted by 
choosing the appropriate command from the File menu 
(top left corner of the screen). 
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Double-click on an ID photo or on the patient data to 
open the chart for a particular patient. 

Filtering the Patient List

To make it easier to locate specific patients in the 
database, you may filter the Patient List using any of the 
patient data or image data that you have entered. 

Click in the field that you wish to search by and 
enter the desired value. As you type, the Patient List 
is filtered to display only those patients that meet the 
entered criteria. The total number of current matches is 
displayed above the Patient List. 

If you use a pen and tablet and do not wish to switch 
between the pen and keyboard, you may type by 
selecting the alphanumeric buttons located to the left of 
the Patient List. 

If you wish, you may enter data into additional fields. 
Entering more than one search value returns only 
patient records that match all entered criteria. 

Entering a value into one of the image data fields 
returns every patient that has at least one image 
meeting the entered criteria. Entering data into more 
than one image data field returns patients with at least 
one image that matches all entered criteria. 

Filtering by name or ID number

Select the desired field (Last Name, First Name, MRN or 
Social Security) and enter a value. If you pause briefly 
after typing a letter, the Patient List is filtered to display 
patients whose data starts with the value in the search 
field. For example, typing “S” into the Last Name field 
may show “Samson,” “Sanders” and “Smith.” Typing 
“Sa” will narrow the search to “Samson” and “Sanders.” 
Typing “San” will return only “Sanders.” 
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Filtering by dates

Search fields for Date of Birth, Procedure Date, Patient 
Age, and Image Date are presented as ranges. As long as 
no data appears in either field for a range, that criterion is 
ignored. 

Entering a value in the From field for a date range 
displays all patients that have a date which is the same 
as or later than the specified date. Patients with no date 
entered are excluded from the filtered list. 

Entering a value in the To field for a date range 
displays all patients that have a date which is the same 
as or earlier than the specified date. Patients with no 
date entered are excluded from the filtered list. 

Entering a value in both the From and To fields for a 
date range displays all patients that have a date which 
falls within the specified range. Patients with no date 
entered are excluded from the filtered list. 

Filtering by image attributes

To search based on image attributes, select an attribute 
type from the Image Attributes drop-down list, then 
pick a value from the Selection List. The selected 
value appears in the values list. If you wish, you may 
select additional values for the same attribute or select 
values for different attributes. 

Filtering by notes

Type the desired text into the Notes field. When you 
stop typing, the Patient List is filtered to show patients 
having image notes containing the entered text. 
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7.8  THE IMAGE SEARCH TAB

The Image Search tab allows you to view all images in 
the database that meet specified criteria.

When all tabs are collapsed, click on the Image Search 
tab at the right edge of the screen. 

When the Chart, Patient Search or Image Data tab 
is open, you may switch to the Image Search tab by 
clicking on it; all tabs are available at the left edge 
of the active tab. The Image Search tab may also be 
opened by selecting File A Search for Images….

Performing a search

Performing an image search is similar to performing 
a patient search. You can search for a specific image 
by patient identification such as name, date of birth 
(D.O.B.), medical record number (MRN), social security 
number, sex or race. You can also search for an 
image or set of images based on parameters such as 
procedure, diagnosis, or patient age. For example, you 
can display all images in the database of male patients 
between the ages of 20 and 70 with Alopecia by 
entering that criteria.

After entering search criteria, click Lookup to execute 
the search. 

Image Search tab 

Note:  If the Lookup button is flashing, click Lookup 
to refresh the search.
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Image search results

Search results in the Image Search tab produce an 
image list that looks and functions the same way as the 
images displayed in the Chart. Click to select/deselect 
images. Use the main menus and toolbar to perform 
commands on the selected images. Double-click on an 
image to open the image in the Image Gallery. Right-
click on any image for a pop-up menu of common 
commands.

Images can be sorted using the Sort by drop-down list 
at the top of the screen. Thumbnails can be resized by 
changing the Columns setting.

Opening a patient chart from Image Search

Right-click on an image in the Image List and select 
Open Patient. The Chart opens displaying only those 
images for that patient that meet current search criteria. 
To view all images for the selected patient, select View 
All from the Search Results Filter drop-down list.

7.9  WORKING WITH IMAGES IN THE CHART

The typical approach to working with images is as 
follows:

1 � Use the Patient Search or Image Search tab to 
locate a specific image. 

2  Open the Chart. 

3  Select one or more images. 

4  Select commands from the toolbar or menus. 

When the Chart is open, the availability of commands 
depends upon the selection of images. Some 
commands are always available. Some commands are 
available only if one or more images are selected. Some 
commands require that exactly one or exactly two 
images be selected. Still other commands require that 
one or more simulation images be selected. 
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Any modifications made to images while the Chart is 
open—either with tools in the Image menu or with 
simulation tools—are saved automatically. 

When images are captured or imported (by selecting 
a command from the Capture menu) with the Chart 
open, new images are automatically saved to the 
current patient. 

Refer to 7.1 Thumbnail Images In the Chart and Image 
Search Tabs for more information about working with 
thumbnails.

7.10  WORKING WITH IMAGES IN THE IMAGE GALLERY 

About the Image Gallery

The Image Gallery provides a workspace that allows 
you to focus on a small number of images with a 
minimum of screen clutter. This is helpful when using 
the software during a patient consultation. The Image 
Gallery also provides a convenient method of working 
with images from multiple patients. 

The Chart, Patient Search and Image Search tabs must 
be closed for the Image Gallery to be active (the Image 
Data tab has no effect). As long as the Chart, Patient 
Search and Image Search remain closed, any commands 
selected from the main menus or toolbar are performed 
on either the active image or on all open images 
(depending on the specific command). 

Opening images

1  Locate and open the patient chart containing images 
you wish to open or perform a search in the Patient 
Search or Image Search tab. 

2  Click one or more images to select them. (Clicking 
on a selected image deselects it.) The All/None buttons 
may be used to select/deselect all images at once. 
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3  Click Open Images (or double-click on an image) 
to open the selected images in the Image Gallery. The 
Chart or Image Search tab retracts to the right edge. 

Viewing open images

	 One open image—the “current” or “active” image—
appears full-size in the viewing area of the main screen. 

The other open images are represented as small 
“stamps” in the Image Gallery. 

The left and right arrows at the top of the Image 
Gallery may be used to view additional stamps. 
Clicking on a stamp switches to the corresponding 
image. 

If an open image has been modified using a simulation 
tool, or if an image contains both standard and UV 
image data (from VISIA, for example), one of three 
different cursors appear as you move the mouse over 
the corresponding stamp:

 Normal Select Cursor — The Normal Select Cursor 
appears as you float over the right side of a stamp. 
Clicking with the Normal Select Cursor displays the 
image in the main screen. 

 Side-by-Side Cursor — The Side-by-Side Cursor 
appears as you float over the middle of a stamp. 
Clicking with the Side-by-Side Cursor opens the original 
and modified versions of the image in the Side-by-Side 
tool. (For more information, see 8.1 Side-By-Side)

 Compare Cursor — The Compare Cursor appears as 
you float over the left portion of a stamp. Clicking with 
the Compare Cursor opens the original and modified 
versions of the image in the Compare tool. (For more 
information, see 8.2 Compare)
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New/modified images in the Image Gallery

Any modifications made to images while the Chart is 
closed—either with tools in the Image menu or with 
simulation tools—are saved to the Image Gallery. In 
order for such modifications to be available for viewing 
at a later time, they must be saved to the Chart (see 
Chapter 6, Saving Images). 

When images are captured or imported (by selecting 
a command from the Capture menu) with the Chart 
closed, new images appear in the Image Gallery. In 
order for such images to be available for viewing at a 
later time, they must be saved to a patient record (see 
Chapter 6, Saving Images). 

The Image Data tab

The Image Data tab displays patient and image 
information for the active (full-size) image displayed in 
the Image Gallery. Refer to Chapter 6, Saving Images 
for details about the Image Data Tab.
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CHAPTER 8 
View Tools 

8.1  SIDE-BY-SIDE 

Use Side-by-Side to view two different images—or the 
original and modified versions of an image—next to 
each other on the screen. 

Viewing two different images

1  Select two images in the Chart. 

2  Without closing the Chart, select Side‑by‑Side from 
the View menu, or click the  Side-by-Side button 
on the toolbar. 

	 You may save the side-by-side view as a single image: 
Click  in the upper right corner.

3  Optional: With PhotoTools, you may use the 
Whiteboard tool to temporarily mark up the images. 
Right-click to return to Side‑by‑Side. 

4  To view a magnified portion of each image, click on 
the  Loupe tool. Move the cursor to view different 
areas of the image. Click the + or – keys to adjust 
magnification.

5  Click on the main image to freeze the magnified area. 
Click on the Loupe image to reactivate it.

6  To save the Loupe images, right-click on the Loupe 
image and select Save Image.
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7  To exit the Loupe tool, right-click on the Loupe image 
and select Close Loupe.

8  Right-click to exit the Side‑by‑Side tool and return to 
the Chart. 

Viewing original vs. modified

1  Select or open a modified image. (Note: A modified 
image is created by using the simulation tools.) 

2  Select Side‑by‑Side from the View menu, or click 
the  Side-by-Side button on the toolbar. 

3  Optional: With PhotoTools, you may use the 
Whiteboard tool to temporarily mark up the images. 
Right-click to return to Side‑by‑Side. 

4  Right-click to exit the Side‑by‑Side tool. 

Side‑by‑Side image size

You may use either of two methods for viewing images 
with the Side‑by‑Side tool: 

Best Fit — Images are sized so their heights match the 
height of the screen. A horizontal scroll bar appears as 
needed to allow viewing of the full width of the images. 

Full Image — Images are sized so both full images 
appear on screen at once without scrolling. 

1  Select Set Tool Options from the Options menu. 

2  Click the General tab. 

3  Under Side‑by‑Side Image Size, select either 
“Best Fit” or “Full Image.”

4  Click OK to close the Tool Options dialog box. 
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8.2  COMPARE

With PhotoTools or Rejuvenation, you may use 
Compare to fade between two different images 
(typically pre-op and post-op) or to fade between the 
original and modified versions of a single image. 

Comparing two different images

The compare tool is most effective when used on two 
images of the same view with the same framing and 
magnification. For best results, you may wish to use the 
Match Orientation tool prior to using Compare. 

1  Select two images in the Chart. 

2  Without closing the Chart, select Compare from the 
View menu, or click the  Compare button on the 
toolbar. 

3  Move the cursor up and down on the screen to fade 
between the two images. 

4  Optional: Click at any point during the fade to 
activate the Whiteboard tool. Right-click to return to 
Compare. 

5  Right-click to exit the Compare tool and return to the 
Chart. 

Comparing original to modified

1  Select or open a modified image. (Note: A modified 
image is created by using the simulation tools.) 

2  Select Compare from the View menu, or click the 
 Compare button on the toolbar. 

3  Move the cursor up and down on the screen to fade 
between the original and modified images. 

4  Optional: Click at any point during the fade to 
activate the Whiteboard tool. Right-click to return to 
Compare. 

5  Right-click to exit the Compare tool. 
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8.3  COMPARE METHOD 

From the View menu, select Compare Method to 
set how the program displays images in Compare and 
Side-by-Side mode (requires PhotoTools). 

Normal — The image appears in color. 

Embossed — The image’s features are embossed onto 
a grayscale screen. 

Embossed mode is useful for showing wrinkles and 
edges, or showing a patient’s image in a less personal 
way.

8.4  ZOOM 

Use Zoom to magnify an area of the active image for 
closer examination. Images cannot be edited in zoomed 
mode. 

Note: To make the Zoom tool available in the View 
menu, select Customize in the Options menu. In the 
menu tab, select View. Be sure Zoom is checked in 
the Available Tools list.

1  Open or select an image. (Note: When working from 
the Chart, you must select only a single image. The 
Zoom tool is unavailable if more than one image is 
selected.) 

2  Select Zoom from the View menu. 

3  Click on the center of the area you wish to magnify. 

4  Move the cursor up or down to interactively change 
the magnification. 

5  Click to freeze the magnified area. The Whiteboard 
tool is activated automatically. 

6  Right-click to return to a full-image view. If you wish, 
you may repeat steps 3–6 to magnify different areas of 
the image. 

7  When you are finished, right-click to exit the Zoom 
tool. 
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8.5  THE LOUPE TOOL

The Loupe tool may be used to magnify areas of an 
open image for closer on screen examination. You 
must open an image to view it with the Loupe tool (the 
Loupe tool is not available from the Chart). 

Using the Loupe tool

1  Open one or more images. (Note: The Loupe tool is 
not available from the Chart.) 

2  Select Loupe from the View menu, or click the  
 Loupe button on the toolbar. 

3  Move the cursor to view different portions of the 
image. 

4  Click anywhere on the main image to freeze the 
current image in the Loupe tool. Click in the Loupe 
window to reactivate it. 

The Loupe tool window

The Loupe tool window may be moved by dragging 
the title bar. The window may be resized by dragging 
the window borders. (Note: The Loupe tool must be 
open but not active in order to move or resize the 
window. Click in the main image to deactivate the 
Loupe tool.) 

Switching views in the Loupe tool 

Mirror’s Loupe tool allows you display any available 
view in the Loupe window: Simply roll the mouse 
wheel to cycle through the views. If your mouse 
does not have a wheel, right-click and select the 
view you want from the pop-up menu. If UV and/or 
cross-polarized images are available, you can display 
processed (i.e., RBX Red, RBX Brown, UV Spots, 
Porphyrins) and unprocessed images, as well as the 
“enhanced” view.
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The Loupe tool pop-up menu

While the Loupe tool is active, right-click in the Loupe 
window to open a pop-up menu of commands. The 
pop-up menu allows you to select the view to be 
displayed in the Loupe window, select a level of mag
nification, save a copy of the image currently displayed 
in the Loupe window, or close the Loupe tool. 

Keyboard commands

The following keyboard commands are available while 
the Loupe tool is active: 

+/– — The plus and minus keys may be used to change 
the level of magnification. 

    — The arrow keys may be used to move 
the target area in small increments. 

5, 1, 2, 3, 4 — Number keys may be used to jump 
directly to magnification levels of 50%, 100%, 200%, 
300% or 400%. 

Space bar — Used to save a copy of the image 
currently displayed in the Loupe tool. 

8.6  THE ENHANCE TOOL

Use the Enhance tool to display the standard image 
side-by-side with an enhanced image. The enhanced 
image makes pigment, fine lines, and other surface 
features more apparent.

1  Open an image. 

2  Select Enhance from the View menu or click on the 
 Enhance button on the toolbar.

3  If you wish, adjust the Brightness and Contrast of the 
enhanced image.

4  To view a magnified portion of each image, click on 
the  Loupe tool. Move the cursor to view different 
areas of the images. Click the + or – keys to adjust 
magnification.
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5  Click on the main image to freeze the magnified 
area. Click on the Loupe image to reactivate the Loupe.

6  To save the Loupe images, right-click on the Loupe 
image and select Save Image.

7  To close the Loupe image, right-click on the Loupe 
image and select Close Loupe.

8  To save the Enhanced image, click  Save.

9  Right-click to exit the Enhance tool.

10  From the File menu, select Close All Images.  
At the prompt, click Yes.

11  On the Save Images window, select the images you 
wish to save to the chart and click Save & Close.

8.7  LAYERS 

With PhotoTools, you may use layers to display various 
data associated with the active image. 

Analysis — All markings and values created with the 
Measurements tool (distances, angles, proportions and 
areas). 

Comparative Analysis — All markings and values 
created with the Comparative Analysis tool (distances 
and angles). 

Labels — All labels and callouts created with the Labels 
tool. 

ImageCheck — The ImageCheck symbol that appears 
in the lower right corner of each image. 

Composite — When an image is added to a layout 
board, any visible layer data for that image gets 
combined into a single “Composite” layer. 

Density — All markings and values created with the 
Density (hair counting) tool. 

Modesty — All privacy panels created with the  
Modesty tool. 
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8.8  PRIORITIZE 

The Prioritize tool is used to display modifications 
made to selected areas of an image. If, for example, 
you have used the simulation tools to simulate both 
wrinkle removal and laser resurfacing on a single patient 
image, you may use Prioritize to show just the wrinkle 
simulation or just the resurfacing simulation. Prioritize is 
a feature of Rejuvenation. 

1  Open or select a modified image. 

2  Select Prioritize from the View menu. 

3  Circle one or more areas of the image for which you 
wish to display modifications. 

4  Click inside any circled area to enter Compare mode. 

5  Move the cursor up and down to fade the selected 
modifications in and out. 

6  Optional: To include additional areas of the image, 
click to stop Compare mode then click again. Repeat 
steps 3–5 as needed for additional areas. 

7  Optional: To replace the current selection by 
selecting a different area, right-click to exit Compare 
mode then repeat steps 2–5 as needed. 

8  Right-click to exit the Prioritize tool. 
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8.9  CONSULTATION TOOLS

PhotoTools includes several features that may be used 
to incorporate images into aesthetic consultations. 
All of the features described in this section require 
PhotoTools. 

Mirror

Use Mirror to present the patient’s image the way the 
patient sees it in a mirror. Mirror is normally used on 
frontal images.

The Mirror tool has two modes: full screen and side-by-
side. Full screen is the standard setting. 

1  Select an image. From the main menu, select View 
then Mirror. A mirrored version of the image appears 
on the screen.

The image is labeled “Mirrored” and the cursor appears 
as a whiteboard pen.

2  With the whiteboard cursor, tap and drag with the 
pen or click the left mouse button and drag to mark 
non-destructively on the image. Press the pen’s side 
button or right-click the mouse to exit the whiteboard 
tool.

3  Tap or click to display the normal-view image. The 
image is labeled “Normal.”

4  Optional: Tap again to toggle between mirrored and 
normal versions of the image.

5  Press the pen’s side button or the right mouse button 
to return to the Chart.

You can set the side-by-side mode as the standard 
mode for showing mirrored images (see 3.3 Setting Tool 
Options). 

In side-by-side mode, when you select the Mirror 
command, the normal-view image is displayed next 
to the mirrored image. The image on the left is 
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labeled “Normal” and the image on the right is labeled 
“Mirrored.” The view in side-by-side mode does not 
toggle as in Step 4. 

Asymmetry

Use Asymmetry to show the natural asymmetry of 
the patient’s unmodified image. The Asymmetry 
tool displays two left sides of the patient’s features 
combined and two right sides of the patient’s features 
combined, side-by-side. Asymmetry is typically used on 
anterior or posterior images. 

1  Select an image. From the main menu, select View 
then Asymmetry. The cursor becomes a vertical line. 

2  Move this line to the center of the image and tap or 
click. A “Right Side” and a “Left Side” image appear 
next to each other on the screen and the cursor 
changes to a whiteboard pen. 

3  Optional: Tap and drag the pen or click the left 
mouse button and drag to draw with the whiteboard 
cursor. Press the pen’s side button or right-click the 
mouse to exit the whiteboard tool.

4  Optional: tap or click and reset the vertical line. 

5  Press the pen’s side button or the right mouse button 
to return to the Chart. 

Show Edges

Show Edges displays the active image in embossed 
mode. Embossing the image removes the color from the 
image and enhances edges, highlights, and depressions. 
Its purpose is to draw a patient’s attention to a profile 
or wrinkles in the skin rather than the patient’s overall 
appearance. 

 	You cannot edit an image in Show Edges. 

1  Select an image. From the main menu, select View 
then Show Edges. 
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2  Move the cursor up and down to reduce or increase 
the embossed detail. 

3  Tap or click to freeze the image. The cursor appears 
as a whiteboard pen. 

4  Tap and drag the pen or click the left mouse button 
and drag to draw non-destructively on the image. 

5  Press the pen’s side button or right-click the mouse 
button to return to embossing. 

6  Press the pen’s side button or right-click the mouse 
button to return to the Chart. 

Blank Screen

Blank Screen serves to keep patient data private when 
you are temporarily away from the system. The blank 
screen can also serve as a view box for x-rays.

Select Blank Screen from the View menu. The screen 
becomes blank. Click to return to the program. 

Note: To make the Blank Screen tool available on the 
View menu, select Customize on the Options menu. 
On the menu tab, select View. Be sure Blank Screen 
is checked in the Available tools list.
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CHAPTER 9 
Printing 

9.1  THE PRINT SCREEN 

1  Select or open the images you wish to print. 

2  Select File A Print A Print Page(s). The Print screen 
appears. 

gallery

header

print button

footer

options menu

caption

margin 
indicator

The Print screen provides a preview of how the printed 
page(s) will appear. Using the menus and the interactive 
preview area, you may adjust the page layout, change 
the number or images per page, add captions, etc. 

3  When the page appears as desired, click Print to 
send the page(s) to the selected printer (or right-click 
to exit without printing). 
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9.2  PRINT OPTIONS 

General printing options

The upper portion of the Options menu contains 
submenus for selecting the printer, number of copies, 
paper size and page orientation. When Optimal is 
selected from the Orientation submenu, PhotoFile 
automatically selects either a horizontal (landscape) 
or vertical (portrait) orientation based on the first 
image on each page. You may override this automatic 
selection by selecting landscape or portrait orientation. 

Page Properties

Select Page Properties from the Options menu to 
open the Page Options dialog box. 

Print Headers and Footers — If you wish, you may 
enter text to appear at the top and/or bottom of every 
page. Up to two lines of header text and two lines of 
footer text may be entered. The check boxes at the 
top of the Page Options dialog box determine which 
headers and footers will be printed. To enter text for 
headers and footers, click the Edit Headers/Footers 
button. 

Minimum Page Margins — Enter values in inches for 
the minimum margins at the left, right, top and bottom 
of the printed pages. Depending on the aspect ratio 
of the images and the layout of the page, the actual 
margins may be larger than the minimum values 
entered. 

Between Image Spacing — Enter a value in inches for 
the minimum space between images when multiple 
images appear on a page. 

Maximum Images Per Page — Enter the number of 
images you wish to print on each page. 
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Save Settings — When selected, the current settings 
will be saved as default values. Clear this check box to 
apply settings only to the current print job. 

Image Properties

Click to select one or more images on the preview 
page (a green border appears around selected images). 
Click again to deselect an image. If you wish, you may 
use the Select All and Select None commands in the 
Edit menu. 

Select Image Properties from the Options menu to 
open the Image Properties dialog box. This dialog box 
is used to set printing options for the selected image(s). 

Print From — For images that have been modified 
using the simulation tools, you may choose to print the 
original image, the modified image or both images  
side-by-side. This setting has no effect on images that 
have not been modified. 

Print Layers — You may choose to selectively print or 
suppress the Analysis and Labels layer as well as the 
ImageCheck symbol. 

VISIA options — For each VISIA image, a specific skin 
feature may be selected for printing. Select the VISIA 
image, then select the skin feature from the drop-down 
list. Check the Mask Overlay box if you wish the mask 
overlay to be printed. If Mask Overlay is checked, 
select a line width from the drop-down list.

Document Properties

Select Document Properties from the Options menu 
to open the settings dialog box for your printer. Refer 
to the printer documentation to determine the best 
settings for photographic output. 
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9.3  THE INTERACTIVE PREVIEW 

The print preview allows you to interactively adjust the 
page layout. Use the scroll bar at the right edge of the 
screen to move among multiple pages. 

Adding an image to the page

1  Drag a stamp from the image gallery to the preview 
page. (Once the thumbnail starts to move, you can 
release the mouse button.) 

2  Move the stamp into an empty or occupied location 
on the preview page. 

3  Click to place the image in the desired location.  
If there was already an image in this location, it is 
replaced but still remains in the image gallery for use. 

Moving an image on the page

1  Drag an image on the preview page. (Once the 
image starts to move, you can release the mouse 
button.) 

2  Move the image to a new location.

3  Click to place the image in the desired location.  
If there is an image in this location, it trades places with 
the moved image. 

Removing an image from the page

1  Drag an image on the preview page. (Once the 
image starts to move, you can release the mouse 
button.) 

2  Move the image off the preview page. 

3  Click outside the preview area to remove the image. 
The image is removed from the page but still remains 
in the image gallery for use. 
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Changing the page margins

1  Move the cursor over the dashed margin indicator. 
The cursor changes to a double-headed arrow. Click to 
activate margin adjustment. 

2  Move the margin indicator to the desired position. 

3  Click to place the new margins. 

Editing headers and footers

You may click any header or footer on the preview page 
to open the Edit Headers and Footers dialog box. If no 
headers or footers appear on the page, you may add them 
by using the Page Properties command (see above). 

Image captions

A single line of text may be printed below each image. 

1  Move the cursor to the bottom of an image on the 
preview page. The cursor changes to an I‑beam. 

2  Click with the I‑beam cursor to open the Edit 
Caption dialog box. 

3  Enter the desired caption and click OK. 

Adding image data to captions

If you wish, you may instruct the software to 
automatically pull patient data and/or image data from 
the database to be included in a caption. 

1  Click with the I‑beam cursor at the bottom of an 
image to open the Edit Caption dialog box. 

2  Click in the Caption field to position the cursor at the 
point where you wish the data to appear.

3  Click the Insert Field button. 

4  In the Insert Field dialog box, select the desired 
data field and click Insert. The name of the data field 
appears in the caption surrounded by two “%” symbols. 
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You may add text or other data fields either before the 
first “%” or after the second “%.” Do not edit the text 
between the two “%” symbols. 

5  Click OK to close the Edit Caption dialog box. The 
data field name is replaced by the appropriate value for 
the image. If no data has been entered, no text appears. 

9.4  PRINTING EVENT REPORTS

1  To print event reports, from the Utilities menu, 
select Extras, then Security Reports.

2  At the prompt, log in. (Only Canfield DB 
Administrators or Power Users may log in to view 
reports.)

3  The Event View screen appears for the currently 
selected database. (To switch to another database, 
select Database from the File menu. Enter your login 
and select the database from the drop-down list.)

4  Database event reports may be generated by user, 
patient, or event. Double-click on one of these options. 

5  To display patient details for a specific event, 
double-click on the event. To view more detail, on the 
Description window, click on Patient Details if this 
option is available. 

6  System event reports may be generated by database, 
user, workstation, or event. Double-click on one of 
these options.

7  To display details for a specific event, double-click 
on the event.

8  To customize the displayed information, select 
Configuration from the Action menu at the top of the 
screen.

9  Click on Select all events or enter start and end 
times to view events during a specific time period. 
Select the order in which to display events (Newest 
first, Oldest first, or Original order). Select the 
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information you wish to view from the Displayed 
columns window.

10  To generate a printable Event Report, select Create 
Report from the Action menu. Use the icons at the 
top of the screen to print or export the report, reduce 
or enlarge the on screen page size, search for text, or 
refresh the screen.

11  To view and print event reports for another 
database, select Database from the File menu. Enter 
your login and use the drop-down menu to select 
another database. Click OK.

9.5  PRINT TEMPLATES 

Print templates allow you to save complete sets of 
print settings (general options, page properties, image 
properties and captions) for future use. 

Creating a print template

1  Open the print tool and make all desired adjustments 
to the page layout. 

2  Select Add Template from the Template menu.

3  Enter a name for the template and click OK. 

Applying a print template

Any print templates you have created will appear in 
the Template menu. Select a template from the menu 
to apply it to the current print job. If you have created 
many templates, you may need to select More from the 
Template menu to see the full list. 

Deleting a print template

1  Open the print tool. Select More from the Template 
menu. 

2  Select a template in the list and click Delete.
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CHAPTER 10 
ViewMyConsult® Patient Portal

With the ViewMyConsult patient portal you can upload 
patient images to a secure website directly from the 
Mirror application. Patients then receive a personal log-
in which allows them to view these pictures in any web 
browser. From here they can also access your licensed 
educational material from The Aesthetic Society 
(ASAPS) or Understand.com®, or click through to 
your practice website. Your access to ViewMyConsult 
requires an active license from Canfield Scientific 
and a current Canfield Care Support & Upgrade 
agreement. For more information, contact your Canfield 
representative.

10.1  MONITORING PORTAL STATUS

To access the Canfield Services utility control panel, 
click the  Canfield Services icon on the Windows 
desktop. From here you can monitor upload activity 
and portal status. In order to upload images, there 
must be green check marks ( ) next to “local service 
connection” and “Canfield Cloud connection” in the 
Portal Connection area, and in the Active column 
next to the “Mirror” application. If a red  appears in 
	any of these areas, contact your IT administrator.
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10.2  UPLOADING PATIENT IMAGES

	 1  From the patient chart in Mirror, click to select those 
pictures that you want to appear in your patient’s 
ViewMyConsult session. The frame around selected 
images will turn blue.

2  Under Tools on the menu bar, select “Patient Portal” 
from the dropdown.

	 3  In the “Push to Portal” dialogue, select the user name 
of the staff member who is performing the upload from 
the dropdown. If prompted for a password, enter the 
user’s ViewMyConsult password, then click Login to 
continue. 

	 4  Enter the patient’s email address. If there is an 
existing email address in the patient record, it will 
appear in the patient e-mail field. Otherwise, enter 
an email address where you want the patient’s login 
information to be sent. Confirm the email address and 
click Next.

	 5  The selected images are displayed in the “Additional 
Images” window in the “Upload to Portal” dialogue.  
Select or enter the desired label for each image.  
This label is displayed to the patient in ViewMyConsult 
and may also be saved to the patient chart.
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	 6  If a Pre-Op image is displayed in the “Additional 
Images” window, drag it to “Highlighted Images”.  
The patient will be able to view the designated Pre-Op 
side-by-side with any of the images in the “Additional 
Images” window, such as simulations or Post-Op.

7  From the Consultation By drop down menu, select 
	 the name of the practitioner who is associated with this 

consultation. This name is displayed to the patient in 
ViewMyConsult.

	 8  Check the box to confirm that the patient has signed 
a consent form for the upload.

	 9  Optional:  Click the Educational Materials tab to 
make selected patient education materials available to 
the patient in ViewMyConsult. This option is only 
available if you have licensed the materials from The 
Aesthetic Society.�

10  Click Upload. The 
“Save Image Label” dialog 
is displayed if you entered 
new labels for any of the 
images (step 5). Click Yes 
if you wish to save the 
new image labels to the 
patient chart. 

	 11  When the “submitted for upload” confirmation 
message is displayed, click OK to return to the Mirror 
patient chart. Note:  The status of current (in process), 
completed, or failed consultation uploads can be 
viewed in the Canfield Services control panel.
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CHAPTER 11 
Integrating Mirror with Other Programs

Mirror software allows you to transfer images directly 
into other programs (such as Microsoft Word) using 
a simple cut and paste function. It also allows you to 
export images saved in standard file formats, which 
can be opened or imported into other software. Mirror 
includes a command specifically for exporting images 
to PowerPoint.

Images captured using Canfield’s VISIA complexion 
analysis system can be imported into Mirror. 

11.1  COPY AND PASTE

Often, the most straightforward way to transfer an 
image to another program is to use the Windows 
Clipboard (i.e., Copy and Paste). 

1  Open or select a single image. (Note: The Clipboard 
may not be used to transfer multiple images at once.) 

2  Select Copy Image from the Image menu. 

3  Switch to another program that supports images on 
the Clipboard. 

4  Select the Paste command in the other program (see 
the manufacturer’s documentation for details). 

5  Repeat steps 1–4 as needed for additional images. 

	 It is also possible to Paste images from the Clipboard 
into the Image Gallery or the Chart (using the Paste 
Images command in the Image menu). Importing 
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images in this manner, however, does not capture any 
image data for Image History (see 5.5 Image History 
for details on Image History). It is generally better to 
import images using the Import Images command 
(see 5.2  Importing Previously Captured Images). 

11.2  EXPORTING IMAGES

The Export Images command may be used to save 
images as standard image files. These image files may 
then be opened or imported into other software. 

1  Select or open one or more images. 

2  From the Image menu, select Send To then Export 
Images to open the Export Images dialog box. 

3  Select the images you wish to export (if you wish to 
export all displayed images, you may skip this step). 

4  Select a file format from the Export Format 
drop‑down list. 

5  Select the Export Modified Data check box to 
export the modified versions of images (if present). 
Clear this check box if you want to export only the 
original versions of images. Note: For images with no 
modified data, this setting has no effect.

6  Confirm that the Export Directory (displayed to the 
right of the Change Directory button) is the location 
to which you wish to export image files. If not, click 
Change Directory and browse to the correct folder.  
If you wish to make this the default destination for the 
Export Images command, select the Save Directory 
Setting check box. 
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Export Image Settings

(Optional) Click Settings to open the Export Image 
settings dialog for additional options.

Export file names

• �Default — A file name is generated using the 
patient name and the unique database record 
number for each image (this is the file name 
format used in previous versions of Mirror).

• �Sequential numbering — File names will start at 
the specified number and increment by one, with 
leading zeros added to always create a six-digit 
file name.

• �Custom file name format — File name format is 
specified by typing and/or using the Insert Field 
button (a three-digit number is appended to all 
file names to ensure uniqueness).

An example file name based on the selected option is 
displayed below the “Export file names” controls.

Subfolders

By default, all images are exported to the same 
Windows folder. If you wish, you may choose to 
separate exported images into subfolders based on 
a selected data field. If you select an attribute with 
multiple values for a single image (e.g., Procedure), 
only the first value for each image will be considered.

Data file

By default, the Export Images feature generates image 
files only. If you wish, you may now choose to export 
applied data along with (or instead of) images. This 
feature generates a Comma Separated Values (CSV) file 
that may be opened in MS Excel or a number of other 
programs. Use the Select Fields button to define which 
data you wish to export. If you select an attribute with 
multiple values for a single image (e.g., Procedure), 
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only the first value for each image will be exported to 
the data file.

Image size

This feature allows you to specify the size and/or 
output resolution of exported images. This is most 
useful for the following:

• �Reducing image size for internet use —  
Check with your web developer for an 
appropriate resolution, then enter the desired 
width and/or height in inches and enter 100 in 
the Resolution field. For example, to export 
images at 400 5 300 pixels, enter “3” for Width, 
“4” for Height, and “100” for Resolution.)

• �Journal submissions — Many scientific journals 
specify a minimum required output resolution 
for submitted images (e.g., 300 dpi). Enter the 
required value in the Resolution field. If you 
know the desired width of the image when 
printed, enter that in the Width field. You may 
leave the Height field blank.

	 Note:  The “Make images smaller but not larger” option 
prevents images from ever being “up-sampled.” Since 
up-sampling increases file size without improving 
image quality, you should generally leave this option 
selected.

7  Click Export to export the selected images or click 
Export All to export all displayed images, whether they 
are selected or not. 

	 Note:  The software automatically assigns a file name to 
each exported image file. If a file with the same name 
already exists in the Export Directory, it is replaced 
by the new file. If you select the Prompt on Replace 
check box in the Export Images dialog box, whenever 
a file name conflict occurs you will be prompted to 
choose whether or not to replace the existing file. 
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11.3  SEND TO POWERPOINT

The Send To PowerPoint command provides an easy 
way to transfer images to a Microsoft® PowerPoint® 
presentation. 

Note: You must have Microsoft PowerPoint 2000 or 
later installed on the same computer to use the Send 
to PowerPoint command. Microsoft PowerPoint is not 
included with Mirror software. 

1  Select or one or more images in the Chart or Image 
Search tab. 

2  Right-click on a selected image and select  
Send To PowerPoint from the pop-up menu.  
(Or, select Image A Send To A PowerPoint….) 

3  Select a PowerPoint presentation: 

• �Open Presentation — Add slides to the end of a 
presentation that is currently open in PowerPoint. 

• �New Presentation — Automatically create a new, 
blank presentation and add slides to it. 

• �Saved Presentation — Automatically open the 
selected PowerPoint file and add slides to the end 
of it. (Use the Browse button to select a file.) 

select a PowerPoint 
presentation
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4  Select a slide layout from the list. You may choose  
to place one, two or four images per slide, or create 
slides with one image and associated data, or overlay 
images with fade. 

5  Select the desired options: 

• �Use slide titles — Select this option to include a 
title text box on each slide. If you wish you may 
enter title text in the field provided. Click Insert 
Field to automatically create slide titles based on 
patient/image data (when placing more than one 
image per slide, only data from the first image on 
each slide will be used). 

• �Include image dates — Automatically place the 
image date as a caption below each image in 
PowerPoint. 

• �Include ImageCheck icon — Send images with 
an ImageCheck icon in the lower right corner 
reflecting the current image status. 
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• �Make images fill slides (no margins) — Disregard 
the slide margins as defined in PowerPoint® and 
maximize the size of images on the slides. May 
be used with any of the slide layouts. 

• �Switch to PowerPoint automatically — The 
presentation automatically opens in PowerPoint 
after you click OK. 

6  (Optional) Click Settings to open a dialog box with 
the following options: 

• �Patient/image data — Select which patient/image 
data you wish to send when using a slide layout 
that includes data. 

• �Resize images — Select the resolution at 
which you wish to send images to PowerPoint. 
Choosing an appropriate image size can produce 
smaller PowerPoint files that display faster with 
no noticeable difference in image quality. 

• �Modified images — Select desired option for 
modified images: 
-  Send original image data 
-  Send modified image data 
-  Send both images with fade.

7  Click OK. 

Microsoft PowerPoint automatically opens and images 
are added to new slides in the selected presentation. 
(You may need to switch programs manually: Hold 
down the Alt key while you press the Tab key.)
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Send multiple images with a fade effect
(Requires MS PowerPoint 2003 or higher.)

1  In Chart or Image Search, select two or more 
images (e.g., a pre-op and a post-op image).

2  Right-click on one of the selected images and select 
Send to PowerPoint.

3  Select the second slide layout, “Overlay images with 
fade”, and click OK.

In PowerPoint, the images will be placed one on top of 
the other with a Custom Animation automatically set to 
fade from one image to the next when the presentation 
is run. For more information on Custom Animations, 
please refer to the MS PowerPoint documentation.
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Send simulation images as original and modified  
with a fade effect
(Requires MS PowerPoint 2003 or higher.)

1  In Chart or Image Search, select a Modified 
image (an image that has been modified with Mirror 
Simulation tools).

2  Right-click on the selected image and select Send to 
PowerPoint.

3  Select the first slide layout, “1 image per slide”.

4  Click Settings.

5  Under Modified images 
select “Send both images with 
fade.”

6  Click OK in the “Send to 
PowerPoint Settings” window.

7  Click OK in the “Send to 
PowerPoint” window.

In PowerPoint, the original and 
modified versions of the image 
will be placed one on top of the 
other with a Custom Animation 
automatically set to fade from 
one image to the next when the 
presentation is run. For more 
information on Custom Anima
tions, please refer to the MS 
PowerPoint documentation.
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11.4  MIRROR–VISIA INTEGRATION

Mirror software is fully compatible with images 
captured using Canfield’s VISIA® Complexion Analysis 
system. You can either import VISIA images into Mirror 
as needed or maintain a single, integrated database for 
both programs.

Importing VISIA images into Mirror

If you wish to maintain separate databases for VISIA 
and Mirror but occasionally wish to work with 
specific VISIA images using Mirror tools (for example, 
to prepare a presentation), the export and import 
commands provide a quick and easy solution.

1  In VISIA, open the Database Management tab in 
the Set Up screen and click Export Clients.

2  Select the patient record(s) you wish to copy to 
Mirror.

3  Click Change Directory and select a location for the 
export files. Be sure to note the location. (TIP: You may 
wish to select an easy-to-remember location such as the 
Desktop or the My Documents folder.)

4  Click Export.

5  In Mirror, select Import Patients from the File 
menu.

6  Click Change Directory and browse to the folder 
containing the export files (the same directory as in 
Step 3).

7  Click to select the patient record(s) you wish to 
import.

8  Optional: Select the “Delete record files when done” 
check box to automatically delete the temporary export 
files after they are imported into Mirror.

9  Click Import.
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Your Mirror database now contains a copy of the 
patient records exported from VISIA. The original 
patient records still reside in the VISIA database. 
Changes made to a patient record in one program have 
no impact on the corresponding record in the other 
program.

If you repeat the export/import process for the same 
patients at a later date, the records will be appropriately 
merged upon import into Mirror.

Using an integrated database

If you capture both VISIA and non-VISIA images of 
many of your patients, or if you frequently wish to 
work with VISIA images using Mirror tools, you may 
wish to create a single, integrated database for both 
programs.

	 IMPORTANT: If you choose to use an integrated 
database, you will need to maintain compatible 
versions of Mirror and VISIA from this point forward. 
All future upgrades must be performed for both 
products simultaneously. Upgrading just one program 
may render the database unusable by the other 
program.

1  Perform a full system backup of your VISIA and 
Mirror data. (Refer to Appendix A for information.)

2  Contact Canfield Scientific to have your hardware key 
authorized for VISIA–Mirror integration, and to ensure 
that you have the latest version of VISIA installed.

3  In VISIA, open the Database Management tab in 
the Set Up screen and click Export Clients.

4  Click Check All.

5  Click Change Directory and select a location for the 
temporary export files. Note: Be sure to select a location 
with sufficient free drive space to store all of your 
VISIA images.

6  Click Export.
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7  In Mirror, select Import Patients from the File 
menu.

8  Click Change Directory and browse to the folder 
containing the temporary export files (the same 
directory as in Step 5).

9  Click Check All.

10  Optional: Select the “Delete record files when done” 
check box to automatically delete the temporary export 
files after they are imported into Mirror.

11  Click Import.

12  In Mirror, select Switch Database from the 
File menu. Note the name of the Current Database 
(displayed at the bottom of the dialog box).

13  In VISIA, open the Database Management tab in 
the Set Up screen and click Database Options.

14  Click to select the Mirror database (noted in Step 12) 
and click Set Startup Database.

15  Exit and re-open both Mirror and VISIA. Confirm 
that the same patients now appear in both programs.

Viewing VISIA images in Mirror

Whenever a VISIA image is opened in the Mirror main 
screen, the Side-by-Side tool, or the Compare tool, the 
VISIA Image Viewer appears automatically. The VISIA 
Image Viewer provides the controls needed to select 
one of the available skin features and to turn the mask 
overlay on or off.

Note: The VISIA Image Viewer only works for original 
VISIA images (images with “VISIA” appearing above 
the thumbnail in the Chart).
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Working with VISIA images in Layout Board

When a VISIA image is dragged onto the Layout Board, 
the VISIA Options dialog appears automatically. The 
VISIA Options dialog provides the controls needed to 
select one of the available skin features, to turn the 
mask overlay on or off and to select the line width for 
the mask overlay. If you wish to change the options for 
a VISIA image that is already on the Layout Board, click 
the VISIA/UV button on the Layout toolbar, then click 
on the VISIA image.

Printing VISIA images from Mirror

Click to select a VISIA image in the Print Preview 
screen, then select Image Properties from the Options 
menu. The Image Print Options dialog contains VISIA 
Options controls that allow you to select one of the 
available skin features, to turn the mask overlay on or 
off and to select the line width for the mask overlay.

Using simulation tools on VISIA images

If you select a VISIA image and open one of the 
simulation tools (Warp, Airbrush, etc.), Mirror 
automatically creates a copy of the VISIA image 
according to the settings in the VISIA Options dialog. 
No modifications are ever made directly to an original 
VISIA image.
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CHAPTER 12 
Tethered Image Capture 

12.1  ABOUT TETHERED IMAGE CAPTURE 

Tethered digital cameras

A “tethered” camera is connected to the computer 
during image capture to provide direct communication 
between the camera and the software. (Note: This is 
not the same as connecting the camera to the computer 
after image capture in order to transfer images.) 

A tethered camera may be controlled either partially or 
completely from within the software, and images are 
captured directly into the software. 

See www.canfieldsci.com/imaging-systems/mirror/ 
for camera/operating system combinations currently 
supported for tethered capture in Mirror.

Video source

Digital still images or motion video clips may be 
captured from video sources such as camcorders, video 
microscopes, endoscopes and VCRs. Devices that offer 
digital video output may be connected directly to the 
computer (typically via IEEE-1394/FireWire). Other 
video sources may require an analog-to-digital video 
converter. 

For details on using video sources, see 12.3 Capturing 
Still Images from a Video Source. 

http://www.canfieldsci.com/imaging-systems/mirror/
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12.2  TETHERED CAPTURE WITH DIGITAL STILL CAMERAS  
THAT DO NOT PROVIDE LIVE VIDEO PREVIEW

Connecting the camera to the computer

1  Plug the small end of the USB cable into the USB 
connector on the side of the camera. The connector is 
marked with the  symbol.

2  Plug the large end of the USB cable into an available 
USB port on your computer.

Capturing images

1  Be sure there is a memory card in the camera.

2  Be sure the USB setting on the camera is set to PTP 
(not Mass Storage).

3  Open or create a patient chart.

4  Select Capture Images from the Capture menu.

5  In the Capture window, select the 
desired camera settings template from 
the Settings drop-down list. (For more 
on using and editing Settings Templates, 
see 12.6 Settings Templates for Tethered 
Digital Still Cameras.) Note: If a setting 
on the camera is inconsistent with the 
selected settings template, a prompt 
appears on screen indicating the setting 
that must be changed on the camera. 
For example, the settings template for 
Studio Capture requires that the 
AE Mode on the camera be set to 
Aperture Priority (A). If it is set to 
Manual (M), you should set it to A 
before proceeding with image capture.

6  Be sure the flash unit or studio strobes are turned on 
and properly adjusted.

7  Frame and focus the image. 
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8  Click  Capture to capture the image.

•	As each image is captured, it appears in the preview 
area and a small thumbnail of the image is added to 
the captures list. The most recently captured image is 
automatically selected. 

•	 If necessary, click on the appropriate icon to rotate 
the image 90 degrees  left or  right.

9  If you are satisfied with the image, repeat Steps 6 
and 7 above to capture additional images. If you are 
unsatisfied with the image, click on  to delete the 
image.

	 IMPORTANT: Once an image has been deleted from the 
captures list, it cannot be recovered.

10  When you are finished capturing images, click 
 Save & Close to exit the capture tool.

12.3  CAPTURING STILL IMAGES FROM A VIDEO SOURCE 

There are several ways that a video device may be 
connected to the system. 

• �A digital video device may be connected directly 
to the computer (typically via FireWire). 

• �An analog video device may be connected to the 
computer indirectly through a video converter. 
The video converter makes the analog device 
appear as if it were a digital video source. 

• �On some older Mirror systems, an analog video 
device is connected to the computer through 
either a Targa 2000 or an Integral Flashpoint 128 
video capture card. 

	 IMPORTANT: You must have DirectX (included on the 
installation CD) installed on your computer to use a 
digital video source. 
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The Digital Video Capture tool

The Digital Video Capture tool provides a live video 
preview from a digital video source and enables the 
capture of still images from the video stream. 

 	Note:  If you will be capturing post-op images 
corresponding to a previously captured series of pre-
op images, or you wish to use a capture sequence, 
follow the procedure for Capturing pre-op images with 
a digital video camera below.

1  Make sure the digital video source is turned on and 
properly connected to the computer. 

2  Open or create a patient chart. (If a patient chart is 
not open, images will be captured to the Image Gallery.) 

3  Select Digital Video Capture from the Capture 
menu. 

4  Using the live video preview, focus and frame the 
image as desired. 

5  Left-click or press Space bar to freeze the image. 
Left-click or press Space bar again to accept the 
image. The screen returns to live preview mode. Adjust 
the patient and/or camera and repeat steps 4 and 5 as 
needed for additional images. 

6  When finished capturing images, right-click or press 
ESC to exit the Digital Video Capture tool. 

Capturing pre-op images with a digital video camera

The Pre-op Capture tool helps standardize photography 
by presenting a series of standard image templates  
(a sequence) that you may choose to use during image 
capture. In addition, the Pre-op Capture tool provides 
a grid overlay to assist with patient positioning. (See 
12.7 Customizing Pre-op Image Sequences for more on 
editing image sequences.)

1  Make sure the video source is turned on and 
properly connected to the computer.
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2  Select Set Tool Options from the Options menu.

3  Select the Pre-op/Post-op tab. In the Select Video 
Driver field, be sure DirectX Video is selected.

4  In the Select Capture Sequence field, select a 
sequence from the drop-down list, or select Standard 
Grid to capture images without a sequence. (To 
browse to a folder containing capture sequences, click 
the Change Directory button. Check “Save Directory 
Setting” if you will select sequences from this directory 
in the future.)

5  If you selected Standard Grid, you can specify the 
number of horizontal and vertical grid lines to be 
displayed on screen during image capture.

6  Open or create a patient chart. (If no patient chart is 
open, images will be captured to the Image Gallery.)

7  Select Pre-op Capture from the Capture menu, or 
click the  Pre-Op Capture button on the toolbar. 

8  A live video preview appears. If you selected a 
capture sequence, the first image template is displayed 
in the corner of the preview window, and a grid 
overlay appears on both the template and the preview. 
If you selected Standard Grid, only a grid overlay is 
displayed. The grid is for alignment purposes and does 
not appear on the final image.

9  Use the grid (and template, if one is displayed) as a 
guide to position the patient and frame the image.

10  Optional: Move the Live Preview–Alignment 
Image slider up and down to vary the intensity of the 
grid overlay.

11  When the patient is properly positioned, click 
Capture. 

12  If you are satisfied with the image, click Accept 
Image. If you are unsatisfied with the image, click 
Retake Image, reposition the patient and click 
Capture. Note: To skip a view in a capture sequence, 
click Skip View.
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13  Repeat Steps 9 through 12 for each view you wish 
to capture. Click Close to exit the Pre-op Capture 
tool. (If you are using a capture sequence, the Pre-Op 
Capture tool closes automatically when the last image 
in the sequence is captured.)

Capturing post-op images with a digital video camera

Using the Post-op Capture tool, you can capture a 
series of post-op images corresponding to a previously 
captured series of pre-op images. During image 
capture, the pre-op image is placed on top of the live 
video preview to assist in proper framing.

1  Make sure the video source is turned on and 
properly connected to the computer.

2  Select Set Tool Options from the Options menu.

3  Select the Pre-op/Post-op tab. In the Select Video 
Driver field, be sure DirectX Video is selected.

4  Open the patient chart containing pre-op images you 
wish to match.

5  Click to select the pre-op images you wish to match. 
The order in which you select the pre-op images will 
be the order of the post-op capture sequence.

6  Select Post-Op Capture from the Capture menu or 
click the  Post-Op Capture button on the toolbar.

7  Refer to the on screen preview and use the Live 
Preview–Alignment Image slider to fade between 
the pre-op image and the live preview to align the two 
images. Adjust the patient’s position as needed so the 
images match.

8  Optional: Select Partial Image as the Overlay Mode 
to overlay the image in a center cross-pattern only. 

9  When the live image is aligned with the pre-op 
image, click Capture. 
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10  Refer to the screen and use the New Image–
Alignment Image slider to fade between the pre-op 
and post-op images to verify alignment.

11  If you are satisfied with the image, click Accept 
Image. If you are unsatisfied with the image, click 
Retake Image, reposition the patient and click 
Capture. Note: To skip a view in a capture sequence, 
click Skip View.

12  Repeat Steps 7 through 10 for each view you wish 
to capture. Click close to exit the Pre-op Capture 
tool. (If you are using a capture sequence, the Pre-Op 
Capture tool closes automatically when the last image 
in the sequence is captured.)

12.4  TETHERED CAPTURE WITH A DIGITAL STILL CAMERA  
THAT PROVIDES LIVE VIDEO PREVIEW

Connecting the camera to the computer

1  Uncover the USB port on the camera (see your 
camera’s manual) and plug the small end of the USB 
cable into the USB port. 

2  Plug the large end of the USB cable into an available 
USB port on your computer.

Capturing pre-op images

The Pre-op Capture tool helps standardize photography 
by presenting a series of standard image templates  
(a sequence) that you may choose to use during image 
capture. (See 12.7 Customizing Pre-op Image Sequences 
for more on editing image sequences.)

1  Make sure the camera is turned on and properly 
connected to the computer. 

2  Select Set Tool Options from the Options menu.

3  Select the Pre-op/Post-op tab. In the Select Video 
Driver field, be sure Digital Still Camera is selected.
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4  In the Select Capture Sequence field, select 
a sequence from the drop-down list, or select 
Standard Grid to capture images without a sequence. 
(To browse to a folder containing capture sequences, 
click the Change Directory button. Check “Save 
Directory Setting” if you will select sequences from this 
directory in the future.)

5  If you selected Standard Grid, you can specify the 
number of horizontal and vertical grid lines to be 
displayed on screen during image capture.

6  Open or create a patient chart. 

7  Select Pre-op Capture from the Capture menu, or 
click the  Pre-Op Capture button on the toolbar. 

8  Select horizontal or vertical from the Settings 
drop-down list. (See 12.6 Settings Templates for 
Tethered Digital Still Cameras.) 

9  A live video preview appears. If you selected a 
capture sequence, the first image template is displayed 
in the corner of the preview window, and a grid 
overlay appears on both the template and the preview. 
If you selected Standard Grid, only a grid overlay is 
displayed. The grid is for alignment purposes and does 
not appear on the final image.

	 The on-screen slider control may be used to control a 
Canon PowerShot camera’s zoom lens.

10  Use the grid (and template, if one is displayed) as a 
guide to position the patient and frame the image.

11  Optional: Move the Live Preview–Alignment 
Image slider up and down to vary the intensity of the 
grid overlay.

12  When the patient is properly positioned, click 
Capture. 

13  If you are satisfied with the image, click Accept 
Image. If you are unsatisfied with the image, click 
Retake Image, reposition the patient and click 
Capture.
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	 To skip a view in a capture sequence, click Skip View.

14  Repeat Steps 10 through 13 for each view you wish 
to capture. Click Close to exit the Pre-op Capture 
tool. (If you are using a capture sequence, the Pre-Op 
Capture tool closes automatically when the last image 
in the sequence is captured.)

Capturing post-op images

Using the Post-op Capture tool, you can capture a 
series of post-op images corresponding to a series 
of previously captured pre-op images. During image 
capture, the pre-op image is placed over the live video 
preview to assist in proper framing.

1  Make sure the camera is turned on and properly 
connected to the computer via a USB cable (see 
Connecting the camera to the computer at the beginning 
of this section). The On indicator lights orange.

2  Select Set Tool Options from the Options menu.

3  Select the Pre-op/Post-op tab. In the Select Video 
Driver field, be sure Digital Still Camera is selected.

4  Open a patient chart containing pre-op images.  
(To locate a patient’s record, click the Patient Search 
tab and enter patient data. Double click on the record 
to open it.)

5  Click on the pre-op images you wish to match. The 
order in which you select the pre-op images will be the 
order of the post-op capture sequence.

6  Select Post-Op Capture from the Capture menu (or 
click the  Post-Op Capture button on the toolbar). 
Note that the correct settings template is automatically 
selected, based on the settings used for pre-op capture.

7  Refer to the screen and use the live preview image to 
position the patient to match the pre-op image.

	 The on-screen slider control may be used to control a 
Canon PowerShot camera’s zoom lens.
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8  Optional: Use the Live Preview–Alignment Image 
slider to fade between the two images. Select Partial 
Image for the Overlay Mode to overlay the image in a 
center cross-pattern only. 

9  When the live image is aligned with the pre-op 
image, click Capture.

10  Refer to the screen and use the New Image–
Alignment Image slider to fade between the pre-op 
and post-op images to verify alignment.

11  If you are satisfied with the image, click Accept 
Image. If you are unsatisfied with the image, click 
Retake Image. Reposition the patient and click 
Capture. 

12  Repeat Steps 7 through 11 to capture additional 
images. 

The Post-Op capture tool closes automatically after the 
last image is captured. 

12.5  MOTION VIDEO CLIPS

The Digital Video Record tool may be used to record 
motion video clips from a digital video source. It is also 
possible to import existing video clips that are stored 
as AVI files using the Import Images tool. The Digital 
Video Playback tool may be used to view video clips 
and to capture selected frames as still images. 

	 IMPORTANT: You must have DirectX (included on the 
installation CD) installed on your computer to record, 
import and view video clips. 

Recording video clips

1  Make sure the video source is turned on and 
properly connected to the computer.

2  Optional: Open a patient chart if you wish to capture 
video clips directly to a patient record. (If the Patient 
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Chart tab is not open, video clips will be captured to 
the Image Gallery.) 

3  Select Digital Video Record from the Capture menu.

4  Press the Space bar or click anywhere in the 
preview area to start recording.

5  Press the Space bar or click again to stop recording 
and save the clip. (Note: To cancel recording without 
saving a video clip, press ESC or right-click in the 
preview area.)

6  Press ESC or right-click in the preview area to exit 
the tool. (TIP:  To exit the tool automatically after 
recording a video clip, press Enter instead of the 
Space bar in Step 5 or click the Stop button.) 

Importing video clips

1  Make sure the device containing AVI files is properly 
connected to and recognized by your computer (i.e., 
insert removable media, log on to network, etc.). 

2  Optional: Open a patient chart if you wish to import 
video clips directly to a patient record. (If the Patient 
Chart tab is not open, video clips will be imported to 
the Image Gallery.) 

3  Select Import Images from the Capture menu. 

4  If the correct video clips do not appear (video clips 
are represented by a stamp of the first frame), click the 
Find Images button at the bottom of the dialog box. 
Repeat as needed until the correct video clips appear. 
(Note: If you prefer, you may use the Directory button 
to browse directly to a specific folder.) 

5  Click to select one or more video clips (a red border 
indicates a selected clip). You may click to select 
additional video clips, or click on a selected clip to 
deselect it. The Mark All and Unmark All buttons may 
be used to select or deselect all clips at once. 

6  Click Import. 
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Viewing video clips

Digital Video Playback is used to play motion video 
clips that either have been captured using Digital Video 
Record, or have been imported from AVI files. 

To open Digital Video Playback, select one or more 
video clips in the patient chart (the word “Video” 
appears across the thumbnail for a video clip) and 
select Digital Video Playback from the View menu. 

 �Return To Beginning — This button returns to the 
beginning of the first video clip. This button is 
disabled if tool is already at the beginning of the 
first clip.

 �Previous Clip — This button returns to the 
beginning of the previous clip. This button is 
disabled if the current clip is the first clip.

 �Rewind — This button rewinds the current clip to 
the beginning. This button is disabled if the tool is 
already at the beginning of the current clip.

 �Play — This button starts playing the video clip(s). 
This button is disabled during playback.

 �Next Clip — This button moves to the beginning of 
the next clip. This button is disabled if the current 
clip is the last clip.

 �Pause/Frame Advance — In playback mode, this 
button pauses playback. When paused, this button 
advances to the next frame. This button is disabled 
only when playback stops because the end of the 
last clip was reached. 

 �Stop — This button stops playback and closes the 
tool.

 �Snapshot — This button saves the still image 
displayed in the window as a new image. This 
button is disabled unless playback is paused. 

 �Frame Slider — The slider moves as the clip is 
played to show the location of the current frame in 
relation to the overall clip. The slider may be 
dragged to move to a specific location in the clip. 
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12.6  SETTINGS TEMPLATES FOR TETHERED DIGITAL STILL CAMERAS

The capture tools for digital  
still cameras contain a list of  
user-definable settings templates. 
By default, this list includes 
templates for capturing 
horizontal and vertical images, or 
for Body, Face, Close-up, or 
Studio images. (The default 
templates included depend on 
the type of camera being used.) 
These templates may be 
modified or copied to create 
new templates (see Modifying 
and creating settings templates 
later in this section).

To view the settings for a selected template, click Edit 
to open the Settings dialog box. The Edit Settings dialog 
displays the following:

Size/Resolution — Resolution, which is measured 
in pixels, determines the quantity of data in a digital 
image. The higher the resolution of an image, the 
greater amount of detail it will contain. The ideal 
resolution of an image depends on the output of 
the image (printer, monitor, etc.,). If an image does 
not contain a sufficient number of pixels when it is 
output, the image will lack detail. If an image contains 
more pixels than are needed for output, the surplus 
information is discarded. Because high-resolution 
images tax system resources, selecting the highest 
possible resolution without regard to output will slow 
down performance and may not provide any benefit. 
Digital images should be captured at the lowest 
resolution that will satisfy the intended use.
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Quality/Compression — Sets the amount of JPEG 
compression used during the capture process. JPEG is a 
method of compressing digital image files so they take 
up less space on a hard drive or other storage medium. 
With JPEG compression, some amount of the original 
image data is lost during compression. The greater the 
level of compression used, the greater the impact is on 
image quality. This setting also affects the speed with 
which images are captured: the greater the compression, 
the faster the download speed. Note that changing the 
Quality/Compression setting in the capture tool has no 
effect on the disk space consumed by images that are 
later saved to a patient chart. (See 3.1 Setting Program 
Options for more about image compression.)

Zoom — Sets the focal length on the camera. 

Focus Mode — Provides two focus modes: CloseUp 
for capturing full face or closer images, and Auto for 
capturing half-body images.

Rotation — Sets the automatic rotation for images as 
they are captured. 

Flash — Sets the mode for the camera’s built-in flash.

White Balance — Configures the camera to 
automatically adjust the color balance based on the 
type of lighting used.

ISO — Sets the camera’s light sensitivity. ISO speed 
should be set to the lowest value that provides good 
exposure. If images are under-exposed, raise the ISO 
speed.

AE Mode — Sets the auto exposure mode to one of the 
following settings:

• �Aperture Priority — Select an aperture and the 
camera automatically adjusts the shutter speed. 
Recommended when using a TTL metered flash 
system.
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• �Shutter Priority — Select a shutter speed and the 
camera automatically adjusts the aperture. Not 
typically used for flash photography.

• �Program — The camera automatically controls 
both aperture and shutter. Not recommended for 
clinical photography because the camera often 
selects wide apertures that produce poor  
depth-of-field.

• �Manual — Select this option and set the aperture 
manually if studio lights will be used. 

Aperture — Sets the camera aperture, or f/stop. In 
clinical photography, this is typically the setting that is 
most often changed from one image to the next. The 
following are some tips regarding aperture:

• �Large f-numbers equate to smaller apertures that 
allow less light to enter the camera. 

• �Large f-numbers produce images with a greater 
depth-of-field (i.e., more of the image is in 
focus). 

• �A good rule of thumb is to use the smallest 
aperture (largest f-number) that allows proper 
exposure. 

• �If the flash takes a long time to charge between 
photos (even with fresh batteries), a larger 
aperture (smaller f-number) should probably be 
selected. 

• �Close-up photos require smaller apertures (larger 
f-numbers) and body photos require larger 
apertures (smaller f-numbers). 

Shutter Speed — Sets the camera’s shutter speed. For 
flash photography, this is typically fixed at 1/125.

Exposure Compensation — May be used to adjust 
overall image brightness.
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Modifying and creating settings templates

Changes made to any of the controls in the Settings 
dialog box take effect immediately and remain in effect 
until a different template is selected or the capture tool 
is closed. This is true even if the Settings dialog box is 
closed.

To save settings changes for future use, do one of the 
following:

• �Click Save to save the changes to the current 
settings template.

• �Click Save As to create a new settings template 
with the current settings. The new template will 
be added to the Settings drop-down list.

Set From Camera

If the camera provides a Set From Camera option, you 
can create a settings template from on-camera settings. 
To do so, configure the camera with the desired 
settings. Open the Edit Settings dialog and click Set 
From Camera. Click Save As and enter a name for the 
template.

12.7  CUSTOMIZING PRE-OP IMAGE SEQUENCES 

This section contains instructions for editing capture 	
sequence files used with the Pre-op Images capture tool.

You can edit sequences to suit your needs by changing 
the sequence file in the program’s directory (typically 
<drive>\mirror\sequence). 

Contents of the sequence file

Sequence files are ASCII text files that have a .seq 
extension. The name of the file, minus the extension, is 
used as the name of the sequence in the Select Capture 
Sequence dialog. 
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These are the contents of the Full Face.seq file: 

Full Face - Front  
fullface_front.tga  
Full Face - Left Oblique  
fullface_leftoblique.tga  
Full Face - Left Lateral  
fullface_left.tga  
Full Face - Right Oblique  
fullface_righttoblique.tga  
Full Face - Right Lateral  
fullface_right.tga

Every two lines apply to a different template in the 
capture sequence. The first of the two is the title that 
appears on the screen when the template is displayed 
(e.g., Full Face – Front). The second is the bitmap 
image file containing the template (e.g., fullface_
front.tga). 

A template’s title typically describes the template’s 
purpose, but you can reword the title in any way you 
choose. For example, the text Full Face – Left Lateral 
describes the template used to capture a left profile 
view of the face. 

The bitmap image file (e.g., fullface_front.tga) 
contains the actual template and must appear in the 
same sequence directory (e.g., C:\mirror\sequence) 
as the sequence file (Full Face.seq). 

The program uses the bitmap image file to construct 
the grid that is displayed over the live video in the 
pre‑op capture screen. Sequence files are 640 pixels 
wide and 480 pixels high and have 24-bits of color 
information per pixel. Each black pixel (0,0,0) becomes 
transparent in pre-op capture mode, so you can see the 
live video underneath the grid. 
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Changing a sequence file’s template order

1  Make a backup copy of the sequence file before you 
edit it. You can use Windows Explorer and copy the 
sequence file to a different name or to the same name 
with an extension other than .seq. 

2  Open the sequence file in a text editor. (The 
Windows-based accessory program, Notepad, is an 
example of a text editor.) 

3  Rearrange the line pairs that describe the templates 
you want to change. 

	 IMPORTANT:  Keep the lines in each pair in the correct 
order (name first, bitmap image second). 

4  Save the edited sequence file and exit the text editor. 

Creating a new sequence file

1  Open a new file in a text editor. (The Windows 
accessory program, Notepad, is an example of a text 
editor.) 

2  Enter a pair of lines for each template you want in 
the sequence. For more information, see Contents of the 
sequence file earlier in this section (12.7). 

	 Tip: Copy and paste line pairs from other sequence files. 

3  Save the new file in the sequence directory (typically 
C:\mirror\sequence) under any name (e.g., custom.
seq) but always use the “.seq”extension.
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CHAPTER 13 
Image Editing and Annotation 

13.1  MATCH COLORS 

Match Colors is typically used to balance the color of a 
patient’s pre- and post-op images. Images that match in 
color are less distracting and allow the patient to focus 
on what is important—the surgical results. The Match 
Colors command is unavailable until you open or select 
images. 

Match Colors screen

Initially, the active image appears in three places on 
the screen. Drag the images you want to match into the 
appropriate positions. 

	 • � The image containing 
the color you want to 
match goes into the 
Target area (upper 
right). 

• � The image you want to 
match to the target goes 
into the Original area 
(upper left). 

• � The Adjusted image 
shows any changes you 
make to the Original. 
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Match Colors View menu

Compare — Interactively fades between the original 
image and the adjusted image. 

Side by Side — Places the original and adjusted images 
next to each other. 

3-Way — Places a Compare image next to the original 
image, so you can view the original image next to the 
Compare image. 

Match Colors Color menu

Match Colors — Is selected to show that it is the active 
command. 

Adjust Colors — Adjusts the color of an image (see 
13.2 Adjust Colors). 

Batch — Applies the current color adjustments to 
additional open images. 

Match Colors Template menu

Add Current — Saves the current Match Colors 
parameters as a template file that you can apply to 
other image(s). 

(Template Name) — The names of any Match Colors 
templates you have created. Selecting a template 
applies it to the active image. The menu shows up to 
twelve templates. 

More — Shows all your templates and is available 
when you have more than twelve templates. 
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Match Colors technique

1  Open or select the images you wish to match. 

2  Select Match Colors from the Image menu. 

3  Drag the image you wish to correct to the Original 
area. 

4  Drag the image with the desired color balance to the 
Target area. 

5  Move the cursor onto the original image (the cursor 
becomes an eyedropper). Click on an area of the skin. 

6  Click on the corresponding area in the target image. 
The adjusted image displays the change. 

7  Optional: Experiment by repeating steps 5 and 6 with 
another area of skin until the adjusted image reflects an 
optimal color correction. 

8  Optional: To make additional manual adjustments, 
select Adjust Colors from the Color menu (for details 
on the Adjust Colors tool, see 13.2 Adjust Colors). 

9  Select Save from the menu bar to save the adjusted 
image or click Undo to discard the adjustments. If you 
wish to apply the same color correction to additional 
open images, select Batch from the Color menu. 

10  Right-click to exit the Match Colors tool. 
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13.2  ADJUST COLORS 

Use Adjust Colors to manually adjust the colors in 
an image based on visual feedback. Adjust Colors is 
unavailable until you open or create images.

Adjust Colors screen

Initially, the active image appears in the Original, 
Target, and Adjusted areas of the screen. Drag images 
from the gallery into these areas. 

The image you want to adjust goes in the Original area. 
If you wish, you may drag a reference image to the 
Target area (useful if you are attempting to match the 
color of another image). The Adjusted areas show any 
changes you make to the Original image. 

Adjustment Scale — The scale that sets the degree of 
adjustment that appears in the Adjustment Palette. Drag 
the slider up toward Fine for less adjustment or down 
toward Coarse for greater adjustment. 

Adjustment Palette — The group of images that 
displays various potential adjustments to the original 
image. Select a palette image to apply its displayed 
adjustment to the adjusted image. 
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Adjust Colors View menu

Compare — Interactively fades between the original 
image and the adjusted image. 

Side by Side — Places the original and adjusted images 
next to each other. 

3-Way — Places a Compare image next to the original 
image, so you can view the original image next to the 
Compare image. 

Adjust Colors Color menu

Match Colors — Adjusts an image’s color to another 
(see 13.1 Match Colors). 

Adjust Colors — Is selected to show that it is the active 
command. 

Batch — Applies the current color adjustments to 
additional open images. 

Adjust Colors Template menu

Add Current — Saves Adjust Colors parameters as a 
template that you can apply to other images. 

(Template Name) — The names of the first twelve 
Adjust Colors templates you have created. 

More — Shows all of your Adjust Colors templates 
and is available when you have more than twelve 
templates. 

Adjust Colors technique

1  Open or select the image(s) you wish to adjust. If 
you wish to use a reference image, open or select that 
image as well. 

2  Select Adjust Colors from the Image menu. 

3  Drag the image you wish to adjust to the Original area. 

4  Optional: Drag a reference image to the Target area. 
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5  Drag the Adjustment Scale slider to the desired level 
of color adjustment. 

6  Select a palette image to apply its displayed color 
adjustment. 

7  Repeat steps 5 and 6 as needed until the adjusted 
image displays the desired color balance. 

8  Select Save from the menu bar to save the adjusted 
image or click Undo to discard the adjustments. If you 
wish to apply the same color correction to additional 
open images, select Batch from the Color menu. 

13.3  FOCUS 

Use Focus to sharpen or soften an image. 

Focus technique

1  Open an image you wish to sharpen or soften. 
(Note: Focus is not available from the Patient Chart.) 

2  Select Focus from the Image menu. The Adjust 
Image Focus dialog box appears. 

This dialog contains a “transparent” window through 
which you can preview adjustments you make to the 
active image. 
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	 3  Click Sharpen one or more times to sharpen the 
image or click Soften one or more times to soften the 
image. You may click Reset at any time to discard the 
changes and start again. 

4  Click OK to apply the focus change or click Cancel 
to exit the Adjust Image Focus dialog box without 
modifying the image. 

13.4  MATCH ORIENTATION 

At times, images you take from one session to 
another may not match in size or orientation. Use 
Match Orientation to correct this problem by defining 
corresponding reference points on the two images.  
The Match Orientation command is unavailable until 
you open or select images. 

Match Orientation screen

The active image automatically fills all places in the 
screen. Drag the images you want to match into the 
screen at the proper location. 

•	 The Original area holds the image you want to adjust. 

•	 The Target area holds the image containing the 
orientation and size you wish to match. 

•	 The Adjusted image displays your progress by 
superimposing the Original over the Target image. 

The Move cursor (open hand) is available inside the 
Original and Target images, allowing you to adjust the 
position of an image within its frame. This is useful 
when part of the image you want to match is outside 
the frame. 

	 Match Bars appear inside the original and target areas. 
These bars have circular “handles” at each end and are 
used to mark corresponding reference points on the 
two images. 
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Match Orientation View menu

Compare — Interactively fades between the original 
image and the adjusted image. 

Side by Side — Places the original and adjusted images 
next to each other. 

Method — Shows Compare or Side by Side results in 
normal or embossed mode. 

Match Orientation  technique

1  Open or select the images you wish to match. 

2  Select Match Orientation from the Image menu. 

3  Drag the image you wish to adjust to the Original area. 

4  Drag the image you wish to match to the Target area. 

5  Determine two fixed reference points in the Original 
image. These reference points should appear in both 
images and should be unaltered by surgery or other 
means. For example, the pupil or medial canthus may 
be good choices in facial photographs. 

6  If necessary, drag the original 
image using the Move cursor so 
that at least one of the reference 
points appears within the 
Original area. 

7  Drag the green handle on the 
Original image Match Bar onto 
one of the chosen reference 
points. 

8  If necessary, drag the original 
image using the Move cursor so 
that the second reference point 
appears within the Original area. 

9  Drag the red handle on the Original image Match Bar 
onto the second reference point. 
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10  Repeat steps 6 through 9 for the Target image, 
adjusting the green and red handles to the corresponding 
reference points on the Original image. 

Confirm that the two images match in the Adjusted area. 

11  Select Save from the menu bar to create an 
adjusted copy of the original image or select Undo 
from the menu bar to start over. 

12  Right-click to exit the Match Orientation tool. 

13.5  WHITEBOARD 

Use the Whiteboard tool to highlight changes, mark 
areas of interest, etc., by adding temporary markings 
on a patient’s image. The whiteboard markings are 
non‑destructive; they do not become part of the image 
you are drawing on, but if you wish, you may save a 
copy of the image with markings. 

	 Note: The Whiteboard tool is easiest to use with a pen 
and tablet. 

1  Open or select the image you wish to mark up. 

2  Select Whiteboard from the Image menu. 
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3  Click a pen icon <  > in the upper right corner 
of the screen to select a color. You may change colors 
at any time as you draw. 

4  Draw anywhere on the image. If you are using a pen 
and tablet, press down and move the pen without lifting 
it from the tablet. If you are using a mouse, press and 
hold the left button while moving the mouse. 

5  Optional: To save a marked up copy of the image, 
click the folder icon <  > in the upper right corner of 
the screen (to the right of the pen icons). 

6  Right-click (or press the side button on the pen) to 
erase all markings. 

7  You may start over with more markings or right-click 
to exit the Whiteboard tool. 

Note: The Whiteboard tool appears automatically during 
the use of certain viewing tools (Zoom, Compare,  
Side-by-Side). If you wish, you may disable this feature. 

13.6  LABELS 

The Labels tool is used to add labels and callouts 
(labels with arrows) to a non-destructive layer that may 
be saved with an image, turned on or off, and modified 
at any time. 

The Labels menu bar

Layers — Allows the user to selectively show or hide 
data layers associated with an image (measurements, 
modesty panels, etc.). 

Template — A menu with commands for saving 
standard labels templates to apply to images. 

Clear — Clears all labels and callouts from the active 
image. 

  Used to place a text label. 

  Used to place a callout (text with arrow). 
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  Opens the Font dialog box, allowing you to format 
label text. This is only available when you are editing 
label text. 

  Opens the Insert Field dialog box, allowing you to 
create a label using data from the patient chart. 

Adding a label to an image

1  Select or open one or more images. 

2  Select Labels from the Image menu. 

3  Click the  Label button. 

4  Click on the image where you wish to place the 
label. A small frame appears. 

5  Type the label text using the keyboard. As you type, 
text appears in the frame. 

6  Optional: To format the label text, click the  Font 
button. Make the desired selections in the Font dialog 
box and click OK. (Note: Font changes are applied 
to the entire label, you cannot selectively change the 
formatting of a portion of the label.) 

7  Click outside the frame to save the label. 

8  Click Save at the top of the screen.

Adding a callout  to an image

1  Select or open one or more images. 

2  Select Labels from the Image menu. 

3  Click the  Callout button. 

4  Click on the image where you wish to place the head 
of the arrow. 

5  Move the mouse and click on the image where you 
wish to place the text. A small frame appears. 

6  Type the callout text using the keyboard. As you 
type, text appears in the frame. 
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7  Optional: To format the callout text, click the  
 Font button. Make the desired selections in the 

Font dialog box and click OK. (Note: Font changes are 
applied to the entire callout, you cannot selectively 
change the formatting of a portion of the callout.) 

8  Click outside the frame to save the callout. 

9  Click Save at the top of the screen.

Editing text for labels or callouts

1  Open or select the image with the label(s) or 
callout(s) you wish to edit. 

2  Select Labels from the Image menu. 

3  Double-click the label or callout text you wish to 
edit. A frame appears around the text. 

4  Edit the text using the keyboard. 

5  Click outside the frame to save the changes. 

6  Click Save at the top of the screen.

Adding data fields to a label or callout

The Labels tool may be used to display patient data and/
or image data on an image. If the data is changed in the 
patient chart, the labels are updated automatically. 

Note: Images must be saved to a patient record before 
using the labels tool to display data. 

1  Using the procedures described above, create a new 
label/callout or edit an existing label/callout. 

2  Click the  Insert Field button. 

3  In the Insert Field dialog box, select the name of the 
data field you wish to use and click Insert. 

4  Click outside the frame to save the changes. 

5  Click Save at the top of the screen.
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As long as you are in the Labels tool, the inserted data 
field is displayed as “%Field Name%.” Whenever labels 
are displayed outside of the labels tool (main screen, 
Print screen, Layout Board, etc.), The actual data is 
displayed. 

Note: If no data has been entered for an inserted field, 
nothing appears in the label text. 

Deleting labels and callouts

1  Open or select the image with the label(s) or 
callout(s) you wish to delete. 

2  Select Labels from the Image menu. 

3  Press the Clear at the top of the screen. All labels 
and any attached lines are removed. 

4  Click Save at the top of the screen.

Moving a label or callout text

1  Open or select the image with the label(s) or 
callout(s) you wish to move. 

2  Select Labels from the Image menu. 

3  Click the label or callout text you wish to move with 
the move cursor < >. 

4  Move the text to a new location and click to place it.

5  Click Save at the top of the screen. 

Moving a callout line

1  Open or select the image with the callout(s) you 
wish to move. 

2  Select Labels from the Image menu. 

3  Click the end of the line farthest from the text with 
the move cursor < >. 

4  Move the line to a new location and click to place it.

5  Click Save at the top of the screen.  
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Formatting line styles for callouts

1  Holding down the CTRL key, move the cursor over 
the end of the line farthest from the text (the cursor 
turns into a spinning color wheel) and click to open the 
Line Properties dialog box. 

2  Select the line style (solid, dashed or dotted), cursor 
style (arrow, circle, square, etc.) and color. 

3  When finished, click OK to apply the changes or click 
Cancel to exit the dialog without changing the line.

4  Click Save at the top of the screen.

Adding a callout line to an existing label

1  Open or select the image with the label(s) or 
callout(s) you wish to modify. 

2  Select Labels from the Image menu. 

3  Click the  Callout button. 

4  Click on the image where you wish to place the end 
of the line (i.e., the tip of the arrow). 

5  Move the cursor over the label. A frame appears 
around the text. 

6  Click to attach the line to the label text. 

7  Repeat as needed to add lines to additional labels, or 
to add additional lines to a single label. 

8  Click Save at the top of the screen.
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13.7  LAYOUT BOARD 

Use Layout Board to resize an image, crop an image or 
combine multiple images into a single composite image. 
The Layout Board command is unavailable until you 
open or select images. 

Layout Board File menu

Convert to Black and White — Converts images from 
color to grayscale. 

Save Working Image — Creates a new composite 
image from the current layout board. 

Save as Original + Modified — Saves the contents of a 
2x1 layout board to a single image file. The image on 
the left side of the layout board becomes the “original” 
image and the image on the right side of the layout 
board becomes the “modified” image. Once you 
have saved two images as original and modified, you 
may view them at any time using the Compare and 
Side‑by‑Side commands in the View menu of the 
main menu bar without returning to Layout Board. 

Exit Layout Board — Exits the Layout Board. 

Layout Board View menu

Compare — Interactively fades between images in 
a two‑up, three‑up or four‑up layout board. With a 
four‑up layout, the fade occurs between a side-by-side 
view of the top two images and a side-by-side view of 
the bottom two images. 

Method — Shows Compare results in normal or 
embossed mode. 

Layers — Allows the user to selectively show or hide data 
layers associated with an image (labels, measurements,	  
modesty panels and the ImageCheck symbol). 

 	When an image is dragged onto the layout board, 
all currently visible layers are combined in a single 
“Layout” layer. 
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Layout Board Size menu

Used to set the size of the layout board. The size 
determines the resolution and aspect ratio of images 
created with the layout board. 

Select Edit Size List to add custom layout board sizes 
or to remove sizes that you do not use. All sizes are 
measured in pixels. 

Layout Board tools

Layout Buttons — (  2x1,  2x2, etc.) Used to select 
the number of images in a layout. 

Move — Used to reposition an image within its frame. 

Zoom — Used to enlarge an image. 

Rotate — Used to rotate an image by 90 degrees, 
counterclockwise. 

Flip — Used to flip an image horizontally. (When you 
flip a rotated image, it will appear to flip vertically.) 

Synchronize — Used to apply changes made to one 
image (move, zoom, rotate and flip) to other images in 
the layout board. 

Orientation Buttons — Used to select a vertical 
(portrait) or horizontal (landscape) layout. 

Creating a layout board

1  Select or open one or more images. 

2  Select Layout Board from the Image menu. 

3  Choose a size for the layout board from the Size menu. 

4  Click one of the Layout buttons (  2x1,  2x2, etc.) 
to choose a layout for the board. 

5  Click one of the Orientation buttons at the right 
end of the menu bar to select a vertical (portrait) or 
horizontal (landscape) format. 
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Note: You cannot change the size, layout or orientation 
of a layout board once it contains images. 

Adding an image to a layout board

1  Open the Layout Board tool and create a layout board 
with the desired size, layout and orientation (see above). 

2  Click on a stamp in the gallery to pick it up. 

 	If an image contains modified (simulation) data, click 
the left half of the stamp to pick up the original image 
or click the right half of the stamp to pick up the 
modified image. 

3  Move the stamp over the desired position in the 
layout board and click to place the image. 

	 If there is already an image in that position, it will be 
replaced by the new image. 

4  Repeat steps 2–3 to fill any remaining positions in the 
layout board. 

Repositioning an image

1  Click the Move button on the Layout Board menu 
bar and move the cursor to the image you wish to 
move. The cursor changes to a hand. 

2  Click anywhere on the image to pick it up. 

3  Move the image to the desired position and click again. 

4  Repeat steps 2–3 as needed to reposition other images. 

Resizing an image

1  Click the Zoom button on the Layout Board menu 
bar and move the cursor to the image you wish to 
resize. The cursor changes to a magnifying glass. 

2  Click anywhere on the image to activate the zoom 
tool. 
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3  Move the cursor up and down to adjust the 
magnification. 

4  Repeat steps 2–3 as needed to resize other images. 

5  After resizing an image, you may wish to use the 
Move tool to reposition it (see above). 

Rotating an image

1  Click the Rotate button on the Layout Board menu 
bar and move the cursor to the image you wish to 
rotate. The cursor changes to a curved arrow. 

2  Click anywhere on the image to rotate it by ninety 
degrees. Click again to restore the image to it’s original 
orientation. 

3  Repeat step 2 as needed to rotate other images. 

Flipping an image

1  Click the Flip button on the Layout Board menu bar 
and move the cursor to the image you wish to flip. The 
cursor changes to a horizontal arrow. 

2  Click anywhere on the image to flip it horizontally. 

 	If an image has been rotated prior to being flipped, it 
will appear to flip vertically.

3  Repeat step 2 as needed to flip other images. 

Synchronizing images

For layout boards composed of two or more images, 
the Synchronize tool may be used to apply changes 
made to one image (move, zoom, rotate and flip) to 
other images in the layout board. This may be used, for 
example, to match the original and modified versions of 
a single image or to match the same view of a patient 
captured at different time points (if the images were 
framed consistently). 

1  Create a layout board for two or more images. 
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2  Add the desired images to all positions in the layout 
board. 

3  Use the Move, Zoom, Rotate and Flip tools as needed 
to adjust one of the images. 

4  Click the Synchronize button on the Layout Board 
menu bar. 

5  Move the cursor over the adjusted image. The cursor 
changes to an eyedropper. 

6  Click anywhere in the adjusted image. 

7  Click on another image in the layout board. The 
size, position and orientation of the second image are 
automatically changed to match the first image. 

8  Repeat steps 5–7 as needed to synchronize additional 
images. 

Down-sampling and cropping images

A 1‑up layout board may be used to make a copy of 
an image at a different resolution. This is useful for 
reducing the size of a high-resolution image before 
transferring it over a dial-up internet connection or 
inserting it in a PowerPoint presentation.

The layout board may also be used to adjust the framing 
of an image. Cropping in on an area of interest can 
reduce or eliminate distracting elements. 

1  Select or open the image you wish to adjust. 

2  Select Layout Board from the Image menu. 

3  Choose a new size (resolution) for the image from 
the Size menu. 

4  Click the 1x1 Layout button (the first button after the 
Size menu). 

5  Click one of the Orientation buttons at the right 
end of the menu bar to select a vertical (portrait) or 
horizontal (landscape) format. 
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6  Drag the image from the gallery onto the layout board. 

7  Use the Move, Zoom and Rotate tools as needed to 
adjust the image. 

8  Click Save to create the adjusted copy of the image 
and right-click to exit the Layout board tool. 
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CHAPTER 14 
Analysis Tools

Using Analysis, you can analyze patient images on 
screen instead of marking measurements directly on 
photographs. You can easily measure distances, areas, 
angles and proportions. Analysis also contains the 
Density command. This feature calculates hair density 
on close-up scalp images.

14.1  CALIBRATING 

Because measurements in Analysis are most easily 
calibrated based on a known measurement, we suggest 
you use a ruler or mm stickers in at least one of the 
images you take of a patient. 

	 IMPORTANT:  A calibration measurement on one 
body plane may not result in an exact measurement 
when applied to another body plane. For example, a 
calibration based on the nose, when applied to the 
cheek, will be slightly off. 

About calibrating

Distances and areas measured in an image are based 
on a calibrated distance. If you measure a distance or 
area without first calibrating the tool, the measurement 
appears in pixels (number of dots of color in the line), 
and the units of measure shows an asterisk to indicate 
the units are uncalibrated. 

	 IMPORTANT:  If you do not save a calibrated image 
before closing it, calibrations are lost. 
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Calibrating from a ruler or sticker

1  Open the patient’s image. 

2  From the main menu, select Tools A Analysis A 
Measurements, then click Calibrate in the toolbar.

3  Click to select two points on the ruler or sticker; 
the Calibrate dialog appears. (If the dialog covers the 
ruler or sticker, move the dialog aside by dragging the 
dialog’s title bar. 

4  Enter the measurement in the Enter known 
distance field. Select a unit of measure from the 
drop‑down menu, if desired. 

5  Click OK to set the calibration or click Cancel to exit 
the dialog without making any changes. 

Calibrating from a known distance

1  Open the patient’s image. 

2  From the main menu, select Tools A Analysis A 
Measurements, then click Calibrate in the toolbar.

3  Click to select two reference points on the patient’s 
anatomy that are a known distance apart. A distance 
line and the Calibrate dialog appear. 

4  Enter the measurement in the Enter known 
distance field. Select a unit of measure from the 
drop‑down menu, if desired. 

5  Click OK to set the calibration or click Cancel to exit 
the dialog without making any changes. 

For example, suppose you already know that the 
distance between the patient’s medial canthi is 2 cm. 
Select the right inner canthus, then the left inner 
canthus. Type 2 in the Enter known distance field and 
confirm that the unit of measure is set to cm. 
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14.2  MEASUREMENTS 

Measurements Analysis menu

Select this menu to switch between Measurements and 
Comparative Analysis in the same session. 

Measurements Layers menu

Opens a dialog through which you can show or hide 
information about an image. 

Measurements Template menu

Add Current — Saves the current Analysis items as a 
template that you can apply to other images.

(Template Name) — The names of measurement 
templates you have created appear in the menu. The 
menu lists up to twelve templates. 

More — Displays the entire list of measurement 
templates and is available if you have more than twelve 
templates. 

Measurements tools

Calibrate — Select this option to calibrate the Distance 
and Area tools. 

Clear — Clears the active image of analysis items.

 Distance — Select the Distance tool to measure the 
distance of a feature or between features. 

 Angle — Select the Angle tool to calculate angles 
(e.g., the nasofacial angle) on an image. 

 Vertical Proportions — Select the Vertical 
Proportions tool to calculate facial thirds and other 
vertical proportions. 
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 Horizontal Proportions — Select the Horizontal 
Proportions tool to calculate facial fifths and other 
horizontal proportions. 

 Area — Select the Area tool to calculate the area 
and perimeter of any circled portion of the image. 

 Chain — Select the Chain tool to connect 
measurements. This tool is used with the Distance and 
Angle buttons. When selected, the system automatically 
starts another measurement at the end of the previous 
measurement. That is, the measurements are “chained” 
together. 

Measuring distances

Distances can be measured on any image.  
To demonstrate, we’ll measure the interpupillary 
distance of a full-face image. 

1  Open a full-face image. 

2  From the main menu, select Tools A Analysis A 
Measurements. 

3  If the  Chain button is selected, tap or click it to 
deselect. 

4  Calibrate your measurements as shown earlier in this 
chapter in 14.1 Calibrating. 

5  Click  Distance in the toolbar.

6  Click the start point, then click the end point of the 
measurement (e.g., the right, then left pupil).  
The distance is calculated and displayed. 

Measuring distances with the Chain tool

When the  Chain tool is selected before you 
measure distances, the system automatically starts 
another measurement at the end of the previous 
measurement. That is, the measurements are  
“chained” together. 



Chapter 14� Analysis Tools

Mirror User Guide	 PART 2:  PHOTOTOOLS	 185

.—.—.—

1  Calibrate the Distance tool (see 14.1 Calibrating). 

2  Select the  Chain tool, if it is not already selected. 

3  Click  Distance in the toolbar. 

4  Click the start point, then click the end point of the 
first measurement. 

5  Move the cursor; the system is ready to calculate a 
new measurement from the end point of the previous 
measurement. 

6  Click the end point of the next measurement. 

7  Repeat steps 5 and 6 as needed. 

8  Press the pen’s side button or the right mouse button 
to finish measuring. 

Measuring angles

Angles can be measured on any image. To demonstrate, 
we’ll use a face profile to measure the nasofacial angle. 

1  From the main menu, select Tools A Analysis A 
Measurements. 

	 If the  Chain button is selected, click to deselect. 

2  Click  Angle in the toolbar. 

3  Click the end then the vertex of the first side of the 
angle you want to measure (e.g., from the patient’s 
nasal tip to the naison). As you move the cursor, the 
first side of the angle appears. 

4  Move the cursor and the line for the other side of the 
angle appears. Select the ending point of the angle’s 
second side at the edge of the nostril. 

5  The angle’s measurement is calculated and displayed 
near the vertex. 
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Measuring angles with the Chain tool

When the  Chain tool is selected before you 
measure an angle, the system automatically starts a 
second angle from the end of the previous angle. That 
is, the angles are linked together. 

For demonstration purposes, we’ll measure nasofrontal 
and nasofacial angles. 

1  Open a profile rhinoplasty image. 

2  From the main menu, select Tools A Analysis A 
Measurements. 

3  Select the  Chain tool, if it is not already selected. 

4  Click  Angle in the toolbar. 

5  Click the start point, then click the end point of the 
angle’s first side to form a line tangent to the glabella 
and ending at the naison.

6  Move the cursor to extend the second side of the 
angle along the ridge of the nose and select the tip of 
the nose to paste the angle. 

7  Move the cursor, and the second side of the 
connecting angle appears. Select the tip of the chin to 
paste this side of the angle. 

8  Press the pen’s side button or the right mouse button 
to exit chain mode. 

Vertical proportions

Vertical proportions can be measured on any image 
(e.g., a full face image). 

1  Open a full-face image. 

2  From the main menu, select Tools A Analysis A 
Measurements. 

3  Click  Vertical Proportions in the toolbar. 

4  Select an area outside the face at the top of the 
image. 
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5  Move the cursor to the patient’s hairline, and a line 
appears. 

6  Select the hairline to paste the line then select the 
patient’s glabella to paste the second proportion line.  
A percentage appears. 

7  Select the subnasale to place a third proportion line. 
Notice the percentages divide proportionally as you 
paste additional lines. 

8  Select the menton to set the final line. 

9  When finished, press the pen’s side button or the 
right mouse button to exit proportion mode. 

You can add as many sets of proportion lines as you 
need to an image. 

Horizontal proportions

Horizontal proportions can be measured on any image 
(e.g., full-face image). 

1  Open a full-face image. 

2  From the main menu, select Tools A Analysis A 
Measurements. 

3  Click  Horizontal Proportions in the toolbar. 

4  Select a location outside the patient’s face at left and 
a proportion line automatically appears. 

5  Select the outer edge of the left ear to place the 
proportion line. 

6  Select the outer corner of the left eye to place 
a second proportion line and percentage appears 
between the two lines. 

7  Continue placing proportion lines at the inner left 
eye, inner right eye, outer right eye, and outer right ear. 
Notice the percentages change proportionally as you 
add these lines. 
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8  When finished, press the pen’s side button or the 
right mouse button to exit proportion mode. 

You can add as many sets of proportions as needed to 
an image. 

Area and circumference

Area and circumference can be measured on any image 
(e.g., the area of a tattoo.) 

1  Open an image containing a tattoo. 

2  From the main menu, select Tools A Analysis A 
Measurements. 

3  Calibrate the Area tool (see 14.1 Calibrating). 

4  Click  Area in the toolbar. 

5  Circle the tattoo with the pen; the circled region 
automatically fills with crosshatching. The area and 
circumference are calculated and displayed within the 
circled region. 

Hint:  To circle, drag the cursor and release to close the 
circle. If the circle is unsatisfactory, press the pen’s side 
button or the right mouse button and start a new circle.

14.3  FORMATTING CONTENTS OF THE ANALYSIS SCREEN 

Deleting a single measurement

1  Move the cursor over a measurement until the Move 
cursor (open hand) or a double-arrow cursor appears; 
tap or click. 

2  Press Clear in the toolbar; the measurement 
disappears. 

If the measurement was chained to other measurements, 
the chained measurements also disappear. 
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Formatting measurement text

1  Move the cursor over the measurement text until the 
Move cursor appears. 

2  Double-tap or double-click on the measurement to 
open the Font dialog. 

3  From the Font dialog, change the font style, size and 
color of the measurement text. Sample displays the 
changes you make. 

4  When finished, click OK to apply or click Cancel to 
exit the dialog without changing the text. 

The next time you measure a feature in this image, the 
system uses these font attributes.

Formatting measurement lines

1  Holding down the CTRL key, move the cursor over 
a measurement line arrowhead until a spinning color 
wheel appears. Tap or click to open the Color dialog. 

2  From the Color dialog, select a Basic or Custom color. 

Hint:  To create a new color, drag the target until the 
Color/Solid indicator shows the desired color, then 
click Add to Custom Colors. 

3  Click OK to apply or click Cancel to exit the dialog 
without changing the color. 

The next time you measure a feature in this image, the 
system uses the new color attributes. 

Formatting measurement areas 

1  Holding down the CTRL key, move the cursor over a 
measurement area until a spinning color wheel appears. 
Tap or click to open the Color dialog. 

2  From the Color dialog, select a Basic or Custom color. 
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Hint:  To create a new color, drag the target until the 
Color/Solid indicator shows the desired color, then 
click Add to Custom Colors. 

3  Click OK to apply or click Cancel to exit the dialog 
without changing the color. 

The next time you measure a feature in this image, the 
system uses the new color attributes. 

Moving measurement labels

1  Move the cursor over the measurement text until the 
Move cursor appears. 

2  Click to select the label and move the cursor to 
reposition the label (all proportion labels move as a 
unit). 

3  Click to paste the label in its new location. 

Adjusting a measurement 

1  Move the cursor over the measurement line until the 
Move cursor appears. 

2  Click to select the measurement and move the cursor 
to reposition. 

3  Click to paste the measurement in its new location. 

Adjusting proportion lines

1  Move the cursor over the end of a proportion line 
(opposite the percentage end) until one of the double-
arrow cursors appears and tap or click. 

2  Move the cursor to reposition the line (percentages 
change as you move the line). 

3  Click to paste the line in its new location. 
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14.4  COMPARATIVE ANALYSIS 

Use Comparative Analysis to show the amount of 
change you made to a modified feature (e.g., that the 
angle of a patients nose decreased by a degree).

Comparative Analysis works in much the same way 
Measurements does. Comparative Analysis contains the 
same interface with some of the same tools, including 
the template feature. You can format the contents of 
the Analysis screen, just as you would measurements. 

1  Open a modified image. 

2  From the main menu, select Tools A Analysis A 
Comparative Analysis; the original and modified 
images appear next to each other. 

3  Use the scroll bars in the lower-right corner of 
the screen to place the feature in question in the 
workspace. 

4  Select the  Distance or  Angle tool. 

5  Click the start and end points of the distance 
(or angle) of interest in the original image. The 
corresponding measurement appears in the modified 
image. 

6  Adjust the measurement on the modified image 
(see Adjusting a measurement earlier in this chapter). 
The number in parenthesis under the corresponding 
measurement shows the amount of change. 

7  When finished, press the pen’s side button or the 
right mouse button to exit comparative analysis mode. 

 	To format the appearance of the comparative analysis 
screen, see 14.3 Formatting Contents of the Analysis 
Screen earlier in this chapter. 

 To create a template from the comparative analysis 
you’ve made, see 14.6 Measurement Templates later in 
this chapter. 
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14.5  DENSITY 

Density analyzes close-up scalp images and counts hair 
roots in a given area (lense aperture) to calculate hair 
density. Using Density, you can calculate density in the 
patient’s donor/recipient region and track the survival 
of hair in the grafted area.

Density Lense menu

Calibrate — Tunes the Density tool based on a 
known measurement (of a patient’s feature or a ruler 
photographed with the feature). 

Emboss — Toggles the image between normal and 
embossed gray-scale color. Emboss is useful for 
focusing on the details in an image. 

Add Current — Saves the current image’s density 
parameters (lense size, view type, etc.) as a template 
you can apply to other images. 

(Lense Template Name) — The names of the first 
twelve density templates you created appear in the 
menu. (Select a template to apply it to the active 
image.) 

More — Lists all density templates and is available if 
you have more than twelve templates. 

Taking density images

To take accurate measurements, use a handheld video 
microscope. Density comes with a lense template for its 
directly-supported video microscope, the Scalar Video 
Loupe. If you use another lens or camera/lens setup, 
you will need to calibrate the setup using Calibrate 
and save it as a template using Add Current if you 
plan to use the setting frequently. For more information 
about templates, see 14.6 Measurement Templates later 
in this chapter. 
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You can use a regular video camera, but it will be 
difficult to get good lighting in extreme close-up 
and the magnification cannot be set precisely. If you 
do use video, use a fixed-focal length lens to avoid 
recalibrating every image. If you use a variable-focal 
length lense, you will have to calibrate each image you 
take by putting either a ruler or sticker of known size 
in the image. 

Calibrating for density

1  Using your camera or microscope, capture, then 
open a close-up image of a patient’s scalp that contains 
a ruler or calibration sticker. 

2  From the main menu, select Tools A Analysis A 
Measurements.

3  Select Lense A Calibrate. 

4  Click to select the start and end points of the known 
measurement or the ruler/sticker. A distance line and 
the Calibrate dialog appear. 

5  In the Enter known distance field, type the 
distance between the start and end points. Select the 
appropriate units (mm, cm, or inches). 

6  In the Aperture Diameter field, type the diameter 
of the aperture you want to use. The diameter must be 
measured in the same units as the known distance. 

7  In the Density Units field, enter the units of 
measure for the density count. This unit need not be 
the same as the previous units you specified. 

8  Click OK to set the calibration or click Cancel to exit 
the dialog without making any changes. 
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Using density

1  Use the Scalar Video Loupe template or calibrate the 
density measurements as described in Calibrating for 
density above. 

2  Count follicles in the aperture by selecting them with 
the pen or mouse. A “1” (meaning 1 hair) appears after 
the first tap or click. 

3  Select the same follicle for each additional hair 
growing from the root (to a maximum of 4). 

Hint: Selecting the follicle more than four times cycles 
through the count a second time, and so on. To 
decrement the count, press CTRL and select the follicle. 

As you count hairs, the total hairs, density, and hairs 
per follicle counts change. 

14.6  MEASUREMENTS TEMPLATES 

Creating a measurements template

You can save measurements in an image as a template 
to apply them to other images. Using templates 
regularly saves valuable time. 

1  Open an image containing measurements or add 
measurements to an image. 

2  From the Measurements or the Comparative Analysis 
screen, select Template A Add Current…. 

3  In the dialog, type a name for the template. 

4  Click OK to save the measurements as a template 
or click Cancel to exit the dialog without saving the 
template. 
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Applying a measurements template

1  From the Measurements or the Comparative Analysis 
screen, click on the Template drop-down menu. The 
first twelve templates appear in the menu. 

2  Select the name of the desired template.

	 To select a template from the full list of templates, 
select Template A More…, click to highlight the 
desired template in the Templates dialog, then click 
Select. 

Deleting a measurements template

1  From the Measurements or the Comparative Analysis 
screen, select Template A More…. The Templates 
dialog listing all the templates appears. 

2  Select a template and click Delete. 

3  In the confirmation dialog, click Yes to delete the 
template or No to cancel without deleting the template.

4  Click Close to exit the Templates dialog.
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CHAPTER 15 
Creating Presentations 

Use the Presentations tools to prepare and present 
lectures, electronic case books or other presentations. 

15.1  THE PRESENTATION EDITOR MENUS 

Presentation Editor File menu

New Presentation — Clears the current presentation 
and opens a new Presentation Editor screen. If you 
have modified the current presentation, you are able to 
save the edits. This command becomes available once 
you place images in the Slide List Area. 

Open Presentation — Opens a previously created 
presentation. 

Save Presentation — Saves the displayed presentation 
and is available once you place images in the Slide List 
Area. 

Save Presentation As — Saves the current presentation 
to a new or different directory and is available once 
you place images in the Slide List Area. 

Open Images — Opens the current chart so you 
can open an image. Select Search to find and open 
image(s) from another chart. 

Save Images — Saves image(s) from the Gallery to the 
active chart. To specify another chart, select Search 
and find and open another chart. 
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Search for Image — Opens the Search for Patient 
dialog, so you can find and open images. 

Close Image — Closes the active image in the Gallery. 
The active image is outlined in green. If you have 
modified the image, you are able to save the edits. This 
command becomes available when you select an image 
from the Gallery. 

Close All Images — Closes all the images in the Gallery. 
If you have modified any images, you will be able to 
save the edits. 

Print Presentation — Prepares the images for printing 
to paper or slides. 

Exit Editor — Exits the Presentation Editor screen. 

Presentation Editor Edit menu

Cut — Removes an image from the Slide List Area 
and moves it to the Clipboard so it can be pasted 
into another location in the slide list, or into another 
presentation. 

Copy — Copies an image from the Slide List Area 
and moves it to the Clipboard so it can be pasted 
into another location in the slide list or into another 
presentation. 

Paste — Pastes the contents of the Clipboard into 
another location in the slide list or into another 
presentation. 

Delete — Deletes the selected image from the 
presentation but not from the Gallery or database. 

Insert Image Number — Inserts a place holder into the 
presentation that brings up an image from the active 
Gallery when you run the presentation. 

Move All Images to Slide List — Copies all images 
currently in the Gallery into the slide list. 
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Slide menu

Properties — Specifies how the slide acts during an 
on‑screen presentation: its duration on screen, the 
way it shifts to the next slide, and whether it supports 
whiteboarding. 

Set Image Number — Sets the index of an image 
number in the presentation. The index refers to the 
position of the image in the Gallery (1 for first, 2 for 
second, and so on). 

Presentation menu

Properties — Specifies the way your presentation runs: 
whether it automatically repeats, how long each slide 
appears on screen, and so on. 

Self-Contained — Saves the contents of the Slide List 
Area as a self-contained presentation. Use this option 
when you want to take the presentation to another 
Canfield system. 

Test — Runs a preview of the displayed presentation. 

15.2  EDITING PRESENTATIONS 

The Presentation Editor screen

From the main menu, select Tools A Presentations A 
Presentation Editor to display the Presentation Editor 
screen. 

• � If no images are selected or open, the 
Presentation Editor is blank. 

• � Any selected or open images appear in the 
Gallery. 

	 • � The Slide List Area is where you create the 
presentation. 
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Moving images from the Gallery to the Slide List Area

1  Click an image in the Gallery. The Move cursor 
(open hand) appears and a green border indicates that 
the image is selected. 

2  Drag to the Slide List Area and click to release.

Once in the Slide List Area, images are displayed inside 
a slide-mount border with a number representing 
the order in which the slide appears during the 
presentation. 

Rearranging images in the Slide List Area

1  Click an image in the Slide List Area. The Move 
cursor (open hand) appears and a green border 
indicates that the image is selected. 

2  Drag to desired position in the Slide List Area and 
click to release. Any images below and to the right of 
the image shift to the right.

Deleting images from the presentation

1  Click to select one or more images in the Slide 
List Area (a green border indicates that the image is 
selected). 

2  Select Edit A Delete. The image(s) are removed from 
the Slide List Area but remain in the Gallery.

Moving images between presentations

1  Click to select one or more images in the Slide 
List Area (a green border indicates that the image is 
selected). 

2  Select Edit A Cut (to move the selected images) or 
Edit A Copy (if you wish to copy the selected images to 
another presentation). 

3  Select File A Open Presentation… (you may be 
prompted to save the current presentation).
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4  Click to highlight the presentation to which you want 
to paste the images, then click Select to open it.

5  Select Edit A Paste to add the images to the Slide List 
Area of this presentation. 

Self-contained presentations

A self-contained presentation can run by itself on 
another Canfield system. At times you may want to 
make a presentation self-contained (e.g., when you are 
traveling to give a presentation on another Canfield 
system.) 

If a presentation is not self-contained, it relies on the 
database used to create it. A self-contained presentation 
file includes image files, so that it can run without the 
database. This makes self-contained presentation files 
very large. Therefore, we suggest you use this feature 
only when necessary. 

	 IMPORTANT: Although a self-contained presentation 
does not require the specific Canfield system used to 
create it, it will only run on a computer that has the 
same version of Canfield software installed. 

1  From the Presentation Editor screen, select 
Presentation A Self-Contained; a program dialog 
appears. 

2  Click Yes to make the active presentation 
self‑contained or click No to exit the dialog without 
making changes. 

Testing a presentation

After you have created a presentation, you’ll want 
to test it to make sure it runs the way you want it to 
before you show it to your patient or colleagues. 

1  Deselect all of the images in the Slide List Area 
before you test the presentation. Otherwise the 
presentation begins from the first selected slide. 
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2  Select Presentation A Test. The active presentation 
begins. 

To exit the presentation at any time, press the pen’s 
side button or the right mouse button to display the 
media control interface in the bottom left corner of the 
screen, then click the ■ Stop button. 

15.3  SETTING PRESENTATION PROPERTIES 

From the Presentation Editor screen, select 
Presentation A Properties… to determine the 
way a presentation runs on screen. The Presentation 
Properties dialog appears. 

Common to all tabs are the Reset, OK, Cancel and 
Reset All buttons. 

• � Click Reset to return the displayed tab to its 
standard settings. 

• � Select OK to apply all the dialog’s settings. 

• � Select Cancel to close the dialog without 
applying any setting changes. 

• � Select Reset All to return all of the tabs to their 
standard settings. 

Presentation tab

Transition between slides automatically (Auto Run) — 
Select this option to set the presentation to transition 
from slide to slide automatically. Remove the selection, 
and you will need to select the media control interface 
buttons at the bottom of the Slide List Area to move 
from slide to slide. 

Duration that slide remains on screen (seconds) —  
This option is available if “Transition between slides 
automatically (Auto Run)” is set. Type a number of 
seconds in this field to set how long a slide stays on 
the screen before the next slide appears. Alternatively, 
select the arrows to increase/decrease the seconds in 
the field. 
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Restart presentation after last slide (Auto Loop) — 
Select this option to set the presentation to repeat 
continuously until you freeze the presentation by 
tapping the pen or clicking the mouse. To close a 
frozen presentation, select the ■ Stop button in the 
media control interface at the bottom of the screen. 
Remove the selection from this option and the 
presentation runs once. 

Allow whiteboarding on paused slides — Select this 
option and whiteboard cursors appear on each slide 
when you run the presentation. Use these cursors to 
draw on slides. Remove the selection and whiteboard 
cursors are unavailable. 

Transitions between slides — Select this option to 
set the transition method between slides. “Fade to 
Next Slide” gradually blends out the old slide while 
blending in the new slide. “Simple Change to Next 
Slide” abruptly replaces the old slide with the new 
slide. “Wipe Horizontally or Vertically to Next Slide” 
wipes out the old slide while wiping in the new slide. 
See Transition tab for information about setting the 
orientation and direction of the wipe. 

Target duration for transitions between slides 
(seconds) — Type the length of time (seconds) in 
which you want the presentation’s slide transitions 
completed. 

Description of presentation — Enter a description of 
the presentation. Doing so lets you tell this presentation 
from the others when you select presentations in 
the future. See 15.4 Showing Presentations for more 
information. 

Transition tab

This tab is available once you set the Transition 
between slides option in the Presentation tab to  
“Wipe Horizontally or Vertically to Next Slide”.  
Select a Wipe direction: Left-to-right, Right-to-left,  
Top-to-bottom, or Bottom-to-top. 
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Editing slide properties in the Slide List Area

1  Click to select image(s) in the Slide List Area. 
(Selected images are outlined in green.) 

2  From the Presentation Editor screen, select Slide A 
Properties…; the Slide Properties dialog appears. 

Allow whiteboarding on this slide — Use the 
whiteboard tools to temporally mark on a slide. Select 
Yes to make the whiteboarding feature available on 
the selected slides during the presentation. Select No to 
make this option unavailable. Select Use presentation 
setting to use the option you chose for the entire 
presentation. See 15.3 Setting Presentation Properties. 

Duration that slide remains on screen — Specify 
how long the selected slide(s) appears on-screen 
(in seconds). Select Use presentation value to use 
the option you chose for the entire presentation. 
See 15.3 Setting Presentation Properties. To select a 
different length of time, remove the selection from 
Use presentation value and type a number of 
seconds in the Duration (seconds) field. 

Transition — Specify how the selected slide(s) 
transitions to the next slide. Select Use presentation 
transition to use the option you chose for the entire 
presentation. See 15.3 Setting Presentation Properties. 
To select a different transition, remove the selection 
from Use presentation transition and select a 
transition from the Transition for this slide list. 
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15.4  SHOWING PRESENTATIONS 

Once you have created and tested a presentation, you 
are ready to show it.

1  From the main menu select Tools A Presentations 
A Run Presentation; the Select Presentation dialog 
appears. 

2  Select a presentation from the Presentations list.  
If you entered a description of the presentation when 
you created it, the description appears under Selected 
presentation description. 

3  Optional: To open a presentation stored in a different 
directory, click Change Directory… to find and 
select the directory that contains the file. (The current 
directory appears next to Directory.) 

4  Click Select to run the presentation and the 
presentation begins. 

5  Optional: To stop the presentation, tap or click and 
select the ■ Stop button from the media control 
interface at the bottom of the screen. ( )

6  Optional: To manually run the presentation, select 
the media control interface buttons on the screen, or 
press the following keys: 

• �Space bar: Advances to the next slide. 

• �Backspace: Returns to the previous slide. 

• ESC: Exits the presentation.
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15.5  EXTRACTING IMAGES FROM A MIRROR PRESENTATION

The Extract Images feature allows you to open all of 
the images in a selected presentation.

	 	 1  (Optional) Close all open images.

2  Select Tools A Presentations A Extract Images.

3  Click to highlight the desired presentation in the 
Select Presentation dialog, then click Select.

The exact behavior of the Extract Images feature will 
vary based on the type of presentation:

• � For a standard (linked) presentation, all images from 
the presentation will be opened from their respective 
patient charts. You must have the correct database 
open to extract images from a linked presentation.

• � For a self-contained presentation, all images will be 
opened as new, imported images. The images from a 
self-contained presentation have no link back to the 
original patient chart.
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MIRROR USER GUIDE� PART 3  REJUVENATION 

This section of the Mirror User Guide  
details functionality specific to the  
Mirror Rejuvenation module.
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CHAPTER 16
Wrinkle Tool

The Wrinkle tool is used for removing or softening 
wrinkles. The tool is also useful for applications such as 
tattoos or blemishes. 

1 Select a brush size and an opacity percentage from 
the menu bar. 

Tip: Best results are typically achieved using opacity 
values of 50% or 75%. 

	 2 Freehand draw over the area you wish to soften. As 
you draw, the area to be softened will be highlighted.  
 
 
 
 
 

	 3 Lift the pen or release the mouse button. Wrinkles 
and blemishes in the selected area will be softened. 

4 Press the pen’s side button to exit the Wrinkle tool 
and save all changes to the gallery. 

Note:  Unlike other draw tools, the Wrinkle tool does 
not support drawing along a curved line. The Wrinkle 
tool may only be used in freehand mode. 
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CHAPTER 17
Resurfacing Tool 

Use Resurfacing to show a patient the potential results 
of laser resurfacing, including showing standard or 
custom post-op redness. This tool helps demonstrate 
realistic results. 

17.1  RESURFACING VIEW MENU 

Compare – Transforms an edited image from its 
original version to its edited version. 

Side-by-Side – Places the original and adjusted images 
next to each other. 

Method – Shows Compare and Side-by-Side views in 
normal or embossed mode. 

Show Redness – Displays varying degrees of post-op 
redness in selected areas. 

Layers – Opens a dialog through which you can show 
or hide the layers of information associated with the 
image.

17.2  RESURFACING OPTIONS MENU 

Select Shade – Opens a dialog through which you 
can choose the shade of red that best represents the 
patient’s post-op redness. This shade is applied when 
you select Show Redness. 

Reset Shades – Resets the Custom Shades in the Select 
Shade dialog to their default settings. Reset Shades is 
available only if you have modified the Custom Shades 
palette in the Select Shade dialog. 
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17.3  RESURFACING TOOLS 

Undo – Removes edits made since the last save or since 
the tool was activated. 

Save – Saves the edited image to the gallery.  
To save the edits to the patient’s chart, select  
File A Save Images from the main menu. 

Fade – Blends an edit with the original image to soften 
edits. 

17.4  DEMONSTRATING RESURFACING 

1 From the main menu, select Tools A Resurfacing. 

2 Circle one or more areas on the patient image. 

3 Click inside any circled area. 

4 Move the cursor up and down to adjust the amount 
of simulated resurfacing. Tap or click to select the 
current results. 

	 5 Optional: To show simulated post-op redness, select 
View A Show Redness. Move the cursor up and down 
to demonstrate the healing process. 

6 Press the pen’s side button or right-click to exit the 
Resurfacing tool and save all changes to the gallery. 
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CHAPTER 18 
Airbrush Tool

18.1  USING DRAW TOOLS

Draw tools are available once you open a picture. 
Select a tool and a tool menu appears containing  
tool-specific options.

• � You can draw freehand or along a set line.

• � Press the pen’s side button to return to the main 
menu. 

• � Select the Undo button to erase all changes made 
since the last save or since the tool was activated.

• � Select the Save button to save the edited picture to 
the gallery. 

• � To save the changes to the patient’s record, select 
File A Save Pictures from the main menu.

• � Select the Fade button to interactively blend the 
recently edited area of the picture with the original 
version to soften the edit. 

• � Select a brush for the drawing tool.

• � Select an opacity tool to set the tool’s opacity or 
intensity. Use less than 100 percent opacity when 
you want to overlay colors. As you continue to apply 
color to the same area, the percentage increases to a 
maximum of 100 percent. 
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Freehand drawing

• � Tap and drag the pen to draw and lift the pen to stop.

• � Tap and drag the pen to continue freehand drawing, 
or tap with the cursor dot to place a curved line  
(see Drawing with curved lines below).

• � Press the pen’s side button once to return to the 
tool’s menu and twice to return to the main menu.

Drawing with curved lines

• � With the cursor dot, place the beginning and ending 
points of the curved line.

• � Move the pen to shape the curve (along a profile for 
instance).

• � Tap and drag the curve, to apply the tool along the 
line and lift the pen to stop.

• � Tap and drag the pen to resume drawing along the 
line.

• � To reset the line, press the pen’s side button.

• � Press the pen’s side button twice to return to the tool’s 
menu and three times to return to the main menu.

Erasing

To erase in freehand or curve mode, press the pen’s side 
button while drawing and lift the side button to stop.

18.2  USING AIRBRUSH 

Use Airbrush to apply a custom color or a color from 
the picture to a picture. Apply the color freehand or 
apply it along a contour line. 

Common applications include rhinoplasty (lateral view), 
submental liposuction (lateral view), adding shadows 
or highlights and adding surgical markings or incision 
lines. 

The cursor appears as a brush in the Airbrush screen.
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Selecting a custom color

1  Select the Color Palette button and the Color dialog 
appears.

2  Select a color under Basic colors or Custom colors 
and click OK, or create your own color. 

3  Select an existing custom color to overwrite. 

4  Tap and drag the target to a color. 

5  Optional: Tap and drag the cursor in the slide bar to 
edit the color’s saturation. 

6  Click Add to Custom Colors and tap OK to apply 
the color to the brush. 

Technique

1  Select a brush and opacity for the tool.

2  Select a color from the picture or select the color 
palette and choose another color (see Selecting a 
custom color above). The menu disappears.

3  Freehand draw or draw with a curved line  
(see 18.1 Using Draw Tools). 

	 To draw on another picture, select it from the gallery.

4  When finished, press the pen’s side button.

5 Optional: Select a new color with the cursor and 
repeat.

	 To erase a drawn line, press the pen’s side button as 
you draw. 
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APPENDIX A 
Data Backup 

	 IMPORTANT:  Canfield recommends you consult a 
qualified IT professional to assist you in developing a 
backup plan. An IT professional should install and 
configure the necessary equipment and software, and 
train the staff member designated to perform backups.

A.1  WHY DO I NEED TO BACK UP MY MIRROR SYSTEM?

Canfield’s Mirror software is a highly reliable 
program that will function predictably under ordinary 
circumstances. However, problems may occur as a 
result of power surges, disk failure, viruses or other 
damaging events that could render your database 
inaccessible or unusable. For this reason, it is essential 
that you regularly create backup copies of your data 
and images so that you can restore the database if you 
experience a problem. 

After reviewing this summary of backup procedures 
and options, you should be able to develop a backup 
strategy to protect your system from unrecoverable loss 
of data. 

Backup vs. archive

It is important to note the difference between backing 
up your system and archiving files. A backup is 
essentially a snapshot of your hard drive at a particular 
time. The backups you create should contain only 
the files, data, and images you are currently working 
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with in your practice. The purpose of the backup is to 
provide you with the capability to restore your system 
to its current working condition if necessary. 

While backups must be done on a regular schedule to 
be useful, archiving files is an activity you should do 
whenever you have files on your hard drive that you 
are not currently using. These unused files should be 
removed from your hard drive (not just copied from 
it) and stored on media separately from your backup. 
Removing old files from your hard drive ensures you 
will have sufficient space on the drive for current 
files, and enables the computer to function at peak 
efficiency.

A.2  WHAT DO I NEED TO BACK UP?

All information that you cannot readily re-create should 
be backed up. Obviously, this includes patient data 
and images you have input into the system. You may 
back up your data and images only, or you may choose 
to back up all files on your computer, including the 
Mirror program files. Each option has advantages and 
disadvantages. 

Backing up your Mirror database only

The chief advantage of backing up only your database 
is the speed of the backup process. Also, a database-
only backup requires fewer tapes, CDs, or whatever 
media you use than a full backup. If you need to 
re-create your system, you can restore your data and 
images from your backup, and re-install the Mirror 
program files from the installation disk. To back up 
your database and images, you must know the location 
of the data and image files. 
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	 To determine the location of Mirror image files,  
complete the following steps.

	 1  Right-click the  Mirror icon on the Windows 
desktop and select “Run as administrator” to open 
Mirror software in Administrator mode.

2  Go to the Options menu.

3  From the Mirror Database Options dialog, choose 
Set Database Options.

4  Click on the Database List tab.

5  Choose the appropriate database from the displayed 
list and click Edit.

6  The Database Information dialog displays the 
directory path for the Mirror image files. Select this 
directory when backing up Mirror image files.

	 To determine the location of Mirror database files,  
complete the following steps.

1  From the Windows desktop, click on the Start button 
(in the lower left corner of the screen), and select 
Computer from the right panel of the Start menu.

2  Click Local Disk (C:) in the left navigation menu.

3  In the search field (top right corner of the Local Disk 
(C:) window), type *.mdf (if you have a SQL database) 
or *.mdb (if you have an Access database).

4  Locate your database file in the Search Results 
window.

5  Right-click on the database and select Open file 
location from the drop-down menu. Select this 
directory when backing up Mirror database files.
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Backing up all files

A full backup offers the advantage of making it easy to 
re-create your system from a single source. However, 
if you choose to back up all files on your hard drive, 
the backup process will take longer and require more 
backup media than would be needed for a backup of 
your database only. 

A.3  WHEN DO I NEED TO BACK UP?

Regularly scheduled backups

Backing up your computer system should be part of 
your routine office procedures. Regularly scheduled 
backups ensure that you will be able to restore your 
most current data and images if there is a problem 
with your system. Establishing a backup schedule is 
discussed in detail in the section “How should I back 
up my Mirror system?” below.

Backups before major system events

In addition to your scheduled backups, you should 
do a full backup prior to any event that could create a 
problem with your system so that you can restore the 
system to a usable state if necessary. These kinds of 
events include:

•  installing new software
•  upgrading software
•  installing a Windows update
•  installing a hardware upgrade
•  moving your computer from one location to another
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A.4  WHERE SHOULD I BACK UP MY MIRROR SYSTEM?

Computer files can be backed up to various types of 
media, including another hard drive, tape, CDs, or 
DVDs. When deciding on a type of backup media, 
you should consider how easy the backup and restore 
process is using that media, the data transfer speed 
and capacity of the media, and the amount of space 
you have for media storage. You may wish to maintain 
two sets of backups: one on-site, and one off-site at 
a secure location. You should take into account the 
amount of space available at each location. 

Tape

Because it is easy-to-use, tape is one of the most 
commonly used types of backup media. An IT 
professional can provide you with specifics regarding 
cartridge capacity, data compression, and rates of data 
transfer for tape drives.

Second hard drive

Backups can be stored on another hard drive, which 
can be either internal (physically inside the computer 
terminal that houses your primary drive), or external. 

A second internal hard drive can be set up to mirror 
any changes made to your original drive. In this way, 
a duplicate of your hard drive is maintained. The 
disadvantage of an internal hard drive is that it is 
subject to the same potential problems as your primary 
hard drive; for this reason you may not want to rely on 
an internal hard drive as your chief backup strategy. 

An external drive is not connected to your system, and 
therefore not susceptible to potential problems, such as 
power surges, that affect your primary hard drive.
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CDs/DVDs

Backups can be created by copying data onto 
CD-ROMs or DVDs. However, because of the limited 
capacity of these devices, they are probably not 
practical as a backup medium for a Mirror database.

A.5  HOW SHOULD I BACK UP MY MIRROR SYSTEM?

Developing a backup plan

When developing a backup plan, consider the 
following:

• � Determine what should be backed up. You should 
back up your patient data and images. You may also 
wish to back up program files.

• � Develop a schedule that includes the type of backup 
to be performed (Full, Incremental, or Differential), 
how often backups will be done, and at what time of 
day.

• � Decide which type of media (tape, external hard 
drive, etc.) you will use for the backup, and how 
many backup copies you wish to maintain.

• � Decide where you will store data once it is backed 
up. This plan should include both on-site and off-
site storage. For both locations, ensure that only 
authorized personnel have access to the backup.

• � Identify the person(s) who will perform the backups.

• � Develop a schedule for testing your backup system 
regularly. The person responsible for backups 
should test the system periodically by backing up 
and restoring data to ensure data integrity. All testing 
should be done in a separate test environment to 
prevent the possibility of introducing problems into 
the system during testing.

• � Create a backup log where you will record what 
was backed up, when the backup took place, who 
performed the backup, and what media was used.
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Full, incremental and differential backups

There are three types of backup that can be 
implemented separately or in combination to ensure 
that you always have an up-to-date copy of your 
database. These backup types are Full, Incremental, 
and Differential. Each type of backup has advantages 
and disadvantages, which are discussed below.

With a full backup, all files and folders on the hard 
drive are backed up. An incremental backup provides a 
backup of files that have changed or are new since the 
last incremental backup. A differential backup creates 
a backup of files that have changed since a full backup 
was performed. 

A good model for a backup schedule combines a full 
weekly backup with daily differential backups. With 
this schedule, backups can be performed quickly 
on a daily basis, and restoration of the database 
requires restoring the contents of only two tapes: 
the full backup overlain with the differential backup. 
Incremental backups could also be used for daily 
backup but are more difficult to restore because of the 
number of tapes required to keep a full incremental set.

Full backup

When you do a full backup, all files and folders on 
the drive are backed up. Before initiating a full backup 
strategy, consider the following:

Advantages:

• � All files from the selected drives and folders are 
backed up to one set of tapes (or whichever media 
you have chosen). 

• � In the event you need to restore files, they are easily 
restored from the single backup set. 
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Disadvantages: 

• � A full backup is more time consuming than other 
backup options. 

• � Full backups require more tapes, disks, or network 
drive space.

Incremental backup

An incremental backup provides a backup of files that 
have changed or are new since the last incremental 
backup. Before you can successfully use incremental 
backups, you must do an initial full backup of the 
drives, folders, or files in question.

The first time you do an incremental backup (following 
a full backup), all files in the file set are backed up, 
just as in a full backup. If you use the same file set to 
perform an incremental backup later, only the files that 
have changed are backed up. If you use the same file 
set for a third backup, only the files that have changed 
since the second backup are backed up, and so on. 

The Windows Backup utility (or whatever backup 
software you use) designates a file for backup in an 
incremental backup based on the filename, its last 
modified date, and the date of the last incremental 
backup, all of which are stored in the file set. 

An incremental backup might be done as follows:

Monday	 Perform a full backup.

Tuesday	 Perform the first incremental backup of 
selected files and/or folders using a file set 
with the Incremental option enabled.

Wednesday	 Perform another backup with the backup 
file set you created Tuesday. Only files that 
have changed since Tuesday’s backup are 
backed up.

Thursday	 Perform another backup with the backup 
file set you created Tuesday. Only files 
that have changed since Wednesday’s 
incremental backup are backed up.
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Before initiating an incremental backup strategy, 
consider the following:

Advantages: 

• � Backup time is faster than for full backups. 

• � Incremental backups require less disk, tape, or 
network drive space than a full backup. 

• � You can keep several versions of the same files on 
different backup sets. 

Disadvantages: 

• � In order to restore all the files, you must have all of 
the incremental backups available. 

• � It may take longer to restore a specific file because 
you must search more than one backup set to find 
the latest version of a file. 

Differential backup

A differential backup creates a backup of files that  
have changed since a full backup was performed. A 
differential backup typically saves only the files that 
are different or new since the last full backup, but this 
can vary in different backup programs. Together, a full 
backup and a differential backup include all the files on 
your computer, changed and unchanged.

A differential backup might be done as follows:

Monday	 Perform a full backup and save the file set.

Tuesday	 Perform a differential backup using the 
same file set. All files that have changed 
since the full backup are backed up in the 
differential backup.

Wednesday	 Perform a differential backup using the 
same file set. All the files that have changed 
since Monday’s full backup are backed up.
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Before initiating a differential backup strategy, consider 
the following:

Advantages: 

• � Differential backups require less disk, tape, or 
network drive space than incremental backups. 

• � Backup time is faster than for full or incremental 
backups. 

Disadvantages: 

• � Restoring all your files may take considerably longer 
because you may have to restore both the last 
differential and full backup. 

• � Restoring an individual file may take longer because 
you have to locate the file on either the differential 
or full backup.

Automated backup software

Refer to the documentation for your Server Operating 
System for instructions for using your system’s 
automated backup program.

Storing backup media

Canfield recommends that you maintain two copies of 
your backups: one to be stored on-site (preferably in a 
fire-proof container), and one to be stored at a secure 
off-site location. For both locations, ensure that only 
authorized personnel have access to the backup.

Testing your backup system

The person responsible for backups should test the 
system periodically by backing up and restoring data 
to ensure data integrity. All testing should be done 
in a test environment to prevent the possibility of 
introducing problems into the system during testing.
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A.6  OTHER WAYS TO PROTECT DATA (IN CONJUNCTION WITH BACKUPS) 

In addition to performing regular backups of your 
database, there are other methods of safeguarding your 
system so that you are protected against potential data 
loss. 

RAID (Redundant Array of Independent Disks)

RAID is a method of creating one or more pools of  
data storage space on several hard drives. RAID 
accomplishes this through one of two techniques:  
Disk Mirroring or Disk Striping. Both of these 
techniques create a copy of your primary hard drive on 
an external drive.

Disk Mirroring  provides a way of protecting your data 
through redundancy. With this technique, a duplicate 
of your primary hard drive is created on another drive. 
The data on both drives is continuously updated.

Disk Striping  is the process of dividing a body of data 
into blocks and spreading the data blocks across 
several partitions on several hard disks. Disk striping 
also provides data protection through redundancy. This 
process requires that you have at least three external 
drives dedicated for this purpose.

Refer to an IT professional for assistance in 
implementing one of these RAID techniques.

Uninterruptible Power Supply

An uninterruptible power supply (UPS) is a device that 
has a battery, power conditioning, and surge protection 
built into it. The UPS plugs into the wall outlet and the 
computer and monitor plug into the UPS, so that while 
the AC power from the wall powers the computer, it 
also charges the UPS battery. If the power goes out, the 
charged battery takes over and keeps the computer up 
and running long enough for you to perform an orderly 
shutdown, which can be important to bringing the 
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server back up after an outage. If the users connected 
to the server also have UPSs, they will also have a 
chance to save their data before powering down. The 
amount of time the UPS can maintain power to the 
computer depends on the size of the battery inside the 
UPS and the amount of power drain placed on it. 

In addition to battery backup, a UPS also provides 
power conditioning and surge protection. Power 
conditioning “cleans up” the power, removing noise 
caused by other devices. Surge protection keeps the 
computer from being affected by sags or spikes in the 
power flow. Alterations in power flow can occur during 
thunderstorms even if the power doesn’t go out, or 
when there is a drain on power resources, such as on 
a hot day when air conditioners are straining power 
stations.
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